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Welcome to Using Dashboard

This guide describes how to work with Mercury Business Availability Center
Dashboard.

How This Guide Is Organized

Part |

Part Il

Part Il

Part IV

The guide contains the following parts:

Dashboard Overview

Introduces the Dashboard concept and describes how Dashboard fits into
the Mercury Product architecture.

Working with Dashboard

Describes how to work with Dashboard and the Dashboard views, how to
use the Top View tab, the Console tab, the Filters tab, the Geographical Map
tab, the Custom Map tab, the Topology Map tab, Mercury Dashboard Ticker,
and the Deep Transaction Tracing view.

Dashboard Reports

Describes how to view the Configuration Item Status Alerts, KPIs Over Time,
Raw Data Over Time, SLAs Summary reports, and how to use the report
repository.

Working with Real User Monitor Data

Provides detailed information about the content and structure of the Real
User Monitor views.
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Part V

Part VI

Part VII

Part VIII

Working with the SAP Solution

Provides detailed information about the specific tasks involved in using
Mercury Business Availability Center for SAP and about the content and
structure of the SAP Systems view.

Working with the Siebel Solution

Provides detailed information about the specific tasks involved in using
Mercury Business Availability Center for Siebel and about the content and
structure of the Siebel Enterprises view.

Working with Deep Transaction Tracing Data

Provides detailed information about the specific tasks involved in using
Deep Transaction Tracing that provides a monitoring layer for collecting
information about the behavior of transactions within the target machine.

Working with Mercury Business Availability Center for SOA

Provides detailed information about the specific tasks involved in using
Mercury Business Availability Center for SOA, about the content and
structure of the SOA UDDI and SOA Web Services views, and details about
the Mercury Business Availability Center for SOA reports.

Who Should Read This Guide

This guide is intended for the following users of Mercury Business
Availability Center:

» Mercury Business Availability Center administrators

» Mercury Business Availability Center end users

Readers of this guide should be knowledgeable about navigating and using
enterprise applications, and be familiar with Mercury Business Availability
Center and enterprise monitoring and management concepts.
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Getting More Information

For information on using and updating the Mercury Business Availability
Center Documentation Library, reference information on additional
documentation resources, typographical conventions used in the
Documentation Library, and quick reference information on deploying,
administering, and using Mercury Product, refer to Getting Started with
Mercury Business Availability Center.

xi
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Introduction to Dashboard

Mercury Business Availability Center Dashboard enables you to monitor the
system performance of your organization’s IT universe and to view the
results in several formats.

This chapter describes: On page:
About Dashboard 3
How Dashboard Works 5
View Explorer 7

About Dashboard

Mercury Business Availability Center Dashboard is an interactive digital tool
that enables you to assess real-time system performance and availability in a
business context. Dashboard provides extensive infrastructure monitoring
under a single umbrella, giving you a consolidated view of the current
operational status of your organization.

This section includes the following topics:

> “Collecting and Aggregating Data” on page 4

» “Prioritizing IT Operations and Maximizing Business Results” on page 4
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Collecting and Aggregating Data

Dashboard utilizes data collected by Mercury Business Availability Center
monitoring components, such as Business Process Monitor, SiteScope, and
Enterprise Management Systems (EMS) integration tools, as well as data
collected from external monitoring tools. Mercury Business Availability
Center collects metrics about the end-user experience from a range of
environments, including ERP, CRM, Web, and Citrix, and about system
performance from a range of back-end infrastructure components, including
Web, application, database, and firewall servers.

The collected and aggregated data is used by the Dashboard KPIs (Key
Performance Indicators) to provide quantifiable measurements that help
you monitor how well your business is achieving its objectives. The KPIs
provide a real-time assessment of the present state of your business and
processes, enable you to track critical performance variables over time, and
help assess the business impact of problems in the system.

At the top level, Dashboard provides an integrated view of critical
applications and business processes; from there, you can drill down to the
underlying IT infrastructure associated with these critical business processes.
This drill-down view can be laid out in any number of ways, such as by data
centers, by technology clusters, by geographical locations, and so forth.

Prioritizing IT Operations and Maximizing Business
Results

Dashboard helps you to prioritize IT operations and maximize business
results by:

» presenting global system component data organized into a logical and
relevant framework.

» providing integrated, scalable, cross-application views that reflect the health
of mission-critical services and applications in real time. This enables IT
operations teams to continuously manage the health of mission-critical
services and applications from one central location.

» providing a common view of how IT operations are meeting line-of-business
goals. This enables better communication between the teams, and the
alignment of management and IT operations around customer-centric
values.
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» providing the ability to assess actual customer impact, so that IT teams can
prioritize response according to business impact and optimize resource
utilization to meet critical business objectives. The end result is better
quality of service for your end users.

» providing a big-picture perspective, enabling you to see how a performance
issue impacts the availability of any part of your business and allowing you
to quantify the business impact of a potential failure.

» providing operational-level service level management reporting. Dashboard
uses Service Level Management data to provide an indication of whether an
SLA is in breach of contract, or may be in breach in the near future.

How Dashboard Works

The physical and logical entities in your system, such as hardware, software,
services, business processes, and so forth, are represented in Dashboard by
configuration items (CIs). The ClIs are stored in the Mercury Universal
CMDB, and organized into hierarchical format based on the
interdependencies in your organization’s IT environment.

You view the Cls in Dashboard in service views. Each service view provides a
different aspect of your organization’s IT universe, enabling you to focus on
the IT area that is of interest at that point in time.

Each CI has one or more KPIs showing current operational status or business
impact over time. Status propagates up the CI hierarchy, from the monitor
(leaf) Cls at the bottom of a tree, up to the root CI shown at the top of the
tree. The monitor CIs receive real performance metrics from the monitoring
data flowing into Mercury Business Availability Center, and KPI status for
these Cls is calculated from that data. For all higher level CIs, KPI status is
based on an aggregation of statuses for all child Cls (the calculation method
used for this aggregation varies, according to the business logic the KPI is
using).

The child CIs for a CI may not be visible in a view, but the KPI status shown
is still based on the status propagated up from the hidden child ClIs.
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The incoming report data is updated every 30 seconds (configurable default
value), so that the status information displayed in Dashboard represents the
real-time availability of your organization’s infrastructure components.

This section contains the following topics:

» Monitoring Performance Problems

» Monitoring Service Level Agreements

Monitoring Performance Problems

When a problem is identified, you can drill down to locate the source of the
problem, view event reports, and track problem handling. You can also
move directly to the appropriate pages in Mercury Business Availability
Center to view reports for problematic components, measurement data over
time, and general monitoring data.

Dashboard also enables you to view operational status from the viewpoint
of geographical locations, so you can see which locations are impacted by
problems.

In addition, you can isolate and manage enterprise problems discovered in
Mercury Business Availability Center, and identify likely suspects to help in
solving the root cause of the problem using the Problem Isolation
application.

Monitoring Service Level Agreements

Service Level Management enables you to track applications, infrastructure,
and services according to the service contracts you have with internal or
external customers.

In Dashboard you can view an SLA information bar that gives you advanced
warning of any potential breaches of contract, and you can act proactively
to fix a problem before it causes financial damage.
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View Explorer

Mercury Business Availability Center View Explorer enables you to locate
configuration items (Cls) in the application with which you are working, for
example, Dashboard, Service Level Management, or IT Universe Manager.
View Explorer also enables end users to view IT elements and the

relationships between them, to select Cls, and to perform operations on the
CIs.

P— n— Browse|Search| ¥
@|E =
Wiew: IMonitors View J

5 ' Monitors View
EE bpr_profile_1
= [EE bprn_profile_2

= ﬁ tx_10

[0 tx_15
E=: tx_1_failed
E=: tx_2_failed
E=: tx_5
[?3 crn_profile_1
[?3 crn_profile_2
Gﬁ fist_bprn_profile_1
Eﬁ fist_bpm_profile_2

FH EHFHMH

s

Lo sis_profile_1

The View Explorer pane is displayed for most tabs in the Dashboard. For
details, see “Using View Explorer” in Working with the CMDB.
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Dashboard Menu Options

From most tabs in Dashboard and from the View Explorer, you can access
right-click menu options that enable you to move to different tabs or
applications filtered for the selected CI.

This chapter describes: On page:
About Menu Options for Cls 9

List of Menu Options 10

Show Path to Root Option 29

Show Problematic Subtree Option 30
Acknowledging Performance Problems 32

Find Visible and Hidden Child CIs Option 36

About Menu Options for Cls

w

Click the down arrow on the right of a CI name to access the menu options
for that CI. The options that are available depend on the type of CI and on

the context menu defined for the CI. If no context menu is defined for the

CI, then the menu arrow is not displayed. If one of the menu options is not
supported for the selected CI, that option is shown disabled.

The menu options are available for Cls in the Console and Filters tabs, and
in View Explorer.

For information on the various menu options, see “Context Menus
Repository” in Application Administration.
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The menu options available for a CI may include the following
functionality:

Enable you to move to other Mercury Business Availability Center
applications or SiteScope to view information and reports related to the CI,
or to open standalone reports or views. For example, you can view a trend
report on the End User Management page, containing measurement data for
the CI over a specified time period.

Enable you to move to the Filters tab to view Cls for a CI’s subtree. You can
select an option to filter the subtree CIs and monitor Cls, in which case the
CIs are filtered according to the current active filter selected in the Filters
tab.

List of Menu Options

10
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The menu options that are displayed in Dashboard View Explorer and in the
main page of the Console and Filters tabs, depend on the selected view and
on the selected CI. They can be a subset of the options described in this
section. The options are listed in alphabetical order.

This section includes the following topics:

“Acknowledgment” on page 11

“Application Mapping” on page 11

“Drill to Diagnostics” on page 12

“Filters” on page 14

“Find Visible and Hidden Child CIs” on page 15
“Go to Report” on page 15

“Go to Siebel Diagnostics” on page 24

“Problem Isolation” on page 27

“Properties” on page 27

“Show Content” on page 28
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> “Show Related CIs” on page 28
» “Top View” on page 28

Acknowledgment

Displays a list of options similar to options in the Top View tab to view
different trees centered on the selected CI.

This section includes the following topics:

> “Acknowledgment Details” on page 11

> “Set/Unset Acknowledgment” on page 11

Acknowledgment Details

This option is available for all CIs.

This option opens the Acknowledgment details page that displayed
information about the CI’s acknowledgment. For more details, see
“Acknowledging Performance Problems” on page 32.

Set/Unset Acknowledgment
This option is available for all Cls.

This option opens the Set/Unset Acknowledgments page where you can set
or clear the CI's acknowledgment. For details, see “Setting or Unsetting
Acknowledgments” on page 35.

Application Mapping

Displays a list of options that enable you to open specific capabilities
provided by the shared CMDB feature filtered by the selected CI.

This section includes the following reports:

» “Show Impact” on page 12

» “Problem Isolation” on page 12

11
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Show Impact

This option is available for SAP-specific Cls. This option is displayed only if
you have installed shared CMDB.

This option opens a dialog box that shows the impact of a root cause object
by displaying all of the objects that are affected by it. For details about the
report, see “Showing Impact for SAP CIs” on page 241.

For details about the SAP Systems view, see Chapter 19, “Using the SAP
Solution.”

Problem Isolation

This option is available for SAP-specific Cls. This option is displayed only if
you have installed shared CMDB.

This option isolates a CI's problem in a separate browser dialog box. For
details about the report, see “Isolating a Problem for SAP CIs” on page 242.

For details about the SAP Systems view, see Chapter 19, “Using the SAP
Solution.”

Drill to Diagnostics

Displays a list of options that enable you to open specific pages in the
Diagnostics application filtered by the selected CI. This option is displayed
only if you have installed Diagnostics.

This section includes the following reports:

“Layers View” on page 13
“Server Requests” on page 13
“Summary View” on page 13

“Transactions View” on page 14
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Layers View

In the Diagnostics View, this option is available for all Probe Group, and
Probe CIs. In the End User Monitors View, this option is available for the
Business Process Step Cls. This option is displayed only if you have installed
Diagnostics.

The option opens the Layers (Load) view, with the following characteristics:

For a Business Process Step CI, the view displays the layer(s) of the
transaction that corresponds to the Business Process Step CI.

For a Probe Group CI, the view displays the performance metrics for the
Probe Group.

For a Probe ClI, the view displays the performance metrics for the Probe.

For more information about Diagnostics, refer to Mercury Diagnostics User’s
Guide.

Server Requests

In the End User Monitors View, this option is available for the Real User
Monitor Business Process Step Cls. This option is displayed only if you have
installed Diagnostics.

The option opens the Server Requests View in the Mercury Diagnostics
application with the URL(s) that correspond to the Real User Monitor
Business Process Step Cls selected.

For more information about Diagnostics, refer to Mercury Diagnostics User’s
Guide.

Summary View

In the Diagnostics View, this option is available for all Diagnostics Probe
Group and Diagnostics Probe Cls. This option is displayed only if you have
installed Diagnostics.

The option opens the Diagnostics Probe Group Summary View for the probe
or the probe group in the Mercury Diagnostics application.

For more information about Diagnostics, refer to Mercury Diagnostics User’s
Guide.

13
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Transactions View

In the End User Monitors View, this option is available for all Business
Process Step ClIs. This option is displayed only if you have installed
Diagnostics.

The option opens the Transactions view that displays performance metrics
for the transactions that are being executed by your applications. The
transaction that corresponds to the selected Business Process Step CI is
highlighted.

For more information about Diagnostics, refer to Mercury Diagnostics User’s
Guide.

Filters

Displays a list of filters you can use to display subsets of the selected CI’s
children on the Filters page.

This section includes the following topics:

“Filter Subtree” on page 14
“Filter Subtree Monitors” on page 14

“Show Complete Subtree” on page 15

Y VY VY Y

“Show Subtree Monitors” on page 15
Filter Subtree
This option is available for all Cls.

This option opens the Filters page, which displays the selected CI subtree
filtered by the active filter.

For details, see Chapter 6, “Dashboard Filters.”
Filter Subtree Monitors
This option is available for all Cls.

This option opens the Filters page, which displays the monitor ClIs in the
subtree of the selected CI filtered by the active filter.

14
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For details, see Chapter 6, “Dashboard Filters.”
Show Complete Subtree
This option is available for all CIs.

This option opens the Filters page, which displays the complete subtree of
the CI as if it was filtered by the Show All active filter. That filter appears in
the Active Filters box.

For details, see Chapter 6, “Dashboard Filters.”
Show Subtree Monitors
This option is available for monitor Cls.

This option opens the Filters page, which displays the monitor ClIs in the
subtree of the CI as if it was filtered by the Show Monitors Only active filter.
That filter appears in the Active Filters box.

For details, see Chapter 6, “Dashboard Filters.”

Find Visible and Hidden Child Cis

This option is available for all CIs.

This option returns all of the visible and hidden child CIs of the selected CI
that appear in the CMDB.

For details, see “Find Visible and Hidden Child ClIs Option” on page 36.

Go to Report

Displays a list of options that enable you to access all types of reports that
display information about the selected CI.

This option is available for all Cls.
This section includes the following topics:

> “Change Rule” on page 17
» “Component Topology” on page 17

> “Configuration Item Status Alerts” on page 17

15
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“End User Summary” on page 18

“Event Count Over Time” on page 18

“Event Summary” on page 18

“Event Summary (Errors Monitor)” on page 19
“Event Summary (Event Monitor)” on page 19
“Event Summary (HTTP Error Monitor)” on page 19
“Event Summary (Information Event Monitor)” on page 19
“KPIs Over Time"” on page 19

“Operations Health” on page 20

“Raw Data Over Time” on page 20

“Related Change Requests” on page 20

“SAP Transaction Changes” on page 20

“SAP Transport Changes” on page 21

“Server Summary” on page 21

“Service Level” on page 21

“Session Analyzer” on page 22

“Siebel Cross-Performance” on page 22
“SiteScope” on page 22

“Systinet Web Service Data” on page 23
“Tracking” on page 23

“Transaction Analysis” on page 23

“Trend” on page 23

“Triage” on page 24

“Web Services Health” on page 24
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Change Rule
This option is available for all CIs whose properties have changed.
This option opens the Change report for the CI. The Change report displays

information about the changes made to the properties of Cls for all CIs that
were assigned to keep this information.

For details about the report, see “Change Report” on page 191.

Component Topology

This option is available for Deep Transaction Tracing Cls.

This option opens the RTM report. The RTM report displays a top view map
for the flow of information across components in the target machine, over a
specified time period. The report shows activity for all components on the
machine during the time period, not for any individual transaction. The
report also displays statistics on the interaction between components (for
example, failed, late, and total counts for events).

For details about the report, see “Component Topology Report” on
page 316.

For details about the Deep Transaction Tracing Sites view, see Chapter 25,
“Working With Deep Transaction Tracing.”

Configuration Item Status Alerts
This option is available for all CIs.

This option opens the Configuration Item Status Alerts report for the CI.
The Configuration Item Status Alerts report lists all of the alerts that
occurred in the specified period of time:

For details about the report, see Chapter 12, “Configuration Item Status
Alerts Report.”

17
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End User Summary
This option is available for Real User Monitor-specific CIs.
This option opens the End User Summary report. The End User Summary

report displays data for specific end users that were configured for Real User
Monitor in Monitor Administration.

For details, see “End User Summary Report” in Using End User Management.

For details about the Real User Monitor views, see Chapter 18, “Real User
Monitor Views in Dashboard.”

Event Count Over Time

This option is available for Real User Monitor-specific CIs.

This option opens the Event Count Over Time report. The Event Count
Over Time report displays data for all events, or sessions with events, in

monitored applications that you configured in Monitor Administration,
broken down by time intervals.

For details, see “Event Count Over Time Report” in Using End User
Management.

For details about the Real User Monitor views, see Chapter 18, “Real User
Monitor Views in Dashboard.”

Event Summary
This option is available for Real User Monitor-specific CIs.

This option opens the Event Summary report. The Event Summary report
displays a summary of events in monitored applications that you configured
in Monitor Administration.

For details, see “Event Summary Report” in Using End User Management.

For details about the Real User Monitor views, see Chapter 18, “Real User
Monitor Views in Dashboard.”
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Event Summary (Errors Monitor)
This option is available for RUM Error Events ClIs.

This option opens the Event Summary report. For details, see “Event
Summary Report” in Using End User Management.

Event Summary (Event Monitor)
This option is available for RUM Informational Events Cls.

This option opens the Event Summary report. For details, see “Event
Summary Report” in Using End User Management.

Event Summary (HTTP Error Monitor)
This option is available for RUM HTTP Error Events CIs.

This option opens the Event Summary report. For details, see “Event
Summary Report” in Using End User Management.

Event Summary (Information Event Monitor)
This option is available for RUM Informational Event Monitor CIs.

This option opens the Event Summary report. For details, see “Event
Summary Report” in Using End User Management.

KPIs Over Time
This option is available for all Cls.

This option opens the KPIs Over Time report for the CI. The KPIs Over Time
report shows the status or value, over time, of selected ClIs and KPIs that are
accessible from the Dashboard application.

For details about the report, see Chapter 13, “KPIs Over Time Reports.”

19
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Operations Health
This option is available for Web Service Operation, SiteScope Monitor, and
Diagnostics Web Service Monitor Cls.

This option opens the Health Report in the Mercury Business Availability
Center for SOA application filtered for the specific operation. For details, see
“Health Reports” on page 343.

Raw Data Over Time

This option is available for all CIs.

This option opens the KPIs Over Time report for the CI. The Raw Data Over
Time report displays raw data over time for selected configuration items,
received in the data samples from Business Process Monitor sources for the
transaction from location CIs (for Business Process Monitor) or from

SiteScope Monitor, SiteScope Measurement Group, and SiteScope
Measurement CIs (for SiteScope).

For details about the report, see Chapter 14, “Raw Data Over Time Reports.”
Related Change Requests
This option is available for all Cls.

This option opens the Related Change Requests report that displays all
change requests in the system that have direct or indirect impact on the
selected CI.

For details, see Chapter 17, “Related Change Requests Report.”
SAP Transaction Changes
This option is available for SAP-specific Cls.

This option opens the SAP Transaction Changes report. The SAP Transaction
Changes report displays the SAP transactions and SAP transports and the
impact of transports on each transaction.

For details about the report, see “SAP Transaction Changes Report” on
page 244.
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For details about the SAP System view, see Chapter 19, “Using the SAP
Solution.”

SAP Transport Changes
This option is available for SAP-specific Cls.
This option opens the SAP Transport Changes report. The SAP Transport

Changes report displays the changes inside the Transport and the impact on
the SAP transaction.

For details about the report, see “SAP Transport Changes Report” on
page 246.

For details about the SAP System view, see Chapter 19, “Using the SAP
Solution.”

Server Summary
This option is available for Real User Monitor-specific Cls.
This option opens the Server Summary report. The Server Summary report

displays data for the servers that are monitored by the Real User Monitor
probe.

For details about the report, see “Server Summary Report” in Using End User
Management.

For details about the Real User Monitor views, see Chapter 18, “Real User
Monitor Views in Dashboard.”

Service Level

This option is available for Deep Transaction Tracing Cls.

This option opens the Service Level Analysis report. The Service Level
Analysis report provides a graphical view of response time for the
transaction over time. The displayed information includes average response

time, maximum response time, and transaction volume over each reporting
time period.

For details about the report, see “Service Level Report” on page 315.
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For details about the Deep Transaction Tracing Sites view, see Chapter 25,
“Working With Deep Transaction Tracing.”

Session Analyzer
This option is available for Real User Monitor-specific Cls.
This option opens the Session Analyzer report. The Session Analyzer report

displays session data for specific applications that were configured for Real
User Monitor in Monitor Administration.

For details, see “Session Analyzer Report” in Using End User Management.

For details about the Real User Monitor views, see Chapter 18, “Real User
Monitor Views in Dashboard.”

Siebel Cross-Performance

This option is available for the Siebel Application Server, Siebel Web Server
Extension, Siebel Component Group, Siebel Component, and Siebel Web
Application ClIs.

This option opens the Cross-Performance report for the CI. The Cross-
Performance report displays the behavior of a measurement running on
several monitored servers, or the behavior of several measurements from
various types of monitors running on one monitored server.

For details about the report, see “Cross-Performance Report” on page 13.

SiteScope

This option is available for SiteScope Profile, SiteScope Group, and SiteScope
Measurement Group Cls.

This option opens the appropriate monitor page in SiteScope.

For details about SiteScope, refer to SiteScope documentation.
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Systinet Web Service Data

This option is available for Business Unit CIs, Web Service Cls, and Web
Service Operation Cls, when there is an integration between Mercury
Business Availability Center and Mercury Systinet 2. For details on the
integration with Mercury Systinet 2, see “Integrating with Mercury
Systinet 2” in Application Administration.

The option opens the Mercury Systinet 2 application, focused on the
relevant Web service. For details, see the Mercury Systinet 2 documentation.

Tracking

This option is available for Deep Transaction Tracing Cls.

This option opens the Transaction Tracking Report. The Transaction
Tracking report lists information for every instance (run) of the Business
Process Monitor transaction over a specified time period. The displayed
information includes start time, response time, and the result of the run.

For details about the report, see “Tracking Report” on page 313.

For details about the Deep Transaction Tracing Sites view, see Chapter 25,
“Working With Deep Transaction Tracing.”

Transaction Analysis
This option is available for all Cls.

This option opens the Transaction Analysis report for the CI. The
Transaction Analysis report provides an in-depth picture of the performance
of transactions.

For details about the report, see “Transaction Analysis Report” in Using End
User Management.

Trend

This option is available for all Cls.

This option opens the trend report for the CI. Trend reports enable you to
compare multiple measurements from several profiles.
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For details about the report, see “Trend Report Manager” in Application
Administration.
Triage

This option is available for Real User Monitor-specific ClIs and for Siebel-
specific CIs.

This option opens the Triage report. The Triage report displays transaction
data for Business Process Monitor, Client Monitor, and Real User Monitor
profiles for the past day.

For details, see “Triage Report” in Using End User Management.

For details about the Real User Monitor views, see Chapter 18, “Real User
Monitor Views in Dashboard.”

For details about the Siebel Sites view, see Chapter 20, “Using the Mercury
Business Availability Center for Siebel Solution.”

Web Services Health

This option is available for Web Services ClIs.

This option opens the Health Report in the Mercury Business Availability
Center for SOA application filtered for the specific. For details, see “Health
Reports” on page 343.

Go to Siebel Diagnostics

This option lists options that enable you to open specific pages in the
Business Availability Center for Siebel filtered by the selected CI.

This section includes the following reports:
“Siebel Database Breakdown” on page 25
“Siebel SARM” on page 25

“Show Tasks in Error” on page 25

“Show Running Tasks” on page 26

“Show Processes” on page 26
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Siebel Database Breakdown
This option is available for the Siebel Site, Siebel Application, and Siebel
Enterprise ClIs.

This option opens the Database Breakdown tab in Business Availability
Center for Siebel to enable you to create and analyze database logs that
record the SQL activity between Siebel components and the Siebel database.

For details, see “Using the Siebel Database Breakdown Diagnostic Tool” on
page 293.

Siebel SARM

This option is available for the Siebel Site, Siebel Application, and Siebel
Enterprise ClIs.

This option opens the SARM - User Trace Breakdown tab in Business
Availability Center for Siebel to enable you to create and record the SQL
activity in each monitored Siebel site.

For details, see “Using the SARM - User Trace Breakdown Diagnostic Tool”
on page 267.

Show Tasks in Error

This option is available for Siebel Application Server, Siebel Component
Group, and Siebel Component Cls.

This option opens a separate page with the Task Diagnostics Tool filtered by:

the selected site, server, and Exited with Error status for Siebel Application
Cls

the selected site, server, selected Component Group CI, and Exited with
Error status for Component Group Cls

the selected site, server, selected Component Group CI, selected Component
CI, and Exited with Error status for Component Cls

For details about the Siebel CIs, see Chapter 20, “Using the Mercury Business
Availability Center for Siebel Solution.”

For details about the Siebel Task Diagnostics Tool, see Chapter 23, “Using
the Siebel Tasks Diagnostic Tool.”
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Show Running Tasks

This option is available for Siebel Application Server, Siebel Component
Group, and Siebel Component ClIs.

This option opens a separate page with the Task Diagnostics Tool filtered by:
the selected site, server, Running status, and Session type for Siebel
Application ClIs

the selected site, server, selected Component Group CI, Running status, and
Session type for Component Group ClIs

the selected site, server, selected Component Group CI, selected Component
CI, Running status, and Session type for Component ClIs

For details about the Siebel Cls, see Chapter 20, “Using the Mercury Business
Availability Center for Siebel Solution.”

For details about the Siebel Task Diagnostics Tool, see Chapter 23, “Using
the Siebel Tasks Diagnostic Tool.”

Show Processes

This option is available for Siebel Application Server, Siebel Component
Group, and Siebel Component Cls.

This option opens the Task Diagnostics Tool filtered by:

» the selected site, and server for Siebel Application ClIs

» the selected site, server, and selected Component Group CI for Component

Group CIs

the selected site, server, selected Component Group CI, and Component CI
for Component Group Cls

For details about the Siebel Task Diagnostics Tool, see Chapter 23, “Using
the Siebel Tasks Diagnostic Tool.”

For details about the Siebel Cls, see Chapter 20, “Using the Mercury Business
Availability Center for Siebel Solution.”

For details about the Process Diagnostics Tool, see Chapter 24, “Using the
Process Diagnostic Tool.”
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Go to Problem Isolation

You can access the appropriate pages in the Problem Isolation
application filtered by the selected CI. Problem Isolation enables you to
isolate enterprise problems discovered in Mercury Business Availability
Center, and to identify likely suspects to help in solving the root cause of
the problem.

This option is available for all Cls.

This option opens the Problem Isolation application, which is also
accessible via Applications > Problem Isolation. The user enters the
application on the Problems List page.

For details about the Problem Isolation application, see Using Problem

Isolation.

Properties

This option is available for all CIs.
This option opens the Properties dialog box appropriate for the CI.

For details, see “Working with CIs in IT Universe Manager” in IT Universe
Manager Administration.

27Go to
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Show Content
This option is available for specific SAP-related and Siebel-related Cls.

For SAP-related Cls, the option displays a details file that includes details
about the configuration file, software component, or support package of the
SAP system discovered by the automatic discovery process.

For Siebel-related ClIs, the option displays a details file that includes
installation information (siebel.cfg) or the output of the list parameters for
component command using srvrmgr (parameters.cfg).

For details about the SAP-related configuration files, see “Configuration File
Details” on page 248.

For details about the Siebel-related configuration files, see “Viewing
Configuration File CI Details” on page 264.

Show Related Cis

This option is available for all Cls.

Performs a search for related Cls and displays the result in the Search tab of
View Explorer.

For details about the Search tab, see “Searching for Configuration Items” in

Working with the CMDB.

Top View

Displays a list of options similar to options in the Top View tab to view
different trees centered on the selected CI.

This section includes the following topics:

> “Show in Top View” on page 29
» “Show Path to Root” on page 29

> “Show Problematic Subtree” on page 29
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Show in Top View

This option is available for all Cls.

This option opens the Top View tab with the view’s tree centered on the
selected CI.

For details about the Top View tab, see “Dashboard Top View” on page 59.
Show Path to Root
This option is available for all Cls.

This option opens a Top View page that displays the path from the selected
CI to the root CI.

For details, see “Show Path to Root Option” on page 29.
Show Problematic Subtree
This option is available for all Cls.

This option opens a dialog box with capabilities similar to the Top View tab
capabilities. The dialog box displays all of the child CIs with Critical, Major,
or Minor status.

For details, see “Show Problematic Subtree Option” on page 30.

Show Path to Root Option

The purpose of the Show Path to Root option in the Filters or Console tab is
to open a Top View window and display the path to the root CI from the
selected CI.

For example, right-click the arrow to the right of the CI for which you want
to display the path to root, and select Top View > Show Path to Root.

29
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A Top View window opens and displays the path to the root.
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Show Problematic Subtree Option

The purpose of the Show Problematic Subtree option is to enable you to
find the problematic child CI that causes the parent CI that you selected to
have a status other than OK.

The Show Problematic Subtree option is enabled only for CIs that have at
least one KPI with a status other than OK.

When you select the Show Problematic Subtree option, a Top View window
opens to display the subtree of the selected CI with the child ClIs that have
at least one KPI with a status other than OK.
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For example, the Profilel CI has the following children:
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If you select the Top View >Show Problematic Subtree option for Profile 1,
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Acknowledging Performance Problems

The Acknowledging utility enables you to track performance problems
identified in your system and network infrastructure by keeping a record of
when the problem was acknowledged and by which user.

You acknowledge a problem by selecting the Ack check box for a CI in the
Top View, Console, and Filters tabs (you can clear the acknowledgment by
selecting the check box again). In the Console and Filters tabs you can
set/unset the acknowledgement by clicking the icon. You can also set/unset
acknowledgment and view the CI acknowledgment history by using the
context menu in the Top View, Console, and Filters tabs.

After a problem CI is acknowledged, or the acknowledged status is cleared,
you can view the history in the Acknowledged Details dialog box.

Note: The Ack check box is enabled only if there is at least one KPI defined
for the CI, and at least one of the KPIs has a status other than OK (green).

A tooltip for the Ack icon displays the current status of the CI’s

acknowledgment.
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Acknowledgement

The acknowledgrment far this CIis set,
Click to unset this acknowledgment,

Mote: You can see the ©I acknowledgment
detailsfhistory using contest menu.

By default, the Ack column is displayed. It can be hidden by users with
administrative permissions. The Acknowledgment-related right-click
options remain available. For details, see “Hiding or Showing the Ack
Column” in Application Administration.
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This section includes the following topics:

> “Viewing Acknowledgment Details” on page 33

> “Setting or Unsetting Acknowledgments” on page 35

Viewing Acknowledgment Details

After a problem CI is acknowledged, you can view the details of the current
acknowledgment or the acknowledgment history of the CI in the
Acknowledged Details dialog box.

To view acknowledgement details:

Click the down arrow to the right of a CI and select one of the following
options:

» Acknowledgment details. Displays the details of the currently opened
acknowledgment in the Acknowledgment details box.

» Cl history. Displays the details of all of the acknowledgments over time in
the Acknowledgment details box.

The acknowladgment for this CIis set

Acknowledgment details:

Date User Action Message
1/18/06 S:147 AM admin COpen set
1/18/06 5:47 AM adrmin Edit A child problem

@ The acknowledgernent details Oer histary

Add details:

Add Clear Close
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The information displayed in the Acknowledgment details box is:

Field Description

Date The date and time when the acknowledgment
status was modified.

User The name of the user who modified the status.

Action The type of action that was performed:

» Clear. When the acknowledgment history was
cleared.

» Unset. When the acknowledgment was unset.

» Info. Details were added to the acknowledgment
without changing the acknowledgment status.

» Open. When the acknowledgment was set.

» Edit. When details were added to the
acknowledgment.

Message Displays the status of the acknowledgment or the
information that was entered in the Add details
box.

2 In the Add details box, add information about the actions you are going to
perform to solve the problem. You can add information whether the
acknowledgment is Open or Closed.

3 Click one of the following buttons:

» Add to add the information you entered in the Add details box to the
acknowledgment history.

» Clear to clear the acknowledgment history. All acknowledgment details
are deleted and a new note is added to indicate that the history was
cleared.

» Close to close the dialog box. If you changed something in the dialog box
and you click Close, a message is issued indicating that data will not be
saved.
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Setting or Unsetting Acknowledgments

You acknowledge a problem by selecting the Set/Unset Acknowledgment
right-click option for a CI (you can unset the acknowledgement by selecting
the same option and clicking OK).

Note: The Ack check box is enabled only if there is at least one KPI defined
for the CI, and at least one of the KPIs has a status other than OK (green).

A tooltip for the Ack icon displays the current status of the CI's
acknowledgment.

To set or unset acknowledgement:

1 Click the down arrow to the right of a CI and select Acknowledgment >
Set/Unset Acknowledgment to open the Set/Unset Acknowledgment dialog
box or click the Ack icon to the right of the CI.

Note: The dialog box is a toggle dialog box. If you have acknowledged the
CI, the top line in the dialog box is: The acknowledgment will be unset. If
you have not acknowledged the CI, the top line in the dialog box displays:
The acknowledgment will be set.

2 In the Add details box, enter information about the acknowledgment.

The acknowledgement will be set

Add details:

0K Cancel
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3 Click OK to set or unset the acknowledgment depending on the previous

status of the dialog box.

Find Visible and Hidden Child Cls Option

36

A CI’s child CIs can be specified as included (visible) or excluded (hidden) in
a specific view. The status of any child ClI, visible or hidden, has an impact
on the status of its parent CI in any view where the parent CI appears. For
details about including or excluding child CIs, see “Include Related CIs” in
IT Universe Manager Administration.

For example, you might have the situation where, in a specific view, the
Availability KPI's status of the parent CI’s is Critical while the Availability
KPI’s status of the CI'’s child CIs are OK. When this happens, you would like
to know what caused the status of the Availability KPI to be Critical.

view: [Danidin = parent -

Performance @ +®  Availability C5+%

B %2 Dpanidinl -
=R
appl
app2

Use the Find Visible and Hidden Child Cls option to list all of the child CIs of
the selected CI in the CMDB. After the list of child ClIs is displayed, you can
search for the views the child CI belongs to and then display the child CIs
details in the specific view.
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To find the Visible and Hidden Child Cls for a specific Cl:

Right-click the CI and select the Find Visible and Hidden Child Cls option to
open the Find Visible and Hidden Child CIs dialog box and list all of the
selected CI’s child Cls that appear in the CMDB (visible and hidden).

fist_bprm_profile_Sanity_1_1

Performance (4#%  Availability 04% %

Manme Performance Availability Visible -
ﬁtx_yellowl i @=° W Search
[=: tw_red3 A - R W Search
[=: tx_greend @+* @=° ' Search
[=: ta_faill = o2 W Search
'f:tx_l,lellow2 i @=° ' Search

The Find Visible and Hidden Child CIs page displays the following
information:

» The name of the selected CI, whose child CIs you want to list, the CI’s
KPIs, and their status in the current view.

» Alist of the child CIs (visible and hidden) that appear in the CMDB, their
KPIs and their status. In the Visible column, a checkmark indicates that
the child CI is visible in the view and an X indicates that the child is
hidden in the view.
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To search for the views that include a specific child ClI:

1 Click Search to perform a search for the CIs whose names include the
selected child CI's name string in all views, and display the results in the
View Explorer search page.

Browse|Search]| ?

Search for: Iblc-c-rnberg =zl

Search in:

0 Current view
& Al views

[T Rrelated ta: l:IJ

Search

Mane = View -
':=: bloormberg ==l Danidin
[=" End
v bloarmberg ==l WS o fie
Maonitors

[=: bloomberg 22l yjow

':=: bloarmberg szl 1 Canidin
[=" End

¢ bloormberg £2l 1 se,..jew
[=" Monitors
¢ bloormberg g5l 1 yjauw

F vy

2 Click the appropriate CI in the list to display more information about the
selected CI in the selected view.

If the CI is not visible in any view, in Dashboard, the following message is
displayed: Search is complete. There are no results to display for the current
search parameters.

The CI is not visible in any view in the following situations:

» Itis included in the CMDB but does not belong to any view.

» It belongs to a view but the Exclude all child Cls option has been selected
for its parent CI in that view. For details, see “Creating a New CI” in
IT Universe Manager Administration.
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3

Working with Dashboard

This chapter describes how to work with Dashboard tabs, views, and

configuration item (Cls).

This chapter describes: On page:
Overview of Dashboard 42
Working with Views 44
Understanding KPI Status 45
Viewing Additional Information for CIs 54
Viewing Sample Details 56
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Overview of Dashboard

You access the Dashboard application by selecting Applications >
Dashboard.

Top View | Console Filters Geographical Map Custom Map Topology Map Reports |

Monitars Wiew Jﬂﬂﬂ

Name System Performance Awailability Ack
[ - @2 [+ X
@ bprn profile 2 + - -_§<¢g '-§<¢f

@ cn_profile_1 =

@ cn_profile_2 «

D0|K
£
DI9|S
E1)

@fist bprn profile 1«
@fist bprn profile 2 *

|

6

W+ |

%

@
' >! *]

] s_profile_1 *

Last Update - 05:47:19 AM

Dashboard contains the following tabs:

» Top View tab. Displays the components of the active view in a hierarchical,
top-down graphic. For details, see “Dashboard Top View” on page 59.

» Console tab. Displays the components of the active view arranged in a
hierarchical tree. For details, see “Dashboard Console” on page 71.

> Filters tab. Displays a filtered list of ClIs, according to the selected filter
option. For details, see “Dashboard Filters” on page 85.
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> Geographical Map tab. Displays an association between geographical
locations and status indicators using a maps applet. For details, see
“Dashboard Geographical Map” on page 10S.

» Custom Map tab. Displays icons representing ClIs in the view on a custom
image. For details, see “Dashboard Custom Map” on page 117.

> Topology Map tab. Displays the results of pattern views or instance views.
For details, see “Dashboard Topology Map” on page 123.

> Reports tab. Displays the Dashboard reports: Configuration Item Status
Alerts report, KPIs Over Time report, Raw Data Over Time report, Change
report, and Report Repository. For details, see “Working with Dashboard
Reports” on page 141.

Each tab contains a Last Update time, showing the time that the
information in the tab was last updated.

Notes and Limitations
Note the following when working with Dashboard:

» Itis recommended that you use Microsoft Internet Explorer as your browser
when using the Dashboard application.

» User access to Dashboard views is limited according to the viewing
permissions specified for the user. If you cannot see a view, contact your
administrator. For details, see “Configuring User Permissions” in Platform
Administration.

» The first time that you access Dashboard, you may experience a short delay
while Dashboard compiles the page.
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Working with Views

44

The CIs and relationships produced by the various CI-generating tools that
operate within Mercury Business Availability Center are stored in the
Configuration Management Database (CMDB).

The service views displayed in Dashboard are built from Cls contained in
the CMDB. These CIs are mapped together to build views that meet your
business requirements and objectives, and monitor what is important to
you. (For a more detailed explanation of how views are built, see IT Universe
Manager Administration.) Each CI has only one instance in the CMDB.
Different views can look at the same CI.

The ClIs at the lowest level of the hierarchy represent the monitor CIs, such
as SiteScope monitors, Business Process Monitor transactions, or metrics
from other external monitoring sources. The upper levels of the hierarchy
represent logical groups (that is, all CIs that may act as a parent CI to other
Cls). CI names are either taken from the external source, or as defined by the
administrator in “Creating a New CI” in IT Universe Manager Administration.

When changes are made to your organization’s infrastructure, they are
detected by the discovery process or by the monitoring source adapters.
Dashboard checks the engine every 60 seconds (default setting) for
configuration changes received from the external sources. The structure and
content of the CI hierarchies are then automatically updated and deployed
to the Dashboard application.

In addition, changes made within Mercury Business Availability Center, by
changing the profiles in Monitor Administration, or by manually updating
CIs in CMDB Administration, are also automatically deployed to Dashboard.

Key Performance Indicators (KPIs) are assigned by default to monitor Cls
and propagate up the hierarchy. You can manually assign additional KPIs to
ClIs in Dashboard Administration. For each CI, one or more Key
Performance Indicator (KPI) columns are displayed, for example, for
Availability, System, Performance, and so forth. For a list of the KPIs used in
Dashboard, see “Dashboard KPIs Detailed Description” in Application
Administration.
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For each CI, each KPI column contains status icons or values, representing
how the KPI objective is met. For details on KPI status, see “Understanding
KPI Status” on page 45.

The views may also contain dynamic hierarchies generated by the Dynamic
Node Factory definition file. These hierarchies are created in Dashboard in
runtime, based on the incoming samples. The parent for a dynamic
hierarchy is a Dynamic Node Factory CI. Note that the CIs under the
Dynamic Node Factory parent do not generally have option menus. For
more information on dynamic hierarchies, see “Working with Dynamic
Node Factory” in IT Universe Manager Administration.

Understanding KPI Status

For each CI, Dashboard displays real-time status in one or more KPI columns
used in the view. A color-coded icon (LED) is displayed for each KPI in a
view, representing the status assigned to that component for its current
performance level. In addition to the main status icon for a KPI, the KPI
column may contain additional icons showing trend and history for the CI
under that KPI.

Performance Availability
> a
P @+

s @
@+ ?
A & 7
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@+7 @ +>
*—Hisiury
Trend
Status

For explanations about trend and history icons, see “Trend and History
Statuses” on page 51.
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The status of a KPI in Dashboard provides an indication of how well a
business process or system is meeting your business objectives. Based on
traffic light colors (with additions), the Dashboard shows you whether the
KPI measurement is meeting the objective requirements (green), is critically
failing (red), or is at some business risk level between the two (olive, yellow,
orange). For more details about objectives, see “KPI Objectives” in
Application Administration.

The status of each KPI is calculated using a business rule. A different
business rule may be used for a parent CI and a child CI with the same KPI
attached. The business rules are defined for the KPI in Dashboard
Administration. For details on the rules, see “Dashboard Business Rules
Detailed Description” in Application Administration.

There are two types of CIs whose status is calculated differently:

Monitor Cl. Monitor ClIs receive real data from data samples. These data
samples are used to calculate the status of the KPIs attached to the monitor
ClIs.

The foundation of status definition for all monitor ClIs is a comparison of
performance metrics with objective values.

Group CI Status. For group ClIs (all Cls except monitor Cls), Dashboard
displays a status icon that represents a “summary” of the status for the child
components (that is, the CIs that belong to the lower level in the
hierarchical structure).

The Details tooltip for each status icon provides some information regarding
the calculation method in use for the KPI. For details, see “Viewing
Additional Information for CIs” on page 54.
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Note: The color displayed for a CI icon in Dashboard represents a summary
of interim status values for a predefined duration (the default duration value
is generally 300 seconds). The calculation of status values is an ongoing
process, using samples collected every 60 seconds (default granularity
value), thus the interim status may actually change several times over the
duration without causing any change in the color of the icon. For example,
if the icon for a transaction is red at the beginning of a duration, and during
the duration the interim status changes from red to green and back to red, at
the end of the duration the icon will still be red.

This section includes the following topics:

» “Statuses Used in Dashboard” on page 47

» “Trend and History Statuses” on page 51

Statuses Used in Dashboard

The following shows the main status levels that are used to show status for
KPIs in Dashboard (note that some of the Dashboard KPIs use text in place
of icons, but use the same color coding to indicate status as shown here):

Icon | Description Status Status Definition
1 Red with Critical The measurement calculated for the
e attached “X” KPI fell within the value range for
the Critical objective.
Orange with | Major The measurement calculated for the
" attached KPI fell within the value range for
exclamation the Major objective.
marks
. Yellow with Minor The measurement calculated for the
' attached KPI fell within the value range for
exclamation the Minor objective.
mark
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Icon | Description Status Status Definition
Olive with Warning The measurement calculated for the
~ | tilda KPI fell within the value range for
the Warning objective.

. Green OK The measurement calculated for the
KPI fell within the value range for
the OK objective.

] Gray with Uninitialized No performance measurement data
attached has yet been received for this KPI.
dash This may be the case if no

measurements have been taken for
the CI in the period since starting
Dashboard.
] Gray with Not up to date The KPI has passed a timeout period
attached (Decay) during which no new information
dash has been received.
The default timeout period is 15
minutes, and the default decay status
color is gray.
(o Gray with Stopped or The corresponding
B attached Downtime profile/group/monitor for the CI is

dash and currently disabled. For details, see

green outline “Stopped/Downtime Status” on
page 49.

Gray with Not applicable This KPI is not applicable for the CI.

white center | for this CI

Note: To change the color of the icons used at each status level, you can
customize some of the icons, or complete sets of icons. For details, see
“Specifying Different Status Icons” in Repositories Administration.
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Note the following specialized status icon information:

Change icons indicate when a change was made to a specific static attribute
of a specific CI in the Mercury Universal CMDB. For details, see “Viewing
Real-Time Changes to CI Properties” on page 78.

If all members of a group have Uninitialized status, the group status is
Uninitialized, regardless of which calculation method is in use. A group will
also have Uninitialized status if it has no children.

As long as there are one or more children in a group that have a colored
status, then one of the group business rules will be used to define status for
the group, regardless of the number of children that have Uninitialized,
Stopped, or Downtime status.

For Trend and History status, see “Trend and History Statuses” on page 51.

This section includes the following topics:

> “Stopped/Downtime Status” on page 49

> “Influence of Must and Weight on Status” on page 51

Stopped/Downtime Status

If a monitor in SiteScope or Business Process Monitor is stopped (disabled
indefinitely) or in downtime (disabled for a scheduled time period),
Dashboard displays a Stopped/Downtime status icon for the corresponding
ClIs (gray with a green outline).

Monitor_kiosk -

Performance | :_' Availability (l :_'

CI Mame Performance Availability
@ﬁccess fin ... data page ¥ - -

When the downtime or stopped period finishes, the status icon changes to
No Data until data is received for the CI.
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You can determine whether the CI is stopped or in downtime by holding the
cursor over the Stopped/Downtime icon for the CI. The displayed Details

tooltip gives the CI status, the rule that was used to calculate the result, and,
if the Cl is in downtime, to give the date and time when downtime finishes.

Details - Performance

CIname: siebel 7.7 whistle cc
Status: Minor

Calculation Rule: warst Child Rule
Held status since ! &f4/06 10:53:50 PM

The following applies for the status of groups containing Stopped or
Downtime status Cls:

If at least one child has a status other than Stopped, Downtime, or
Uninitialized, then the status for the group is calculated in the usual way, as
described in “Understanding KPI Status” on page 45.

If all of the children have either Stopped, Downtime, or Uninitialized status,
the group has Uninitialized status.

» If all of the children have Stopped status, the group also has Stopped status.

» If all of the children have Downtime status, or there is a combination of

Stopped and Downtime, the group has Downtime status, and its Details tooltip
displays the earliest time given for the end of downtime for all children in
the group.

In the Top View tab, the icon for a Stopped or Downtime status CI is shown in
gray with a green border.

&)
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Influence of Must and Weight on Status

When Must and Weight properties have been defined for the relationship
between a parent CI and a child CI, these properties have an impact on the
status calculations for the KPIs of the parent CI.

Must and Weight can be used to qualify a relationship. Weight is used for
weighted percentage status calculations. Must is used for dominant child
status calculations.

The dominant and/or weight information affects only the status of the
group to which this CI belongs, and does not affect the status of the CI
itself. The status of a group CI is based on its child CIs, and the status of a
monitor CI is based on the information received from the monitoring
source.

For more details about Weight and Must, see “Understanding the Percentage
Rule” in Application Administration.

Trend and History Statuses

The following status levels are used to show historical and trend status for
monitor Cls in Dashboard:

Icon | Description Status Status Definition

4 Small gray Downward Real-time status shows a downward
downward trend trend.
arrow

& Small gray Stable trend Real-time status shows a stable trend.
double-sided
arrow

+* Small gray Upward trend Real-time status shows an upward
upward trend.
arrow

@ Small green Historical OK All performance measurements fell

- . sel.s . .
with within the OK objective level over a
attached time period up to the present.
checkmark
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Icon | Description Status Status Definition
Small yellow | Historical At least one performance
with Warning measurement fell within the
attached Warning objective level, but no
exclamation measurements fell within the Critical
mark objective level, over a time period up
to the present.
3 Small red Historical At least one performance
" with Critical measurement fell within the Critical
attached “X” objective level, over a time period up
to the present.

The trend status has three positions: up, down, and no change. It shows the

trend of the real-time status.

The history status can display the worst status or the average status over a

time period.

Note: No history or trend status is displayed for a CI if there is no relevant
data, for example, if it is uninitialized or stopped, or if it is not relevant for

the KPIL.

Trend status tooltips display the following information:

CI name:

# Trend - Performance %

bprn_profile_2
Trend: Stable

» Trend followed by the name of the KPI

» Cl name. The name of the CI.

» Trend. The trend of the KPI in the selected time period.

52




Chapter 3 » Working with Dashboard

History status tooltips display the following information:

CI name! cpu netapp
History type: Wi arst
Historical worst: Critical

> History followed by the name of the KPI.

» Cl name. The name of the CI.

> History type. The history calculation type to be used when calculating history

status. Values can be: Worst, Average, or None (no history status displayed). The
value of the parameter is assigned to the HistoryType rule global parameter.
For details, see “Configuring the Rules Global Parameters” in Application
Administration. If the value is none, the historical information is not
displayed.

Historical <worst|average|none>. The worst or average status of the KPI in
the selected time period. The information that is displayed depends on the
value assigned to the HistoryType rule global parameter.

For more information on how to customize your trend and history statuses
and explanations about how those statuses are calculated, see “Status
Calculations” in Application Administration.

You can customize the set of Trend and History icons. For details, see
“Specifying Different Status Icons” in Repositories Administration.
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Viewing Additional Information for Cis

54

You can view additional information for a CI in a Details tooltip by holding
the cursor over the status icon for the CI. Details tooltips provide additional
textual information for the CI, such as the current status, how long the icon
has held the current status, the thresholds used to calculate the status, and
the historical worst value. For example, the tooltip for the Availability KPI of a
monitor CI is as follows:

Details - Availability

goto_accounts_whistle_sadmin

Llname frarm rcal
Status: oK
Calculation Rule: Transaction Availability Rule

Held status since:  &/1/06 09:57:37 AM
Awg. availability: 100%

Average for: 990 seconds period
Major: == 30.0%
Minor: == 50.0%
Warning : == 70.0%
okK: == 90.0%

The Critical threshold is defined by values lower than the Major threshold;
for example, in the above tooltip the Major threshold is 30%, so any value
lower than 30% means that the KPI is at Critical status.

For more information on all status calculations methods, see “Status
Calculations” in Application Administration.
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Note:

» Dashboard uses the timestamp of the database machine hosting the
Mercury Business Availability Center database. The times displayed in the
tooltips reflect the time zone setting on that machine. If you customize
the time zone setting in Mercury Business Availability Center using the
Admin > Personal Settings > General Settings option, then the
customized time zone is also used in Dashboard.

» When Dashboard is not receiving data for a Business Process profile
because a Business Process Monitor is stopped (while the profile itself is
not stopped), this is not specifically indicated in the tooltip. In this case,
after a while the tooltip Status parameter displays Not up to date, and
the Warning parameter displays the number of seconds during which no
data has arrived.

The parameters displayed in the Details tooltips vary, depending on factors
such as the CI type (group or monitor), KPI, and business rule. For details,
see “Tooltips Repository” in Application Administration.

Note: To change the color of the tooltip border and header. For details, see
“Modifying the Tooltip Border and Header Colors” in Repositories
Administration.
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Viewing Sample Details

56

If required, you can set Dashboard to provide data from the last sample that
arrived for a monitor CI. This data is viewed in the Event Details dialog box
for the CI. The Event Details dialog box displays all of the parameters for the
ClI, and gives the parameter values at the last update.

To view the Event Details dialog box for CIs, you must configure Dashboard
to save the last sample for the CI. You can configure this per KPI rule (so that
you will only see sample details for a monitor CI under that KPI), or for all
rules. For details on how to do this, see “Displaying the Last Sample Details”
in Application Administration.

Note: Storing last sample details may require use of a large amount of
memory, slowing down Dashboard performance.

After setting Dashboard to save the CI samples, the Event Details dialog box
can be opened from the Console or Filters tabs in Dashboard by clicking the
status icon for a monitor CI. (If there is an associated Event Details dialog
box for a CI, then the cursor changes to a hand when you hold the cursor
over the status icon for the CI.)

Top View Console Filters Geographical Map C

Springfield_travel_book_flight from Unionville =
Performance Y Availability @ H
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The Event Details dialog box is as follows:

Event Details - Springfield_t-avel_book_flight from Unionville

Event source

szScriptMame
instance_id
zzSessionMame
dEndTime
szldnigueldentifer
u_iSessionld
szTransactionMarme
iCormponentErrorCount
iBreakdownExists
customer_name
trans_instance_id
u_irganizationId
u_iHao=tId
u_iScriptld
szlocationMarme
sz2rganizationMame
iApplicationType
profila_narne
sampleType
u_iStatus
dResponzeTime
szHostMame
u_iTransactionld

time_starmp

Dirnension narme: Auvailability
Status: Critical
Event Message

u_iLocationId 4

Springfield_Travel_Services
eTadywebgkK2rk2qd_CRGQA==
ZI

1,127290169E9
00045245f4420003

a2
Springfield_travel_boak_flight
u}

u}

Default Cliant
-21474253337

4

4

=1

Unianville

Groupl

1

ZI

trams_t

1

1.0

Unianville

1z

1,127290169E9

Close |

The Event Source area in the dialog box contains parameters providing

information on the KPI (in the Dimension name field) for which the event
details are relevant, the date and time of the last update to the CI, and the

CI status at that update.
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The Event Message area displays the details for the CI (according to the KPI)
at the last update. Note that the Event Details dialog box is not
automatically refreshed when there is a new update for the CI. You can
refresh by right-clicking in the dialog box (outside of the Event Message
panel) and selecting Refresh, or by closing and reopening the dialog box.

You can open as many Event Details dialog boxes as required; if you move to
another application or administration page in Mercury Business Availability
Center, any open Event Details dialog boxes are closed.
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Dashboard Top View

The Top View tab provides you with a top-down view of the health of your
applications and business processes. The configuration items (ClIs) in the
view are displayed in hierarchical format within a single, interactive
graphical interface, enabling you to gain a big-picture perspective of
business availability for both the end-user and system Key Performance
Indicators (KPIs) of your organization.

This chapter describes: On page:
Navigating the Top View Tab 60
Working with the Top View Tab 63
Network Operations Center View 72
Monitoring the Connection to Tomcat 72
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Navigating the Top View Tab

When you click the Top View tab, Dashboard displays the Top View page:
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j
I
Wiew Explorer Last Update Root Child Cls Wiew If:F'Is and NOC View
message Cl their statuses/

values

For details, see “Working with the Top View Tab” on page 63.

When the Top View tab is selected, Dashboard includes the following
features:

> View Explorer. Enables you to locate configuration items (Cls) in the
application with which you are working, for example, Dashboard, Service
Level Management, or IT Universe Manager. View Explorer also enables end
users to view IT elements and the relationships between them, to select ClIs,
and to perform operations on the CIs. For details on how to use View
Explorer, see “Using View Explorer” in Working with the CMDB.
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» Last Update message. Displays the time the information in the tab was last
updated. For details, see “Monitoring the Connection to Tomcat” on
page 72.

» View. When you select a view in View Explorer, Top View displays the
selected view bar centered in the tree with all its root Cls expanded. For
details, see “Working with the Top View Tab” on page 63.

» Cls, Child Cls, and Root Cls. The tree is built from branch parent and
children configuration items (ClIs) and monitor ClIs. For details, see
“Working with CIs in IT Universe Manager” in IT Universe Manager
Administration.

» KPIs and their statuses/values. For each CI, Dashboard displays the CI's KPIs
and their real-time status as a color-coded icon (LED). For details, see
“Understanding KPI Status” on page 4S5.

» NOC View. Displays the top view tree in a separate window to be used by a
Network Operations Center (NOC). For details, see “Network Operations
Center View” on page 72.

Working with the Top View Tab

The Top View tab page enables you to see the business availability of your
system components at a glance. The CI bars in the tab provide a visual
representation of real-time IT performance metrics mapped onto business
applications, based on the hierarchy tree structure defined for each view.
The connecting lines between the bars define the relationships between the
CIs.

By presenting an integrated, single view of essential applications and
business processes, the Top View tab is able to provide you with an overall
perspective on the health of your business services, and enables you to
instantly assess how a performance issue impacts the availability of any part
of your business. Each CI in the active view is color coded to indicate the
worst status held by the CI's KPIs.
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Y Y Y Y Y Y Y

The Top View tab presents an interactive map of the CIs that can be
intuitively manipulated using the mouse, enabling you to drill down to
specific branches of the tree and to focus on particular business areas or
problem areas. For details, see below.

Select the Top View tab to display the CIs of the selected view in a top-down,
graphical diagram. Select the required view from the View Explorer. The
name of the selected view is displayed in the central bar of the diagram.

You can customize the Top View feature as follows:

“Accessing an External Application from Top View” in Application
Administration

“Customizing the Layout of the Hierarchy in Top View” in Application
Administration

“Enabling Chinese or Japanese Characters in Top View” in Application
Administration

“Specifying Different Status Icons” in Repositories Administration

This section includes the following topics:

“Accessing the Top View Tab” on page 65

“Cls and KPIs” on page 65

“KPI Icons” on page 66

“Menu Options” on page 67

“Top View and View Explorer” on page 69
“Top View Tab Functionality” on page 69

“Notes and Limitations” on page 71
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Accessing the Top View Tab

To access the Top View tab, select Applications > Dashboard and click the
Top View tab.

Cls and KPlIs

By default, the Top View tab displays four levels of CIs. The rest of the CIs
are collapsed. You can then expand a CI at the fourth level and see its
children.

You can change the default setting for the number of levels of CIs that are
displayed in Top View, on the Infrastructure Settings page. For details, see
“Modifying the Number of Levels in the Console Tab” in Application
Administration.

You can also change the default setting for the number of levels of Cls that
can be expanded in Top View, on the Infrastructure Settings page. For
details, see “Modifying the Number of Levels in the Console Tab” in
Application Administration.

Each CI contained in the view is displayed as a bar, color-coded according to
the current worst operational status for that CI. For details about color
coding, see “Understanding KPI Status” on page 45.

AN

springfield_infra_ems_logi

E

The icons displayed under a CI bar identify the relevant KPIs for the CI.
These icons are also color coded to indicate the status of that KPI.

Note: The root CI does not display KPI icons because it is a container and
not a real CIL.
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KPI Icons

A CI may have one of the following icons:

Icon Description
18 Availability KPI (with OK status)
1 Customer KPI (with OK status)

System/HP System KPI (with OK status)

OT Impact KPI (with OK status)

,-;-f Performance KPI (with OK status)
-—m

Jl PNR KPI (with OK status)

] RT Impact KPI (with OK status)

3 User KPI (with OK status)

m All other KPIs (with OK status)

Q’:, The CI has been acknowledged
Note:

In the Top View tab, the icon for a CI with a Stopped or Downtime status CI
is shown in gray with a green border.

You can customize the set of icons used in Dashboard. For details, see
“Specifying Different Status Icons” in Repositories Administration.
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For a list of the KPIs used in Dashboard, see “Dashboard KPIs Detailed
Description” in Application Administration.

The lines connecting the bars represent the branches of the tree. The bars
and lines can be manipulated to change the amount of information
displayed and the overall layout of the diagram, as described in “Top View
Tab Functionality” on page 69.

Menu Options
Right-click a CI bar to display the following menu options:

» View in Console. To view the CI’s branch in the Console tab.

> Expand to problem. To collapse the branches where ClIs do not have critical

or major statuses.

For example, if in the Mercury Tours Business view, you see that Infra support
is red, you might want to display the lower levels of the view to get a better
idea of the problem.

Monitors View m
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Right-click Infra support and select the Expand to problem option, to
collapse the non-problematic branches.

| Monitors View |

» Expand more levels. To open a number of levels (7 by default) below the
selected level.

» Set/Unset Acknowledgment. To set or clear the CI acknowledgment. For
details, see “Acknowledging Performance Problems” on page 32.

» Acknowledgment Details. To display acknowledgment information for the
CI. For details, see “Acknowledging Performance Problems” on page 32.

» Open in new window. To open a popup window that contains the page
accessed by the specified URL. This is useful to open external applications.
By default, this option does not appear in the menu.

Note: Some Top View tab functionality can be customized by users with
administrative permissions. For details, see “General Administration for
Dashboard” in Application Administration.
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Top View and View Explorer

When you select a CI in View Explorer, Top View displays the selected CI
centered in the tree with all its sub-branches expanded.

If you select a CI in the Top View tree, it is highlighted in the View Explorer.

Top View Tab Functionality

You can manipulate the Top View graphic to display any area of the tree, to
display expanded branches or collapsed branches, and to change the overall
panorama of the graphic, by using the following actions:

» Click a bar to move the bar to the center of the graphic.

» Click anywhere in the tab to change the emphasis of the graphic. The

graphic rotates to display the components of the subtree for the nearest bar.

Click and drag anywhere in the tab to move and rotate the graphic around
that point.

Expand and collapse the branches of a subtree by clicking the expand (+) or
collapse (-) symbols, displayed in the bottom right corner of the bar.

Increase or reduce the gap between each branch by holding down the ALT
button on the keyboard and dragging in the tab.

If there are branches that do not fit on the screen, the Top View graphic
displays lines emerging from the bar, to indicate the number of branches
and leaves that are hidden. Click the end of one of these lines to display the
entire hidden branch.

Monitors Yiew g
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68

Holding the cursor over a bar enables the following functionality:

» The bar is outlined in grey.
» If the CI has a long name, the bar expands to display the full name.

> A tooltip is displayed, providing status and performance data in each KPI for

the item. For an explanation of the tooltips, see “Viewing Additional
Information for CIs” on page 54.

Note: When you open the Top View tab, it displays by default the active
view at the root level, centered around the view name bar. Any
manipulation you do to the graphic is not saved; if you move to another
tab, then when you open the Top View tab again it reverts to the default
display format.

Notes and Limitations

When you open the Top View tab for a view tree with a large infrastructure,
you may experience a short delay while Dashboard builds the view.

The top view is refreshed every 30 seconds. If no change was made to the
view, the top view remains the same. If many changes have been made to a
view, or if CIs have been deleted from the view, that view’s top view is
automatically reloaded after 30 seconds and displays the changes. While
reloading, the following message is displayed in the top right corner of the
screen: The model has changed. Reloading... After reloading is complete,
the following message is displayed in the top right corner of the screen: Top
view has been updated with model changes. Last Update in the bottom left
corner of the screen indicates the last time an update of the top view was
reloaded. The refresh rate of the view can be modified. For details, see
“General Administration for Dashboard” in Application Administration.

If the Top View tab does not display Chinese or Japanese characters
properly, make sure that the Top View Font Name setting has been set to:
Arial Unicode MS in the Infrastructure Settings. For details, see “Enabling
Chinese or Japanese Characters in Top View” in Application Administration.
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» Do not select a new view in the Role-Based Views list until the currently
selected view has finished loading. Doing so may cause the browser to
freeze. If this happens, close the Top View browser page, then close any
other open Mercury Business Availability Center browser pages, and reopen
Mercury Business Availability Center.

Network Operations Center View

You can display the top view tree in a separate window to be used by a
Network Operations Center (NOC).

Monitors ¥Yiew g
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Last Update - 02:56:40 FM

Only one instance of Top View can be displayed at a time; this means that if
you are displaying the top view in the NOC View standalone window, you
do not see it in the Top View tab and vice versa.

To display the top view in the NOC View standalone window, click
NOC View at the bottom right corner of the Top View tab. To return to the
Top View tab, close the Top View standalone window.
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Monitoring the Connection to Tomcat

The Last Update message in the bottom-left corner of the tab shows
connectivity with the Dashboard servlet, running on the Tomcat servlet
engine. The Last Update message text displays the time the information in
the tab was last updated.
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Dashboard Console

The Console tab presents your views in tree format, indicating status for

each CI under each KPI.

This chapter describes: On page:
Navigating the Console Tab 72
Understanding the Console Tab Page 73
Viewing Real-Time Changes to CI Properties 78
Menu Options for Cls 79
Service Level Management Results in Dashboard 80
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Navigating the Console Tab

72

MERCURY

Business Availability Center - Dashboard

When you click the Console tab, Dashboard displays the Console page:
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For details, see “Understanding the Console Tab Page” on page 73.

When the Console tab is selected, Dashboard includes the following
features:

> View Explorer. Enables you to locate configuration items (Cls) in the
application with which you are working, for example, Dashboard, Service
Level Management, or IT Universe Manager. View Explorer also enables end
users to view IT elements and the relationships between them, to select ClIs,
and to perform operations on the Cls. For details on how to use View
Explorer, see “Using View Explorer” in Working with the CMDB.
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» Last Update message. Displays the time the information in the tab was last
updated. For details, see “Monitoring the Connection to Tomcat” on
page 70.

» Cls. The tree is built from group parent and children configuration items
(CIs) and monitor ClIs. For details, see “Working with ClIs in IT Universe
Manager” in IT Universe Manager Administration.

> KPIs and their statuses/values. For each CI, Dashboard displays real-time
status in one or more KPI columns used in the view. A color-coded icon
(LED) is displayed for each KPI in a view, representing the status assigned to
that component for its current performance level. In addition to the main
status icon for a KPI, the KPI column may contain additional icons showing
trend and history for the CI under that KPI. For details, see “Understanding
KPI Status” on page 45.

» Context tools. Click the buttons to expand, collapse, to go up or down one
level in the tree of CIs, or to switch on/off the sound alert for Critical status.
For details, see “Understanding the Console Tab Page” on page 73.

» Acknowledgment. Shows the components of the active Dashboard view
organized into the same hierarchy tree format that you defined for the CIs
in Dashboard Administration. For details, see “Acknowledging Performance
Problems” on page 32.

Understanding the Console Tab Page

The Console tab page shows the components of the active Dashboard view
organized into the same hierarchy tree format that you defined for the CIs
in Dashboard Administration. For details, see “Working with CIs in

IT Universe Manager” in IT Universe Manager Administration.

The tree is built from group ClIs (parents and children) and monitor CIs.

The KPI columns for the view (for example, System, Performance, and
Availability) contain colored indicators representing performance status for
each CI under that KPI (if the KPI is applicable for the CI). Note that if a KPI
is relevant for at least one CI in the tree branches currently displayed, then
that KPI is displayed for all CIs. The KPIs that are not relevant for a
particular CI display a hyphen (-) meaning that the KPI is not applicable for
this CI.
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For an explanation of the status icons, see “Understanding KPI Status” in
Using Dashboard.

Tip: Hold the cursor over the entry in the Cl Name column to display the
full name of a Cl in a tooltip.

You can also customize the Console Tab feature as follows:

» “Modifying the Sound Alert for Critical Status in the Console and Filter
Tabs” in Application Administration

> “Hiding or Showing the Ack Column” in Application Administration

> “Modifying the Number of Levels in the Console Tab” in Application
Administration

» “Specifying the Number of CIs that Can Be Monitored for Change in Real-
Time” in Application Administration

» “Specitying Different Status Icons” in Repositories Administration
> “Modifying the Tooltip Border and Header Colors” in Repositories
Administration

This section includes the following topics:

“Navigating in the Tree” on page 75

“Tooltips” on page 76

Y VY VYV Y

“Sound Alert for Critical Status” on page 77
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Navigating in the Tree

The Console tab top level displays the view and the status of the top level
CIs’ KPIs. The tree pane provides a “snapshot” of tree branches at two
consecutive levels (configurable default). When you first access the view, if
there is only one parent, you see the two highest levels: Mercury Tours
Business (parent) and Springfield and Unionville (children).

Top View Console Filters | Geographical Map | Custom Map | Topology Map | Reports |

Mercury Tours Business R
CI Name Systemn Performance Awailability PR

T scrinafield @ @ B P L -93M4TE

@ Unionville

If there is more than one child, all Cls are shown collapsed when you first
access the view.

You can expand each CI individually to show the child ClIs for that CI, or
you can use the Expand All/Collapse All buttons to expand all CIs in the
view (so that you see child ClIs for all CIs). Note that these buttons are
shown only when one or more of the currently displayed CIs can be
expanded or collapsed.

After a Cl is expanded using either of these methods, it remains expanded
for as long as the browser window is open, even if you move to another
Mercury Business Availability Center application.

If you move from another tab to a CI in the Console tree pane (for example,
by clicking a CI name in the Filters tab, or by selecting an option from a CI
options menu), then the relevant CI name is shown highlighted in the tree
(and in the View Explorer), and the CI is shown expanded. However, Cls
expanded in this way do not retain the setting and are collapsed again when
you move away from that level of the view.
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76

To view the Cls two levels down from the current CIs, click a drill-down link
(linked CI name). Cls are displayed as drill-down links if there is at least one
level below the CI, or if there is at least a CI with child CIs within the same
branch. In the above example, the CIs Springfield and Unionville are shown as
drill-down links because Mercury Tours Business is a CI with child CIs. Click
Springdfield to display the CI’s child CIs. The view of the tree changes;
Springfield is shown as the parent CI and the level under the selected CI is
displayed.

Springfield ﬂﬂﬂﬂ

System @ °  performance ., 1 Availability O T PNR TSI -93M 475
CI Name System Performance Awailability PHNR
Y ] ]
@ Infra supp ... pringfield * o F Vo
Y \ ]
@Trauel ser ... pringfield = < .- o 7

The CIs at the new level are by default shown collapsed; however, if the
displayed level contains only one parent CI, or if you have previously
expanded ClIs, then the child CIs are shown for the relevant Cls.

Tooltips

Hold the cursor above the icon to display a tooltip that provides more
information about the change:

Details - Performance

CI nanne ! tx_5

Status: K

Calculation Rule: warst Child Rule
Held status since ! 2/19/06 05:43:44 AM

The tooltip includes the following information:

» Cl Name. The name of the CI.

» Status. The status of the CI (calculated according to one of the status
calculation methods). It may also display:

> Not up to date. For decayed ClIs, indicating that the CI has passed its
timeout period. (For a SiteScope CI, this status is displayed after a
SiteScope monitor is disabled.)
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» Stopped. When a Business Process profile is stopped.

Calculation Rule. The name of the rule that calculates the KPI status or
value.

Held Status Since. The date and time since which this CI has held its current
operational status.

Invisible Children. Might not appear. The number of child CIs belonging to
other views, which are connected to this CI but do not belong to this view.
For details, see “Editing CI Properties” in IT Universe Manager Administration.

Sound Alert for Critical Status

Dashboard provides the option to have a sound play when a CI changes
status to Critical (red), to provide an aural notification of the change in
status.

The Sound On/Off button is displayed in the top right corner of the Console
tab. Click the button to toggle the sound on or off.

The icon tooltip indicates the action you will perform if you click the
button.

When the sound is switched on, a sound alert is played when the Console is
currently displayed and a CI’s KPI changes status to Critical (red). The
Critical status icon is also shown flashing until the next screen refresh.

Note the following additional conditions:

The sound is played only if the status of a CI’s KPI in the currently displayed
tree branches has changed to Critical. If a Cl in a hidden part of the view has
changed to Critical but does not change the status of any of the Cls in the
currently displayed branches, no sound is heard.

If the view is being loaded for the first time, no sound is played for the CI’s
KPIs that are loaded at Critical status.
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Note: The alert sound is a .wav file downloaded by the browser. If you are
using Mozilla, you must download a plug-in for playing .wav files, otherwise
no sound will be heard.

The default alert sound can be changed by users with administrative
permissions.

Viewing Real-Time Changes to Cl Properties

78

Change icons are displayed in the Console tab report and in the Filters tab
report, between the name of the CI and the down arrow to indicate that
changes were made to the CI’s or KPI's change-monitored properties, in real
time. The change-monitored properties are the properties for which the
Change Monitored parameter has been selected. For more information on
CIT definitions, see “Managing CITs” in CI Type Manager Administration.

To display real-time changes for a CI and its child CIs, the Monitor changes
check box must be selected for the CI. For details, see “Real-Time
Monitoring of CI Property Changes” in Application Administration.

A limited number (twenty by default) of CIs (and their child CIs) can be
monitored for real-time changes at any one time. This number can be
customized.

By default the Change icon is displayed for 24 hours (default value) after a
change has occurred. This time period can be customized.

Note: To view the real-time change icons you must have the Shared CMDB
feature installed. For details, see “Real-Time Monitoring of CI Property
Changes” in Application Administration.

Changes made to other Cls are displayed in the Change report. For details
about the Change report, see “Change Report” on page 191.
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The Change icons are:

+#4f  » left-pointing arrow and star indicate that at least one change-monitored
property of CI itself has changed.

+#t  » down-pointing arrow and star indicate that at least one change-monitored
property of the CI’s child CIs has changed.

35 > both left-pointing and down-pointing arrows and star indicate that at least
one change-monitored property of the CI and at least one
change-monitored property of the CI’s child CIs has changed.

Hold the cursor above the icon to display a tooltip that provides more
information about the change:

Change - This CI and those related to it have changed

=) bloormberg s=l 1 from part-tng
=
2 v bloomberg ssl 1

=) bloomberg ==l 1 from wall

» The tooltip header indicates whether the change was made to the CI, the
CI’s child ClIs, or both.

» The tooltip body lists the CIs that were changed.

Menu Options for Cis

- You click the down arrow to the right of a CI name to access the menu
options for that CI. The available options vary, depending on the CI type
and on the context menu defined for the CI. If no context menu is defined
for the CI, then it will not have a menu arrow. If one of the menu options is
not supported for the selected CI, that option is shown disabled.

The menu options are available for Cls in the Console and Filters tabs. For
information on the various menu options, see “Context Menus Repository”
in Application Administration.
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The menu options available for a CI may include the following
functionality:

Enable you to move to other Mercury Business Availability Center
applications or SiteScope to view information and reports related to the CI;
for example, you can view a trend report on the End User Management
page, containing measurement data for the CI over a specified time period.

Enable you to move to the Filters tab to view ClIs for a CI’s subtree. You can
select an option to filter the subtree CIs and monitor Cls, in which case the
Cls are filtered according to the current active filter selected in the Filters
tab.

For details about the menu options, see Chapter 2, “Dashboard Menu
Options”.

Service Level Management Results in Dashboard

80

You use the Dashboard Console to proactively monitor your service level
agreements (SLAs). The console displays a PNR KPI bar that enables you to
see which SLAs are problematic. You can drill down to see which specific CI
may cause you to breach a service contract.

Dashboard calculates whether the measurements of an SLA are within the
limits set out in a service level agreement (as defined in Service Level
Management). Furthermore, Dashboard calculates whether an SLA is in
breach of contract, or may be in breach in the near future.

Dashboard displays the results color-coded according to the status of the CI
(that is, whether the CI is functioning within the SLA’s time constraints).

For details on attaching a PNR (point of no return) KPI to a CI to view data
in Dashboard, see “Attaching a PNR KPI to a CI” in Application
Administration.

This section includes the following topics:

» “PNR Details” on page 81
» “How Dashboard Calculates Unavailability” on page 82
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PNR Details
The following example shows the PNR of an SLA:

PNR LI -18M 475 Acle &)

Details - PNR

CI name: profilel
Status: Breached
Calculation Rule: Dashboard PHR
SLA: alga

Tracking Period: Hour

Time Interval: 24x7
Calculation Time ! 1/13/06 12:00:00 PM
PHR Time Left: -18min, 47zec
Max unavailability: 1min. 12sec
PNR availability: 66,67 %

Target availability : 95.0%

» Cl name. The name of the CI that is attached to the SLA.

» Status. The status of the SLA as defined in the Edit KPI dialog box. For

details, see “Defining an SLA: KPIs” in Application Administration.

Calculation Rule. The name of the rule that was used to calculate the value
of the PNR.

» SLA. The name of the SLA.

» Tracking Period. The time period by which Service Level Management filters

the calculation (in this example, Hour).

Time Interval. The actual period of time for which Service Level
Management calculates data.

Calculation Time. The date and time from when Service Level Management
begins calculating the SLA. In this example, the time period being measured
is 1/19/06 12:00:00 PM to 1/19/06 01:00:00 PM.

PNR Time Left. The time remaining before the service level agreement (SLA)
contract is breached (in this example, 18 minutes and 47 seconds).

Max Unavailability. The maximum time that a KPI may be unavailable (in
this example, 1 minute and 12 seconds) without breaching the SLA contract.
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82

> PNR Availability. The availability percentage of the KPI at the last time data

was polled. PNR availability is calculated from the start of the time range (by
default, at 00:00) till the current time.

Target Availability. The percentage of time that the KPI must be available,
according to the SLA. For an example of unavailability, see the next section.

Note: The PNR KPI takes the score of the worst result from the lower levels
of the SLA (the worst child result).

How Dashboard Calculates Unavailability

Service level agreements regularly include a clause covering unavailability,
that is, the period of time that a system may be down. For example, if
availability must be 98.5%, then a system may be unavailable 1.5% of the
time.

The Dashboard PNR Rule (the rule always assigned to the PNR KPI)
calculates unavailability according to the target availability for the CI (the
time that the component must be available, according to the SLA). This
calculation is also based on the measurements for the Service Level
Management Availability KPI that is attached to the CI when creating the
SLA.
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The following example shows how Dashboard calculates the time a system
may be unavailable:

The start of the week is Monday, 8 Aug 05 00:00 AM.

Today is Friday 12 Aug 05 10:15 AM.

The time range is Week to Date.

The time interval is Business Hours, that is, 8:00 AM to 5:00 PM, Monday
to Friday.

The time that has passed for this time range is:

4 whole days (Monday to Thursday) =4 x 9 = 36 hours.

Part of a day (Friday) = 8:00 AM - 10.15 AM = 2.25 hours.
Total time = 38.25 hours.

Availability (as defined in SLA) = 98.5%

Availability, therefore, must be 98.5% x 38.25 = 37.68 hours.
Maximum unavailability = 38.25-37.68 = 0.57 hours.

If unavailability reaches above this limit, Dashboard changes the status icon
colors in the SLM tab.
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Dashboard Filters

The Filters tab enables you to view operational status for specific segments
or components of your business. The Filters tab displays (in a flat
non-hierarchical way) the configuration items (Cls) that match the
following criteria: they belong to the selected view, and at least one of their
Key Performance Indicators (KPIs) has the status specified in the active filter.

This chapter describes: On page:
Navigating the Filters Tab 86
Understanding the Filters Tab 88
Setting Active Filters 91
Searching for Specific CIs and Filtering the Results 97

Quick Filter 101
Menu Options in the Filters Tab 104
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Navigating the Filters Tab

When you click the Filters tab, Dashboard displays the Filters page:
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For details, see “Understanding the Filters Tab” on page 88.

When the Filters tab is selected, Dashboard includes the following features:

View Explorer. Enables you to locate configuration items (CIs) in the

application with which you are working, for example, Dashboard, Service
Level Management, or IT Universe Manager. View Explorer also enables end
users to view IT elements and the relationships between them, to select Cls,
and to perform operations on the CIs. For details on how to use View

Explorer, see “Using View Explorer” in Working with the CMDB.
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Quick filter. Enables you to create a temporary filter to display CIs whose
KPIs have one of the selected statuses. For details, see “Quick Filter” on
page 101.

Last Update message. Displays the time the information in the tab was last
updated. For details, see “Monitoring the Connection to Tomcat” on
page 70.

Cls. The tree is built from branch parent and children configuration items
(CIs) and monitor ClIs. For details, see “Working with CIs in IT Universe
Manager” in IT Universe Manager Administration.

KPIs and their statuses/values. For each CI, Dashboard displays real-time
status in one or more KPI columns used in the view. A color-coded icon
(LED) is displayed for each KPI in a view, representing the status assigned to
that component for its current performance level. In addition to the main
status icon for a KPI, the KPI column may contain additional icons showing
trend and history for the CI under that KPI. For details, see “Understanding
KPI Status” on page 45.

Active filter. Enables you to create filters that enable you to filter the ClIs
displayed in the Filters tab, enabling you to focus on the specific view, on
specific CI types or statuses, or on problematic areas. For details, see “Setting
Active Filters” on page 91.

Alarm. Switches on/off the sound alert for Critical status. For details, see
“Sound Alert for Critical Status” on page 77.

Acknowledgment. Shows the components of the active Dashboard view
organized into the same hierarchy tree format that you defined for the CIs
in Dashboard Administration. For details, see “Acknowledging Performance
Problems” on page 32.
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Understanding the Filters Tab

88

The Filters tab displays a filtered list of CIs and the current operational status
in each Key Performance Indicator (KPI) for each CI. The displayed Cls
belong to the selected subtree. All CIs in the Filters tab are shown at the
same level (non-hierarchically).

Active Filters: | alobali Show All = ﬂ
Quick Filter by Statuses: [+ ] [ O @0 -§< [mS O [l O Il Iﬁ Apply
Hame Performance  Awvailability OT Impact Held status since Ack |
(D blocmberg ssl + petails Qe - 12:31:55 PM x|

(D bloomberg szl v Detsils et 12:23:40 PM &

(P bloombera ssl 1 v petails 9+ 9+ 07:32:40 PM x|

@ bloomberg ss1 1 * Details 9+° @+ $0 12:23:10 PM X

= bloornberg ... m rovaloak * Details @+ 9+* $o0 12:23:10 PM e

6 bloarnberg ... m rovaloak * Details 9s® @+ 12:31:55 PM

B bloomberg ... m rovalosk v Details @+ L Ao 12:31:95 PM

e bloarnberg ... m rovaloak ¥ Details 9s® Qs $0 12:23:10 PM ed

B2 bloomberg szl 1 fram Wall ¥ Details o @+ 12:23:40 PM td

= bloormberg ==l 1 from Wall * Details 92 [ R 12:25:40 PM x|

&2 bloarnberg ssl 1 from Wall * Details #® @+ 12:23:40 PM td

= bloomberg szl 1 from Wall * Details Qs Qs 12:23:40 PM e

(D bloomberg szl 2  Detsils Get 9+ 07:32:40 PM ]

(7 bloamberg ssl 2 + petails Qe L Lo $0 12:23:10 BM x|

2 bloombera .. m rovaloak v Details @2 @ $0 12123110 BM |

ez bloomberg ... m rovaloak ¥ Details -.&%‘,E 9+ 12:31:55 PM e

X bloombera .. m rovaloak v Details Qo2 @ $0 12123110 BM x|

r [ P T R (RO W - W O Q2 [ L3 12:31:55 PM < B

If none of a CI's KPI statuses match the filter, the CI is not listed.
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The Filters tab contains the following components:

Active Filters link. Define or modify active filters in the Defining/Editing
Filters dialog box. For more information, see “Setting Active Filters” on
page 91.

List of existing filters. Select a filter from the Active Filters list. The filter can
be one of the predefined filters or a custom filter.

Quick Filter by Statuses. Select a combination of KPI statuses in the Quick
Filter bar. For details, see “Quick Filter” on page 101. You can also use one of
the options in the list to further filter the results:

» All. To display all types of CIs whose KPIs match the selected
combination of KPI statuses selected in Quick Filter.

» Monitors only. To display only the monitor CIs whose KPIs match the
selected combination of KPI statuses selected in Quick Filter.

» All excluding monitors. To display all types of Cls, except the monitor
Cls, whose KPIs match the selected combination of KPI statuses selected
in Quick Filter.

» Click Apply to apply the Quick Filter selection to the display.

» Sound On/Off. Enables a sound to be played when a CI changes status to

error/worst (red), to provide an aural notification of the change in status.
For more information, see “Sound Alert for Critical Status” on page 77.
The table of filtered ClIs includes the following information:

Name. Displays the filtered list of CIs. You can click a specific CI name to
move to that CI in the Console tab. The relevant CI is shown highlighted in
the View Explorer.

The arrow to the right of a CI name opens the options menu for the CI. For
details, see “Menu Options in the Filters Tab” on page 104.

For details about the Console tab, see “Dashboard Console” on page 71.

KPIs. Displays text or an icon indicating the current operational status of
each CI. For an explanation of the color coding for status icons, see
“Understanding KPI Status” in Using Dashboard.

Held Status Since. The time and date when the KPI status changed to the
current status.
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» Ack. Displays an icon that represents the CI Acknowledgment status. For

details, see “Acknowledging Performance Problems” on page 32.

A Details tooltip for each status icon provides some information regarding
the calculation method in use for the KPI.

Details - Performance

CIname: siebel 7.7 whistle cc
Status: Minor

Calculation Rule: warst Child Rule
Held status since ! &f4/06 10:53:50 PM

For details, see “Viewing Additional Information for CIs” on page 54.

This section includes the following topics:

» “Customizing the Custom Filter” on page 90

> “Tips” on page 90

Customizing the Custom Filter

You can customize the custom filter as follows

“Modifying the Sound Alert for Critical Status in the Console and Filter
Tabs” in Application Administration

> “Hiding or Showing the Ack Column” in Application Administration
» “Specifying the Number of CIs that Can Be Monitored for Change in Real-

Time” in Application Administration

> “Specifying Different Status Icons” in Repositories Administration

> “Modifying the Tooltip Border and Header Colors” in Repositories

Administration

Tips
You can sort the information displayed in the Filters tab according to the

entries in any column by clicking the column header. You can toggle
between ascending and descending order by clicking the header again.

If you select (in the View Explorer) a specific CI, the filter works only on the
CI'’s subtree.
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» If you select the view's root, the filter is applied to the whole view.

» Hold the cursor over a CI to display its full name in a tooltip.

Setting Active Filters

Y Y VY Y

You use the Active Filters capability to create filters that enable you to filter
the Cls displayed in the Filters tab, enabling you to focus on the specific
view, on specific CI types or statuses, or on problematic areas.

The currently active filter is displayed in the Active Filters box in the Filters
tab. You select an alternative filter from the Active Filters list.

The Active Filters list contains the Dashboard predefined filters (shown as
gray text strings) and any additional filters you have defined (shown as
black text strings).

You can also create your own filters or modify existing filters.
This section includes the following topics:

“Visibility” on page 92

“Predefined Filters” on page 93

“Defining or Customizing Filters” on page 94

“Deleting a Filter” on page 97
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Visibility
The following levels of visibility are available:

Global. The global active filters are pre-defined and built-in. They are
available for all users of all customers. The global active filters cannot be
modified. You can use the global active filters as templates to build public or
private active filters. Their names have the following syntax:
global:<name>. They appear in the list of active filters as gray text strings.
For a list of global active filters, see “Predefined Filters” on page 93.

Public. Administrators or users with the appropriate permissions can build
public active filters. The public active filters are available for all users at the
specific customer. You can use the global active filters as templates to build
public active filters. Their names have the following syntax: public:<name>.
They appear in the list of active filters as black text strings.

Private. Users can build their own private active filters. The private active
filters are available only to the user who created them. You can use the
global and public active filters as templates to build private active filters.
Their names have the following syntax: private:<name>. They appear in the
list of active filters as black text strings.

For each user name used when logging on to Mercury Business Availability
Center, Dashboard creates an associated filters file. When you log on to
Mercury Business Availability Center using a specific user name, you can
only view and modify the filters contained in the associated filters file. The
file is updated with the filter modifications made by each user who logs in
under this user name, so any changes you make to the filters may overwrite
modifications made by previous users.

Temporary. Another type of private active filter. These filters are created
when you select statuses in the Quick Filter and click Apply or when you use
the Filter subtree - Monitors only option in a CI context menu. The name of
the temporary filter is temp: Quick Filter. For details, see “Quick Filter” on
page 101. You cannot save temporary filters.
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Note:

» If more than one user is logged in at the same time using the same user
name (for example, admin), then every time one of the users saves a
change to the filters, the associated filters file is updated with a copy of
that user’s filters.

» The information displayed in the Filters tab is not refreshed while the
Defining/Editing Filters dialog box is open. (This also applies when the
Defining/Editing Filters dialog box is not in focus.)

Predefined Filters

Dashboard includes several predefined filters. Each predefined filter is used
to include or exclude Cls according to their type, and KPIs according to their
status. These filters cannot be modified or deleted. The predefined filters are
as follows:

global: Show All. Displays all of the ClIs, all their KPIs, and the status of the
KPIs.

global: Show Errors. Displays, for all CI types, only the CIs whose
Availability, Customer, HP System, OT Impact, PNR, Performance, RT
Impact, System, User, Volume, and custom KPIs have a critical status.

global: Show Errors — Monitors Only. Displays only the monitor CIs whose
Availability, Customer, HP System, OT Impact, PNR, Performance, RT
Impact, System, User, Volume, and custom KPIs have a critical status.

global: Show Errors and Warnings. Displays, for all CI types, only the Cls
whose Availability, Customer, HP System, OT Impact, PNR, Performance, RT
Impact, System, User, Volume, and custom KPIs have a minor, major, or
critical status.

global: Show Monitors Only. Displays only the monitor ClIs, their KPIs, and
the status of the KPlIs.

global: Show PNR. Displays, for all CI types, only the CIs whose PNR KPI has
an OK, Warning, Minor, Major, Critical, or No Data status.
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By default, a filter is called Custom Filter when you create a filter without

assigning it a name.

Defining or Customizing Filters

You can define new filters or customize existing filters.

To define or customize filters:

1 Select Application > Dashboard, and click the Filters tab.

2 Select the view in the View Explorer.

3 Click the Active Filters link. The Defining/Editing Filters dialog box opens.

Selec a filter : Ipriuate: Custom Filter ;I Rename Save As | MNew | Delete Clear All
visibility: ) public ) Private
Define filtar:

Fh Fih [ Fh Fh [Fh Fh Fh —

4] 4[] w1 4+ 4[] 4[] 4] L]
Application Oe Ooe O O @ Oe Oa Oo@ Oo@
Availability Ooe = (R Ooe (- Ooe Oo@ o@
Bandwidth O ok O O | O critical O | Stopped [0 powntime
bl OO 0 e [ [ & oe Ooe@ Ooe@
Custorner Ooe 0o e 0o« | 0 & Ooe o@ Oo@
?n':pF:;:ed O ok [ [ N [ critical [ [ Stopped [0 powntime
DT Late Impact [ ok | | [N [0 critical | [ stopped [ powntime
?n':;'ao:tal O ok | | | [0 critical | | Stopped [0 powntime
HP System Oe Ooe o O < 0@ (m o@ oe@
Latency O ok | | N [0 critical | [ Stopped [0 powntime [
Filter by CI type : all -
Filter by Change : IIgnore Configuration Changes ;I
Acknowledged: IAII vl

0K | Cancel Help

94




Chapter 6 » Dashboard Filters

4 Select one of the following options:

» To define a completely new filter, click New. All of the KPIs’ statuses are
cleared.

» To use an existing filter as the basis for the new filter, select the filter
name in the Select a filter list and then click Save As. The KPIs’ statuses
that were selected for the filter you are using as a model are still selected.

» To modify an existing filter, select it in the Select a filter list.

5 The Filter Name dialog box opens. Enter a name for the new filter (this must
be a unique name). This creates the new filter and adds it to the active filters
list. Click OK to save the filter to the active filters list.

Pleaze enter 3 name for the filker

||Custom Filter

0K | Cancel |

6 Select the required Visibility option:

visibility: ) Public ™ privats

» Private. If you want to create a private filter.

» Public. If you want to create a public filter.

Note: Visibility is displayed only to the administrator or to a user with the
appropriate permissions.
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7 Enter the appropriate information in the Define filter area. You can specity

any combination of the filter criteria listed in that area. The filter displays
the CIs that meet all of the selected criteria, as follows:

» Select the check box for each KPI status type that you want to include in
the filter.

Note: If no status is selected for a KPI then all statuses are included in the
filter.

To invert the selection use the Invert Selection button.
> In the Filter by Cl type list, select one of the following options:
> All. All the CI types are included (monitor and non-monitor CIs).

> All excluding monitors. All the CI types are included except for
monitor CIs that are excluded.

> Monitors only. All the CI types are excluded except for monitor Cls
that are included.

> In the Filter by Change list, select one of the following options to filter
by the CIs that are set to be monitored in real-time for changes (only 20
Cls and their children can be monitored at a time). For details, see
“Change Report” on page 191:

> Ignore Configuration Change. To display all CIs, whether their
configuration changed or not.

» Only Changed Configuration Items. To display only the CIs whose
configuration changed.

> Exclude Changed Configuration Items. To display only the CIs whose
configuration did not change.

> In the Acknowledged list, select one of the following options:
> All. To display all of the CIs whether they are acknowledged or not.
> Yes. To display the CIs that are acknowledged.
» No. To display the CIs that are not acknowledged.
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8 Click OK to save your changes to the currently displayed filter and to close
the Defining/Editing Filters dialog box.

Click Cancel to exit the Defining/Editing Filters dialog box without saving
your changes to the filter criteria for the currently displayed filter. The filter
you created is saved and will appear in the Active Filters list.

Deleting a Filter

You can delete filters.

To delete a filter:
1 Click the Active Filters link. The Defining/Editing Filters dialog box opens.

2 Select the name of the filter you want to delete from the Select a filter list.
Filters that can be deleted are shown as black text strings.

3 Click Delete. Dashboard displays a confirmation message.
4 Click OK to delete the filter from the Active Filters list.

5 Click OK or Cancel at the bottom of the Defining/Editing Filters dialog box
to close the dialog box.

Searching for Specific Cls and Filtering the Results

You can search for a specific CI using the View Explorer search function to
filter the list of ClIs that Mercury Business Availability Center displays. For
more details about the Search feature, see “Searching for Configuration
Items” in Working with the CMDB. You can locate Cls by their name, by
related ClIs, by their CITs, in the current view, or in all views.

If, in addition to using the Search feature in View Explorer, you display the
Filters tab in the right pane of the Dashboard, the resulting filtered report
displays only the CIs that have been located by the search filtered by the
selected filter in the Filters tab.

This section includes the following topics:

» “Searching for ClIs in the Current View” on page 98

» “Searching for CIs in More Than One View” on page 100

97



Chapter 6 » Dashboard Filters

Searching for Cls in the Current View

You can search for CIs by their name, by related Cls, and by their CITs in the
current view.

The result is a list of all of the CIs corresponding to the search criteria listed
in View Explorer. The Filters tab displays a filtered list of the CIs and the CI’s
children CIs corresponding to the search criteria filtered by the active filter
and the current operational status in each KPI for each one of those ClIs.

Browse|Search| 7 Top View | Console | Filters Geographical Map | Custom Map | Topology Map | Reports |
search for: Iproﬁle Active Filters: Iglobal: Show Errars ;I g
Search in:
® Current - Y y a y O o
view Quick Filter by = ' u -x “- - .-
Stat X all - Apply
Al views aruses O O O O O O O O
[ related ta: I:lJ Name System  Performiance  Awvailability Held status since Ack |~
[0 oettype: [ el &% bom profile 1 v @2 @42 0210002 PM e
s s s
P &2 bpm profile z « Q+2 @2 02:10:02 PM -]
Qe
e e o Bermslzs Qe 10:36:23 AM 2
Monitars (] O s P . .
%' bprn profile 1 ey BR¥ fist bprm profile 1 v T WxTw 02:17:02 PM — |
= Monitors - -
( S bom profile 1 ey 573 fist bpm profile 2 v @22 @4? 02:32:04 BM a8
1 = Monitors . -
4 2% bpm profile 2 gy i% labrmlzz0g v Q=2 10:36:23 AM |
= . Monitars ) _
BRZ e profile 1 gy By 15 v Q2 [ R4 02:10:02 PM e
= . Monitors : §
82 o profile 2 wjigw B 15 @2 Q4" 02:32:04 PM |
mf' b Monitors
Srefist bom e 1 view Eote 15~ @2 @+° 02:17:02 PM 28
FF_ ol . Monitors
e TIS prm ...=2 i Y -
= e — Ed i 15 @s2 @+°  02:10:02 PM =]
“ zis profile 1 Wiew = § .
haad [ & N N
Monitors Bitx 15 v @2 @ 02:10:02 PM -]
* termnp profile W § §
Bty 15 v [+ 3 @s° 02:17:02 PM 2
E g o @2 [ R 02:10:02 PM
Ed iy 15 v @2 (- 1 02:32:04 PM 2
B9 £y 1 failed ¥ n @2 02:17:02 PM B =
Last Update - 02:16:09 PM
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If the search result is a single CI, or if you click one of the CIs in the results
of the search list, the Filters tab displays the selected CI and the CI’s children
Cls filtered by the active filter, and the current operational status in each KPI
for each of those ClIs.

Browse|Search|?

-

Search for:

Iproﬁle

¢ current
wigw

Al views

Search in:

[ Related to:

I_ CI type:

Top View | Console I Filters Geographical Map | Custom Map

Topology Map

Reports

View

Monitors
View
Monitors
View
Maonitors
View
Monitors
View
Monitors
View
Monitors
View
Monitors
Wiew
Monitors
View
Monitors
View

bpm profile 1

o sis

temp profile

Active Filters:

I global: Show Errars

]

E

Quick Filter by ] e ! " b ‘- O O Im e
Statuses: I_ I_ |_ I_ I_ |_ I_ I— PPy
Mame Performance Availability Held status since Ack
&% born profils 1 v A @2 02:10:02 PM a8
iy 15 v Qs Qs 02:10:02 PM =
Bitx 15w @2 +° 02:10:02 PM
B7 t 1 Failed v ~ Qe 02:10:02 PM |
Bty 1 failed v -] @2 02:10:02 PM a
G tx 2 failed v = @2 02:10:02 PM -]
Bty 2 failed v = @2 02:10:02 PM a

Last Update - 02:22:

41 PM
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Searching for ClIs in More Than One View

You can search for CIs by their name, by related Cls, and by their CITs in all
of the views.

The result is a list of all of the CIs and the views in which they are included,
corresponding to the search criteria listed in View Explorer. The Filters tab

displays a filtered list of the CIs corresponding to the search criteria filtered
by the active filter and the current operational status in each KPI for each of

those Cls.
Browse|Search|? Top View | Console I Filters Geographical Map | Custom Map Topology Map Reports |
sesrch for: |—me profile_1 Active Filters: | global: Show Errors = | o]
gearch in: ) Current view .
& Al vi Guick Filter by [ S ! u & “ O C‘ all > Appl
views Statuses: 0 0 0O 0 0 0O 0O [m| _apry |
O related tor [ ]
Name Performance Availability Held status since Ack
Oertpe: [ Juf = pot Dot
B bpm_profile_1 P A 02:10:02 PM 8
Search &2 fist_bprm_profile_1 Q2 Q2 02:17:02 PM =]

Nanme = View
End Usa,..iew
End Use,..iew

H@ bprm profile 1
H% bprn profile 4
bprn profile 1 Lirans
H@ bpm profile 1 Lirans
B3 bprn profile 1 mandyview_2

Monitors
“ bprm profile 1 iy
rsa Monitors
B3¢ bpm profile 1 yjaw
=7 .
BRY bprn profile 1 MyWiew
5y .
BR% bprn profile 1 MyView2

7
a3
-

bprn profile 1 System iew

fist bprn ...e 1 End Use.iew
End Use,..iew
BRY fist bprn ...e 1 Lirans

B2 fist bprn ..e 1 mandyview 2
%fist bprn e 1 \I\"r'lizultors

BRY fist bprn e 1 MyView

Last Update - 02:28:24 PM
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You can click a specific CI in the results of the search list to display in the
Filters tab a filtered list of the CIs corresponding to the search criteria and to
the selected view, filtered by the active filter and the current operational
status in each KPI for each one of those ClIs.

Nj Browse|Search| ? Top View Console Filters Geographical Map | Custom Map Topology Map Reports |_
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search for: bpm_prafile_1 Active Filters: | globali Show Errors =l o]

Search in: % Current view .
O Al vi Quick Filter by e @ : r @ a @ @ [ 1 el
Al views Statuses: O O O O O O | O 2 =
O related o [ ]
Oertyper [ Jaf

Mame Performance Availability Held status since Ack
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Quick Filter

Quick Filter enables you to display CIs whose KPIs have one of the selected
statuses. The filter is a temporary filter that persists until you log off, until
you change its selection of statuses, or until you select another filter.

After you have selected a combination of filters to display a view’s data, you
can further refine the report by selecting specific KPI's statuses. The CIs that
are displayed have at least one of their KPIs with one of the selected statuses.
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Note: You cannot save the settings you selected in Quick Filter, but you can
create a similar filter using Active Filter. For details, see “Setting Active
Filters” on page 91.

For example, the report is as follows:

Top Wiew Console Filters Geographical Map | Custom Map | Topology Map Reports

Active Filters: I global: Shaw All ;I ﬂ
Quick Filker by Statuses: " ] O@en ged ~.'§< oend O O O O Iﬁ Apply
Name Performance Awailability OT Impact Application Held status since Ack|+
(D blosmberg ssi = Details - @2 g A 10:23:48 AM X|
[ bloomberq ssl v Details = Gt 10:25:48 AM x|
@ bloomberg =5l 1 * Details @+2 @s° 05:20:43 PM x|
(7 bloomberg ssl 1 * Details A Qs $8,906.788 2 10:23:48 AM e
B bloomberd ... m rovalosk * Details “- Qe $8,906.7 88 ‘- 10:21:18 AM td
& bloornberg ... m royaloak * Detsils @s® 9s® 10:18:17 AM
B bloomberd ... m royvalosk v Details @+ @+® 10:18:17 AM
£ bloomberg ... m rovaloak ¥ Detailz -&32 $8,906.788 - 10:21:18 AM e
] bloornberg =51 1 from Wall ¥ Details @s® @+® 10:25:48 AM td
= bloomberg s21 1 from Wall ¥ Details = G2 10:23:48 AM X
] bloornberg =51 1 from Wall ¥ Details @s® @+® 10:25:48 AM td
= bloomberg ==l 1 from Wall ¥ Details = G2 10:23:48 AM X
(T bloombera ssl 2 v Details Qe @+ 05:20:43 BM ]
(7 bloomberg ssl 2 * Details - Q=2 $o0,081.020 - 10023148 AM el
& bloornberg ... m rovaloak * Details - @+ $0,081.020 = 10:21:18 AM e
) bloormberg ... m rovaloak ¥ Details Draad @s° 10:18:17 AM 3
& bloornberg ... m royaloak * Detsils G2 9=° 10:18:17 AM e

L D P e e ~ Q=2 $9.081.929 - 10:21:18 AM =

Last Update - 10:25:49 AM

To display only the CIs whose KPIs have the OK and/or Critical statuses,
select those statuses in the Quick Filter bar and click Apply.

Guick Filter by Statuses: @ W L [ v [0 W 0 @& B 2L [ O I O m
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The following filtered report is displayed:

Top View | Console Im‘ Geographical Map | Custom Map | Topology Map Reports

Active Filters: Itemp: Cruick Filter ;I ﬂ
GQuick Filker by Statuses: * ] | | ‘oge@e ~.§< W O O O O Iﬁ Apply
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B bloomberd ... m rovalosk v Details Lo @+ - ‘- 101817 AM
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5 bloomberg =5l 1 from Wall  Details 2 Q2 . A 10:23:48 AM x|
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To display a combination of statuses:
Select Application > Dashboard, and click the Filters tab.
2 Select the view in the View Explorer.

3 Select the filter in the Active Filter list and select one of the Filters options
from the options list.

4 Click Apply to display the report.

5 Select one or more statuses in the Quick Filter by Statuses bar and click
Apply.
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Menu Options in the Filters Tab

A list of all of the menu options available in the Filters tab is provided in
Chapter 2, “Dashboard Menu Options”.
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Dashboard Geographical Map

The Geographical Map tab enables you to view an association between
geographical locations and status indicators using a map applet, or
Microsoft MSN Virtual Earth.

This chapter describes: On page:
Navigating the Geographical Map Tab 106
Overview of Geographical Maps 108
Working with the Virtual Earth Geographical Map 111
Working with the Geographical Map Applet 115
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Navigating the Geographical Map Tab

When you click the Geographical Map tab, Dashboard displays the
Geographical Map page.
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For details, see “Overview of Geographical Maps” on page 108.

When the Top View tab is selected, Dashboard includes the following
features:

> View Explorer. Enables you to locate configuration items (Cls) in the
application with which you are working, for example, Dashboard, Service
Level Management, or IT Universe Manager. View Explorer also enables end
users to view IT elements and the relationships between them, to select Cls,
and to perform operations on the CIs. For details on how to use View
Explorer, see “Using View Explorer” in Working with the CMDB.

106



Chapter 7 » Dashboard Geographical Map

search. Use this feature to perform a search in Microsoft MSN Virtual Earth
(outside of Mercury Business Availability Center).

Last Update message. Displays the time the information in the tab was last
updated. For details, see “Monitoring the Connection to Tomcat” on
page 70.

zoom. Enable you to zoom in and out to enlarge or shrink the map For
details, see “Adjusting a Virtual Earth Map” on page 113.

view. When you select a view in View Explorer, the Geographical Map tab
displays the selected view bar centered in the tree with all its root CIs
expanded. For details, see “Overview of Geographical Maps” on page 108

status of a location with group Cls or with monitor Cls. The geographical
map of the view displays the worst status at each geographical location. For
details, see “Working with the Virtual Earth Geographical Map” on

page 111.

type of display. Enable you to select different types of maps. For details, see
“Adjusting a Virtual Earth Map” on page 113.

adjustment buttons. Enable you to zoom in and out to enlarge or shrink the
map. For details, see “Adjusting a Virtual Earth Map” on page 113.

Note: If you do not have an Internet connection, the Geographical Map
page displays a maps applet graphic instead of a Virtual Earth map. For
details, see “Working with the Geographical Map Applet” on page 115.
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Overview of Geographical Maps

108

Dashboard displays, for a specific view, the corresponding geographical map
with real-time status indicators showing the worst status at different
geographical locations.

The CI location is determined by locations defined individually for the
group or leaf (monitor) CIs in a view.

Each location in the map may represent one or more Cls from the view.

For details on how to define locations and configure map settings, see
“Configuring the Geographical Map” in Application Administration.

Note: The maps applet requires that Sun JRE plug-in 1.4.2_08 be installed on
the client machine. If an earlier version is installed, then Mercury Business
Availability Center automatically tries to download JRE 1.4.2_08 when you
access the maps applet.

If you select a CI in View Explorer, the geographical map is redisplayed
automatically and shows only the selected CI and the CI’s children status
indicators if a location was specified for them.

If you search for a specific CI in the View Explorer and you click the result of
the search, the geographical map is not automatically redisplayed. The map
is redisplayed only when you go back to the browser mode. It shows only
the selected CI and the CI’s children status indicators if a location was
specified for them.

You specify the CI location when you define a new CI or when you edit a
CI's properties. For details, see “Configuration Item Properties” in

IT Universe Manager Administration. If you do not specify a geographical
location for at least one CI in the view, the Geographical Map tab displays
only the map.

If you select another view, the geographical map reloads automatically to
show the view’s CI status indicators.



Chapter 7 » Dashboard Geographical Map

If you have an Internet connection, geographical maps can be displayed
using Virtual Earth. For details, see “Working with the Virtual Earth
Geographical Map” on page 111.

If you do not have an Internet connection, geographical maps can be
displayed using a maps applet. For details, see “Working with the
Geographical Map Applet” on page 115.

You can customize the geographical map as follows:

> “Configuring the Geographical Map” in Application Administration

> “Customizing View Options” in Application Administration

Location Status Information

The map presents color-coded status indicators that represent the worst
status at each geographical location. The color coding is the same as for
other icons in Dashboard. For more information about color coding, see
“Understanding KPI Status” in Using Dashboard.

The round icon represents the status of a location with group ClIs.
The square icon represents the status of a location with monitor ClIs.

To determine a location status, Dashboard takes the worst status for all KPIs
attached to all of the CIs assigned to that location and determines an overall
worst status.

In addition to the overall worst status for each location, you can view the
worst status for all KPIs associated with the location in the location tooltip.
For details, see below.

A KPI is associated with a location if that KPI is assigned to at least one of
the ClIs attached to the location.
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110

Geographical Map Tooltips

Tooltips provide the overall status for each KPI associated with the location,
and how long the KPI has been at that status.

Performance
Location: USA, Hew vod, New Yok
Status: Critizal
Held status since: 8/23405 01:16:24 P
Caused by: bpm_profile_1

Availability

Locstion: USa, New Yok, New York
Status: Critical
Held status since: /23005 01:16:34 PM
Caused by: bpm_profile_1

The tooltip includes the following information:

Item Description

KPI Name The name of the KPI. The color of the header
indicates the overall status of the KPI.

Location The name of the location (country, city, and state, if
applicable).

Status The status of the KPI.

Held status since The time and date when the KPI status changed to
the current status.

Caused by The names of the CIs/monitors where the problem
occurred.

The city names use UTF8 format. If Mercury Business Availability Center is
working with MS-SQL Server, or an Oracle Server that is not configured for
UTES support, then when the name of a city includes non-English
characters (for example, €), these characters are displayed as empty square
brackets [ ].
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Working with the Virtual Earth Geographical Map

If you have an Internet connection you can display the geographical map
using Microsoft MSN Virtual Earth. Mercury Business Availability Center
integrates Virtual Earth online mapping functionality, available over MSN,
to enable you to use the geographical map of a view that displays the worst
status at each geographical location and detailed information about the CI’s
KPIs.

Top View Console Filters Geographical Map Customn Map Topology Map Reports

ANt et Indian Ocean

O cean

Terms ¢

To view the map applet, a user with the appropriate permissions must have
set the Use Virtual Earth parameter to true. For details, see “Selecting the
Type of Display Used for Geographical Maps” in Application Administration.
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This section includes the following topics:

» “Displaying the Virtual Earth Geographical Map for a View” on page 112

> “Displaying Additional Information about the Cls at the Location” on

page 113
“Adjusting a Virtual Earth Map” on page 113

Displaying the Virtual Earth Geographical Map for a View

You can display the Virtual Earth geographical map for a view.

To display the Virtual Earth geographical map for a view:

1 Select Applications > Dashboard.

Select a view in the View Explorer.

3 Click the Geographical Map tab to open the geographical map page for the

selected view.
You can then:

» view the status indicators to see the worst status at each geographical
location. For details, see “Location Status Information” on page 109.

» display tooltip details for each location. For details, see “Geographical
Map Tooltips” on page 110.

» display additional information about the ClIs for each location. For
details, see below.

» navigate the map to display other locations or to zoom into some
locations. For details, see “Adjusting a Virtual Earth Map” on page 113.

» open the map in a standalone page by clicking open.
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Displaying Additional Information about the Cis at the
Location

Click the status indicator in a specific location to open the KPIs Over Time
report for all of the CIs at the location. For details, see “KPIs Over Time
Reports” on page 1585.

Adjusting a Virtual Earth Map

By default, a map displayed in the Geographical Map tab has a focus area
(center of map) and a magnification that have been set by a user with the
appropriate permissions. For details, see “Adjusting a Virtual Earth Map” in
Application Administration. The adjusted map is displayed when you click the
Geographical Map tab for the view in Dashboard.

You can zoom in and out to enlarge or shrink the map using the IN and OUT
buttons in the top-left corner of the map pane.

You can also zoom in and out to enlarge or shrink the map using one or
more of the following options:

Click the flag button to shift center of map to the nearest CI.
Click the map and drag to move the map in the window.
Double-click on the map to zoom in.

Click the globe button to zoom out completely.

Click the Open in full screen button to open the map on a standalone page.
Close the page to return to Dashboard.
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You can also select how you want to display the map.

Road | Aerial | Hybrid

» click Road to display the map with the country borders
» click Aerial to display the map with the topographical features

» click Hybrid to display the map with both the country borders and the
topographical features
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Working with the Geographical Map Applet

If you do not have an Internet connection you can use the maps applet to
display the geographical map of a view. The map displays the worst status at
each geographical location and detailed information about the CI’s KPIs.

@ Gl Click anywhere to shift map center

To view the map applet, a user with the appropriate permissions must have
set the Use Virtual Earth parameter to false. For details, see “Selecting the
Type of Display Used for Geographical Maps” in Application Administration.

This section includes the following topics:

» “Displaying the Geographical Map Applet for a View” on page 116
» “Navigating the Geographical Map Applet” on page 116
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116

QA&

Displaying the Geographical Map Applet for a View

You can display the geographical map for a view using the maps applet.

To display the geographical map applet for a view:

1 Select Applications > Dashboard.
2 Select a view in the View Explorer.

3 Click the Geographical Map tab to open the geographical map page for the

selected view.
You can then:

» view the status indicators to see the worst status at each geographical
location. For details, see “Location Status Information” on page 109

» display tooltip details for each location. For details, see “Geographical
Map Tooltips” on page 110

» navigate the map to display other locations or to zoom into some
locations. For details, see “Navigating the Geographical Map Applet” on
page 116

Navigating the Geographical Map Applet

By default, a map displayed in the Geographical Map tab has a focus area
(center of map) and a magnification that have been set by a user with the
appropriate permissions. For details, see “Adjusting a Map Applet” in
Application Administration. The adjusted map is displayed when you click the
Geographical Map tab for the view in Dashboard.

You can:

click the area that interests you. The map shifts to make the location you
clicked the new center of the map.

zoom in and out to enlarge or shrink the map using the Zoom In and Zoom
Out buttons in the top-left corner of the map pane.
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Dashboard Custom Map

The Custom Map tab enables you to view the association between a custom

image that represents a view and real-time data.

This chapter describes: On page:
Navigating the Custom Map Tab 118
Using the Custom Map Tab 119
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Navigating the Custom Map Tab

When you click the Custom Map tab, Dashboard displays the Custom Map
page.
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For details, see “Using the Custom Map Tab” on page 119.

When the Top View tab is selected, Dashboard includes the following

features:

> View Explorer. Enables you to locate configuration items (Cls) in the
application with which you are working, for example, Dashboard, Service
Level Management, or IT Universe Manager. View Explorer also enables end
users to view IT elements and the relationships between them, to select Cls,
and to perform operations on the CIs. For details on how to use View
Explorer, see “Using View Explorer” in Working with the CMDB.
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» Last Update message. Displays the time the information in the tab was last
updated. For details, see “Monitoring the Connection to Tomcat” on
page 70.

» status indicator. Indicates the worst status (worst of all KPIs) of the CI. For
details, see “Using the Custom Map Tab” on page 119.

Using the Custom Map Tab

The Custom Map tab contains a diagram or a picture that represents a view
combined with Dashboard real-time status indicators.

The diagram can represent, for example, a logical network diagram, business
logic, or any other graphical representation of a view used by your
organization.

The image shown in the Custom Map tab is the one defined for the active
view. When you select a different view, the corresponding image is
automatically displayed in the tab.
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An element of the image may be associated with a status indicator
representing the status of a CI. The color of the status indicator indicates the
worst status (worst of all KPIs) of the CI. When you place the cursor over the
status indicator, a tooltip shows the name of the associated CI, and KPI
details. For details about tooltips, see “CI Status Indicator Tooltip” on

page 122.

E% Main Server g’
Flat screen

Laser printer
10.0.2.2

l/
-

! = Pen computar
Scanner Workstation

When you click a status indicator, the corresponding CI in the View
Explorer is highlighted. If necessary, the View Explorer will automatically
expand to show the selected CI.

Note:

» The tab displays the image centered in the image pane. If the image is
larger than the image pane, use the scroll bars.

» When a CI is removed from the IT universe model, the corresponding CI
icon (in Dashboard Administration) and the corresponding status
indicators (in Dashboard) are automatically removed from the relevant
custom maps.
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You can also customize the Custom Map:

> “Configuring the Custom Map” in Application Administration

> “Customizing View Options” in Application Administration

This section includes the following topics:

» “Displaying a View’s Custom Map” on page 121

» “CI Status Indicator Tooltip” on page 122

Displaying a View's Custom Map

You can display the custom map for a view.

To display a view’s custom map:

1 Select Applications > Dashboard.

Select a view in View Explorer.

3 Click the Custom Map tab to open the custom map page for the selected

view.
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Cl Status Indicator Tooltip

The tooltip associated with a CI status indicator displays information about
each KPI attached to the CI in a separate section. The color of each section
represents the color of the corresponding KPI's status. For details about the
colors, see “Understanding KPI Status” on page 45.

Details - Yolume

| CIname:

Status:

Held status since:
Details -

CI name:

Status:

Held status since:

Historical worst:

new group
Uninitialized

8/22/05 12:20:53 PM
Performance

new group

Minor

8/22/05 12:20:38 PM

Minor

Details - System

CI name:
Status:
Held status since:

new group
Uninitialized
8/22/05 12:37:13 PM

Details - Awvailability

CI name:
Status:
Held status since:

Historical worst:

new group

Lol 4

2/22/05 12:12:35 PM
Lol 4

The tooltip can display any of the following information, depending on the
KPI:

the header of each section displays Details followed by the name of the KPI
Cl name. The name of the CI.

Status. The status of the KPI.

Y VYV VY Y

Held status since. The date and time when the status changed to the current
status.

Historical worst. The tooltip of the historical status of the CI. For details, see
“Trend and History Statuses” on page 51.
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Dashboard Topology Map

This chapter describes how the Dashboard topology map enables you to
view the results of either an instance view or a pattern view defined in the
View Manager.

This chapter describes: On page:
Navigating the Topology Map Tab 124
Understanding the Dashboard Topology Map 125
Displaying a Topology Map in Dashboard 126
Understanding Topology Map Functionality 126
Using the Toolbar Options 129
Printing the Contents of the Topology Map 129
Defining a View’s Layout 130
Understanding Layout Options 130
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Navigating the Topology Map Tab

124

When you click the Topology Map tab, Dashboard displays the Topology
Map page.
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For details, see “Understanding the Dashboard Topology Map” on page 125.

message

When the Top View tab is selected, Dashboard includes the following

features:

> View Explorer. Enables you to locate configuration items (Cls) in the

application with which you are working, for example, Dashboard, Service
Level Management, or IT Universe Manager. View Explorer also enables end
users to view IT elements and the relationships between them, to select Cls,

and to perform operations on the CIs. For details on how to use View
Explorer, see “Using View Explorer” in Working with the CMDB.
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» Last Update message. Displays the time the information in the tab was last
updated. For details, see “Monitoring the Connection to Tomcat” on
page 70.

» CIl. The CIs that are displayed as the result of a pattern or an instance view.
For details, see “Understanding the Dashboard Topology Map” on page 125.

» Toolbar. The tools that are available to work with the CIs in the topology
map. For details, see “Using the Toolbar Options” on page 129.

Understanding the Dashboard Topology Map

The topology map in Dashboard displays the results of a pattern or an
instance view. You set up the topology map by creating an instance view or
pattern view in View Manager. For information on pattern views, see
“Working with Pattern Views” in View Manager Administration. For
information on instance views, see “Working with Instance Views” in View
Manager Administration.

The topology map shows the results of the currently selected view in the
View Explorer, and consists of Cls and relationships that are defined in the
view you created in the View Manager. You can change the way the maps are
displayed by selecting one of the view layouts (Hierarchical, Symmetric, or
Orthogonal). For details, see “Modifying Layer Layout” in Working with the
CMDB. You can also modify the values of the default layer layouts, as
described in “Defining Layer Layout” in Working with the CMDB.
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Displaying a Topology Map in Dashboard

1
2

This section describes how to display a topology map in Dashboard.

To display a topology map in Dashboard:
Select Applications > Dashboard and select the Topology Map tab.
In the View Explorer, select the required view from the View list.

For more information about the displayed view, see “Presentation Options
for Views” in View Manager Administration.

Understanding Topology Map Functionality

126
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This section describes topology map functionality:

“Understanding CI Icon Composition” on page 126
“Selecting Multiple CIs” on page 127

“Simultaneous Selection” on page 128

“Tooltips” on page 128

“CI Icon Colors” on page 128

“Navigating Between Different Map Levels” on page 128
“Viewing the Selected CI in the Console Tab” on page 129

Understanding Cl lcon Composition

The icon that represents each CI in the topology map is defined by the
administrator in the CI Type Manager. For information on how to assign an
icon to a CIT, see “Assigning an Icon to a CIT” in CI Type Manager
Administration.

Cl icons are made up of the following components:

» An icon.

» The group to which it belongs. For example, Network or SAP System,

appears in the upper left-hand corner.
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If an icon appears with a shadow, it means that there is an additional CI
layer beneath it, created by a parent or child organization rule defined in the
View Manager. For information on how to set up organization rules, see
“Adding Folding Rules to Relationships” in View Manager Administration. For
information on how to navigate between layers, see “Navigating Between
Different Map Levels” on page 128.

Selecting Multiple Cis

In the topology map, you can select multiple ClIs.

To select multiple Cls:

Hold down the CTRL button and click the Cls or drag the mouse diagonally
along the ClIs. The result is shown in the following figure:

g | e | §m |

stas_sis bpm_profile_1 cr_profile_2
SAP- ZMTRAMNS1 fist_bpm_profile_3 fist_bpm_profile_1

& | [ ]

SAP- ZMTRANSS  SAP- ZMTRANSA on MIG fist_bpm_prafile_4

fist_bpm_profile_2 fist_bpm_profile_5 bpm_profile_2

= .
» : 2y A
. " L L

Qren Sis salsa cm_profile_1 ticker profile

If you select multiple ClIs, only one CI has a black selection rectangle around
it, while all of the other selected CIs have red selection rectangles around
them. In this situation, when you right-click anywhere on the map to open
the context menu, the option is performed only on the CI surrounded by
the black rectangle.
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128

Simultaneous Selection

When you select a CI, it simultaneously selects the CI in both the View
Explorer and the topology map.

Tooltips

When you point to a relationship in the topology map, a tooltip is displayed
that contains the relationship CI type of the selected relationship as defined
in the CI Type Manager. For details, see CI Type Manager Administration.

When you point to a CI in the topology map, a tooltip is displayed
containing information about the CI, as seen below.

Cl narne: zap- 2mtranzd onh mig
Status: (]4

Calculation Rule: Warst Child Rule
Held status since: 2/9/06 08 20:55 PM

Availability

Cl narme: zap- zmtranzd on mib
Status: Ok

Calculation Rule: Warst Child Rule
Held status since: 2/9/06 08 20:55 PM

For details, see “Viewing Additional Information for CIs” on page 54.

Cl Icon Colors

The colors displayed for a CI icon represent the worst status of all KPIs for
the CI, apart from Change. For information on status levels, see
“Understanding KPI Status” on page 45.

Navigating Between Different Map Levels

If an icon appears with a shadow, it means that there is an additional CI
layer beneath it, created by a parent or child organization rule defined in the
View Manager (in a pattern view). For information on how to set up
organization rules, see “Adding Folding Rules to Relationships” in View
Manager Administration.

For example, if the IP CI is defined as a child of the host CI in the View
Manager, you can double-click any host icon in the topology map to display
a map of IPs connected with that host.
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To drill down to the lower level(s):

Double-click an icon with a shadow.

To move up one level in the topology map:
1 Select a CI that has an additional CI layer above it.
i 2 Click the Up layer button.

The Up layer button is enabled only if there is an additional CI layer above
it, created by a parent or child organization rule defined in the View
Manager.

Viewing the Selected Cl in the Console Tab

You can view the selected CI and its direct child CI(s) in the Console tab.

To view the selected Cl and its direct child CI(s) in the Console tab:

Right-click the required CI and select Open in Console. The Console tab
opens and displays the selected CI and its direct child CI(s). For details about
the Console tab, see Chapter 5, “Dashboard Console”.

Using the Toolbar Options

For a description of each toolbar option in the View Manager, see “Toolbar
Options” in Working with the CMDB.

Printing the Contents of the Topology Map

For a description of how to print the contents of the topology map, see
“Printing the Topology Map” in Working with the CMDB.
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Defining a View’s Layout

For a description of how to customize the layout of a specific layer in a view,
see, “Defining a View’s Layout” in Working with the CMDB.

Understanding Layout Options

For a description of how you can display the contents of the topology map
using different layout options, see “Defining a View’s Layout” in Working
with the CMDB.
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Dashboard Ticker

Mercury Dashboard Ticker enables you to monitor a selected view in a non-
intrusive manner on your desktop in a Ticker Window or in a Message

Window without opening Mercury Business Availability Center.

This chapter describes: On page:
About Mercury Dashboard Ticker 131
Understanding Mercury Dashboard Ticker 132
Controlling Mercury Dashboard Ticker Behavior 133
Modifying Preferences 134
Ticker Window 136
Message Window 137

About Mercury Dashboard Ticker

Using Mercury Dashboard Ticker, you can, without opening Mercury
Business Availability Center, select a view, select the server where Mercury
Business Availability Center is installed, adjust the rate and the scrolling

speed of the Ticker Window, and open the Message Window.

To use Mercury Dashboard Ticker, you must install it on your desktop. For

details, see “Installing Mercury Dashboard Ticker” in Application

Administration.
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Understanding Mercury Dashboard Ticker

132

After you have installed Mercury Dashboard Ticker, one of Mercury
Dashboard Ticker’s icons appears in the desktop tray bar. The type of icon

displayed indicates different situations. A tooltip is available for each icon to

describe Mercury Dashboard Ticker’s status.

Status Icon

Description

Tooltip

=

Online. The ticker has connected with
the server and is monitoring status.

Connected with
<server-url>

where server-url is
the URL of the
server.

Message. An incoming message was
received. A KPI has turned to Critical
state.

Incoming message

Offline. The server could not be found
or the response returned from the
server is not recognizable.

Offline - <reason>

where reason
explains why the
ticker is offline.

Connecting. Dashboard Ticker is
attempting to connect to the server.

The indication is an animated icon.

Connecting...

For details about installing the Ticker, see “Installing Mercury Dashboard
Ticker” in Application Administration.

Mercury Dashboard Ticker attempts to connect with the server using the
supplied server address after the period of time specified in the Update
interval parameter in the Preferences. If the server cannot be found or a
connection cannot be established, the tray icon changes to Offline. For

details about the Update interval parameter, see “Modifying Preferences” on

page 134.

The tray icon changes to Connecting if Dashboard Ticker is trying to
connect to the server.

The tray icon changes to Online when the server has connected properly.
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Every KPI in the selected view is checked. Any KPI with an error status is
checked against the information already in Mercury Dashboard Ticker. If it
is the first time this KPI appears in the view, or if the KPI's status has
changed to an error status, it is displayed in the Message Window and/or the
Ticker Window. As soon as a message is put in the queue, the tray icon
changes to Message, indicating that there is a message to be viewed.
Mercury Dashboard Ticker’s internal message queue can contain an
unlimited number of messages.

Controlling Mercury Dashboard Ticker Behavior

You can view an event in the Message Window or in the Ticker Window.
You can open the Web browser, connect to the Mercury Business Availability
Center server, and display the view in Dashboard. You can select what
information is displayed in Mercury Dashboard Ticker, and how it is
displayed.

To control some of the Dashboard Ticker behavior:

You can control the behavior of Mercury Dashboard Ticker using the
options that are displayed by right-clicking the icon in the tray bar.
Depending on the icon, a subset of the following options is displayed:

> Show Current Event. To display the event if an event is waiting in the
queue. For details, see “Message Window” on page 137.

> Show Ticker. To display the Ticker Window. For details, see “Ticker Window”
on page 136.

» Log On. Opens the default Web browser, connects to the Mercury Business
Availability Center server, and displays the view in Dashboard. For details
about the Dashboard view, see “Dashboard Console” on page 71.

> Preferences. To modify the information that is displayed in Mercury
Dashboard Ticker, and how it is displayed. For details, see “Modifying
Preferences” on page 134.

» About. To display the About window.
» Exit. To exit Mercury Dashboard Ticker.
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Modifying Preferences

134

You can view messages automatically (if you indicated so in the Preferences)
or you can click the Message icon to display the Message Window. The
Message Window fades out after 5 seconds.

If you click the icon in the Message Window, the message that it currently
displayed is removed from the queue as soon as you close the window.

If you have selected to display the Message Window automatically and you
do not click that window, the Message Window fades out after 5 seconds,
the message is considered unread. It is not removed from the queue.

Use preferences to:

» select the view whose Cls and KPIs statuses you want to display

\

Y Y Y Y Y Y

reload the views from the Mercury Business Availability Center server you
are accessing

change the server you are accessing

modify the refresh rate

change the scrolling speed of the Ticker Window

display a popup Message Window when a new message arrives
sound an alert when a new message arrives

automatically load Mercury Dashboard Ticker when you start your
computer

To modify Mercury Dashboard Ticker preferences:

Right-click the Mercury Dashboard Ticker icon in the desktop tray bar and
select Preferences.

In the Connection Settings area:

a In the BAC server URL box, enter the URL or the IP address of the server
you want to access. The URL format must be:
http://<Mercury_Business_Availability_Center_server>/<virtual_Web_URL>
where virtual_Web_URL may be, for example: MercuryAM.

b In the Update interval box, enter the update interval timeout (in
seconds). The default is 15 seconds. The minimum interval is 5 seconds.
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c Select MMS customer if you are a Mercury Managed Services customer. In
the ID box that is displayed, enter the customer ID number.

[ MMS custormer  1D: I'I

3 In the Login Information area:
a In the User name box, enter your user name
b In the Password box, enter your password

4 In the Selection area:

a In the View name list, select the name of the view you want to display in
the ticker.

b Click Reload if you want to reload the views from the Mercury Business
Availability Center server you are accessing.

c In the Number of levels, enter the number of levels you want to display
in the Ticker. When displayed in the Ticker, all levels are flattened out.

5 In the Ticker Window area:

a In the Scrolling speed list of choices, select a scrolling speed: Low, Mid, or
High. The default is Mid.

b In the Dock orientation list of choices, select where the Ticker appears on
your desktop:

» Top. The Ticker is docked at the top of the desktop.
» Bottom. The Ticker is docked at the bottom of the desktop.

» None. The Ticker is not docked. You can move it around on of the
desktop.The default is None.

6 Select Show incoming message desktop alert to automatically display the
Message Window when a new message arrives. If you do not select this
option, you have to click the message icon to display the Message Window.

7 Select Play incoming message sound alert to automatically sound an alert
when a new message arrives.
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The alert sound depends on the alert.wav file that is located in <Mercury
Business Availability Center installation folder>\Dashboard Ticker\ticker\

A user with the appropriate permissions can replace the sound of the alert
and save it in the same location under the same name. For details, see
“Moditying the Sound Alert for Critical Status in the Console and Filter
Tabs” in Application Administration.

Select Load Dashboard Ticker when my computer starts to automatically
load Mercury Dashboard Ticker when you start your computer. For details
about the Ticker Window, see “Ticker Window” on page 136.

Select Show Ticker Window when my computer starts to automatically load
Mercury Dashboard Ticker Message Window when you start your computer.
For details about the Message Window, see below.

10 Click OK to save your settings.

Ticker Window

136

The Ticker Window displays a scrolling list (from right to left) of the top
level CIs monitored by Dashboard along with icons that display the status of
each one of the CI's KPIs.

MERCURY' [x
erezhamil 5 bpm_profile_1 2 3 vitual_host_7
SRS
cl KPPl KPI

You modify the number of CI's levels you want to display by changing the
value of the Number of levels parameter in the Preferences. For details, see
“Modifying Preferences” on page 134.

The icons correspond to the icons displayed in the Top View tab in
Dashboard. For details, see “Working with the Top View Tab” on page 61.

You set the scrolling speed of Mercury Dashboard Ticker in the Scrolling
speed parameter in the Preferences page. For details, see “Modifying
Preferences” on page 134.
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When you have moved the Ticker Window to a specific location on your
desktop, the window will be displayed in the same location the next time
you select Show Ticker in the Preferences page or when you restart your
computer.

If you move the mouse to the Ticker Window, scrolling stops; it resumes
when you move the mouse out of the Ticker Window.

Hover above any icon in the Ticker Window to display a tooltip that
includes the name of the KPI. For details about tooltips, see “Viewing
Additional Information for CIs” on page 54.

MERCURY" Dashboard Ticker %
siebel78 siebel @ @ %
. Cl narne sighel
Caleulation Rule Wwarst Child Rule
Held statuz since E/27/06 03:28:09 Ak
Statusz Critic:al

If you change any parameter in the Preferences page, scrolling restarts from
the beginning.

Message Window

The Message Window is used to convey to the user that a KPI's status has
changed to error/poor/worst.

The window is displayed either automatically or manually. For details on
how to set this option, see “Modifying Preferences” on page 134.

When you close the message window, the entry that was displayed is
removed from the queue. You cannot re-display that information. When
you reopen the window, the next message in the queue is displayed.

If you specified in the Preferences that an alarm should be sounded when a
KPI's status changes to error/poor/worst, an alarm sounds when the message
is displayed.
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The Message Window displays the following information:

MERCURY" [®
Business Availability Center cl nama
-E< Cl: wall_sanityl - |7|'KP| name
EPI: Availabilty o ]
vhen: 8/23/2005 31542 AM - The date and time
EORE when the status
change was
received by Mercury
Stalus icon of the KPI Toaccess  Dashboard Ticker
Dashboard

Click Log-on to automatically open the view you specified in the
Preferences, in the Console tab in Dashboard.
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Working with Dashboard Reports

The Dashboard Reports tab enables you to view the Configuration Item
Status Alerts report, KPIs Over Time report, Raw Data Over Time report,
Change report, and Report Repository.

This chapter describes: On page:
Working with Dashboard Reports 141
Filtering by CI(s) 143
Filtering by KPI(s) 144

Working with Dashboard Reports
The Dashboard reports are:

» Configuration Item Status Alert report. Lists all of the alerts that occurred in
the specified period of time. Those alerts represent predefined performance
limits that were breached. For details, see Chapter 12, “Configuration Item
Status Alerts Report.”

> KPIs Over Time report. Displays the status or value, over time, of selected
Cls and KPIs that are accessible from the Dashboard application. For details,
see Chapter 13, “KPIs Over Time Reports.”

> Raw Data Over Time report. Displays raw data, over time, for selected
configuration items, received in the data samples from Business Process
Monitor and SiteScope sources for the transaction from location ClIs. For
details, see Chapter 14, “Raw Data Over Time Reports.”
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» Change report. Displays information about the changes to CI properties for

all CIs that were assigned to keep this information. For details, see
Chapter 15, “Change Report.” This report is listed only if you have installed
shared CMDB.

Report Repository. Displays a list of reports saved to the report repository.
For details, see Chapter 16, “Report Repository.”

You can filter the Dashboard reports by configuration item (CI), by Key
Performance Indicator (KPI), by raw data measurement, and by period of
time. For details about raw data measurements, see Chapter 14, “Raw Data
Over Time Reports”) and by period of time. For details about the period of
time, see “Choosing the Tracking Range and Granularity” in Working with
Applications.

You can print the generated report, send the report by e-mail, open the
report in different formats, publish the report in different formats, or save
the report to the report repository. For details, see “About Working in
Reports” in Working with Applications.

Note:

» Mercury Business Availability Center records in a reports log errors that
occur when generating reports. The reports log can also include the
following activities: creating a new report, generating a report, modifying
the report filter(s), drilling down in reports, and so forth. For details
about the reports log, see “Reports Log” in Platform Administration.

» Mercury Business Availability Center enables you to generate Dashboard
reports automatically, and to specify a header and a footer for those
reports. For details, see “Customizing Reports” in Platform Administration.




Chapter 11 « Working with Dashboard Reports

Filtering by CI(s)

Active filters enable you to filter specific components from reports for the
duration of a Web session. You can select specific Cls to filter Dashboard
reports.

To filter by Cl(s):

1 Click Configuration Items to open the Configuration Items Filter dialog box.

Browse|Search
Wiew: I.ﬂ.lona J

B0 T Alana
O D boston
|:| one
O @ zdzad
O |:| three
O |:| two
O D wewqge

(1134 | Cancel | Help |

2 In the View list, select the appropriate view. For additional information, see
“Filtering Data Using Active Filters” in Working with Applications.

3 Select the relevant CI(s).
4 Click OK to save the selection.
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Filtering by KPI(s)

Active filters enable you to filter specific components from reports for the
duration of a Web session. You can select specific KPIs to filter Dashboard
reports.

To filter by KPI(s):
1 Click KPIs to open the KPIs Filter dialog box.

¥ oT impact
¥ Performance
¥l availability

el | 58

OK | Cancel | Help |

2 Select the appropriate KPI(s). For additional information, see “Filtering Data
Using Active Filters” in Working with Applications.

3 Click OK to save the selection.
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Configuration Item Status Alerts Report

The Configuration Item Status Alerts option in the Dashboard Reports tab
enables you to list all of the alerts that occurred in the specified period of
time and to display detailed alert information.

This chapter describes: On page:
About Configuration Item Status Alerts Report 146
Viewing the Configuration Item Status Report 147
Viewing the Configuration Item Status Alert Notifications Report 149
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About Configuration Item Status Alerts Report

146

Note: It is recommended to use the new CMDB-based alerting mechanism
under Admin > Dashboard > Cl Status Alerts which provides greater
granularity and flexibility for configuring alerts. The existing alerting
mechanism under Admin > Platforms > Alerts and Recipients will be
gradually phased out in future releases of Mercury Business Availability
Center.

Mercury Business Availability Center alerts proactively inform you when
predefined performance limits are breached, by sending alerts to pre-defined
users. The Configuration Item Status Alerts report is a log of alerts that were
sent during a specified time period.

Users with the appropriate permissions must attach alerts to a configuration
item (CI) in a view. For details, see “Configuring CI Status Alerts” in
Application Administration. The alert is then attached to the CI in any view
where the CI is included.

You can schedule this report. For details, see “Scheduling User Reports or the
Performance Update Report” in Platform Administration.

This chapter includes the following topics:

> “Viewing the Configuration Item Status Report” on page 147

» “Viewing the Configuration Item Status Alert Notifications Report” on

page 149
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Viewing the Configuration Item Status Report

The Configuration Item Status Alerts report lists all of the alerts that
occurred in the specified period of time:

KPIs: All

View:lpastweek 'I From: /10/05 2:52 PM

Configuration Iterns: Filtered

Status =

Time

-..% Critical

O Critical

W Critical

2/17/05 2:25 PM
817705 1:11 PM
817705 11:11 AM

[#1
To: B/17/05 2:52 PM Israel Standard Time 4(r é =] L% IE
Generate
Configuration Ttem KPI Alert Action Details |+
2 bpmz Performance Access asd @
<h bpmz Performance Access asd
28 bpmz Performance Access asd |

The Configuration Item Status Alerts report displays the following

information:
Field Description
Status The current status of the KPI(s). The change from
previous status to current status triggers the alerts.
Time The time and date when the alert was triggered. The
format is: dd/mm/yy hh:mm GMT[<offset>].
Alert Name The name of the alert.

Configuration Item

The name of the CI the alert is attached to.

KPI

The name of the KPI.

Alert Action

The action that is triggered by the alert.
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To view the Configuration Item Status Alerts report:
1 Select Applications > Dashboard.
2 Select the appropriate view, CI, or KPIL.

3 You can then do one of the following to display the Configuration Item
Status Alerts report:

» click the Console tab, click the appropriate context menu, and select
Configuration Item Status Alerts

» right-click the Reports tab and select the Configuration Item Status Alerts
option

4 You can then:

» select the period of time for which you want to display the alerts. For
details, see “Choosing the Tracking Range and Granularity” in Working
with Applications.

» filter by configuration item. For details, see “Filtering by CI(s)” on
page 143.

» filter by KPI. For details, see “Filtering by KPI(s)” on page 144.

» click the Details button for the relevant alert to see the alert notification
details. For details, see “Viewing the Configuration Item Status Alert
Notifications Report” on page 149.

» print the report, send it by E-mail, open it in Excel or PDF format. For
details, see “Sharing and Storing Reports” in Working with Applications.
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Viewing the Configuration Item Status Alert Notifications
Report

To display detailed alert information, access the Configuration Item Status
Alerts page, and click the Details button for the relevant alert to open the
Configuration Item Status Alert Notifications report.

The Configuration Item Status Alert Notifications report includes the
following areas:

» Alert Details. Includes details about the alert.

alert Details

Time: 1Z/20/05 6:05 AM
Status: W arning

Alert Nama: Alert 2

Configuration Item: fist bprn_profile_1
KPI: Availability

Send E-rmail to: fist_ermail_recipient_1; Send SMS to: fist_sms=_recipient_1,
fist_sm=_recipient_1; Send Pager to: fist_pager_recipient_1; Send SMMPvl

trap to dardanelles on port 162; Send SHNMPvl trap to <GLOBAL SHMP ADDRESS>
an pott 162

Alert Action:

The details are as follows:

Field Description

Time The time when the alert was triggered.

Status The previous status of the KPI.

Alert Name The name of the alert.

Configuration Item The name of the CI to which the alert is attached.

KPI The name of the KPI whose change of status
triggered the alert.

Alert Action The action that has been assigned to the alert.
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» Action Notifications. Includes details about the notification.

Action Notifications

Type= Command Status
SHMPul Send trap to dardanelles Pass
SHMPul Send trap to Pazs

The details are as follows:

Field Description

Type The type of action notification: Executable, URL, or
SNMP trap.

Command The action that was executed:

» for executables: the command line
» for URLs: the URLs
» for SNMP traps: Send SNMP trap to <address>

Status The status of the action:

» Pass. When the action has been performed.
» Fail. When the action failed.

» Message Notifications. Includes details about the notification message.

Message Motifications

Type= Recipients Status
E-rnail fist_erail_recipient_1 Pass
Pager fist_pager_recipient_1 Pass
SMS fist_srns_recipient_1 Passz

The details are as follows:

Field Description

Type The type of message notification: E-mail, SMS
message, or Pager message.
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Field Description

Recipients The names of the recipients who receive the
notification that the alert has been triggered and
that the alert scheme has been executed.

Status The status of the message:

» Pass. When the message has been sent.
» Fail. When the message was not sent.

> Notification Messages. In the Notification Messages area displays the type
of message followed by the text of the message.

Motification Messages

=b=fist_bpm_profile_1</b> status has changed to <b>Warning</b*, <br><table
border=1=<tre=<td=<b>Trigger Time:</b>=/td><td>GMT[-02:00] 12/20/05 &:05
E-Mail Message: AM</tds<ftre <tz <td=><b=KPI Marme: </b> <ftd=<td=fuailability < td = </ tre <be <kd
=<h>KPI Value:</be</ftd=<td= N/ A< td> </tr=<tr=<td > <b>=Previous Status:</bxr<
Ftd=<td=Minor</td =</ tr=<tr><td==h=alert Mame:</b> < td><td =alert Z<itd=</. ..

fist_bprn_profile_1 status has changed to Warning.
Trigger Time: GMT[+0Z2:00]
12/20/05 4:05 PM
KPI Marme: Auvailability
Pager Message: KPI Value: M/A
Previous Status:
Minar
Alert Mame: Alert 2
Alert Description: Alert 2

fist_bprn_profila_1 status has changed to Warning.
Trigger Tirne: GMT[+02:00]
12/20/05 4:05 PM
KPI Marme: Awvailability
SMS Message: KPI Valua: MfA
Previous Status:
Minar
Alert Marme: Alert 2
Alert Description: Alert 2
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The E-mail message text format depends on the e-mail format selected by
the sender. The following format corresponds to a Long HTML format:

<b><ci-name> status</b> has changed to <b><current-status></b>.<br>
<table border=1>

<tr><td><b>Trigger Time:</b></td><td><trigger-time></td></tr>
<tr><td><b>KP| Name:</b></td><td><KPIl-name></td></tr>
<tr><td><b>KPI value: </b></td><td><KPI-value></td></tr>
<tr><td><b>Previous status:</b></td><td><previous-status></td></tr>
<tr><td><b>Alert name:</b></td><td><alert-name></td></tr>
<tr><td><b>Alert Description: </b></td><td><alert-description></td></tr>
<tr><td><b>URL: </b></td><td><URL></td></tr>

</table>

HTML is encoded in the report. The text of the e-mail received by the
recipient is decoded and is similar to the Pager message text. For more
information on the different formats available to send e-mails, or pager
messages, see “E-Mail, SMS, and Pager Message Templates” in Application
Administration.

The text of the Pager and SNMP messages has the following format:

<ci-name> status has changed to <current-status>.
Trigger Time: <trigger-time>

KPI Name: <KPIl-name>

KPI value: <KPI-value>

Previous status: <previous-status>

Alert name: <alert-name>

Alert Description: <alert-description>

URL: <URL>
where:
Field Description
ci-name The name of the CI whose change of status
triggered the alert
current-status The new status of the CI
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Field Description

trigger-time The time and date when the alert was triggered. The
format is: dd/mm/yy hh:mm GMT[<offset>]

KPI-name The name of the KPI

KPI-value The value of the KPI

previous-status The previous status of the CI

alert-name The name of the alert

alert-description The description of the alert

URL The URL of the Mercury Business Availability

Center Centers server

URL. The URL of the Mercury Business Availability Center Centers Server.

To view the Configuration Item Status Alert Notifications Report:

Access the appropriate Configuration Item Status Alerts report. For details,
see “Viewing the Configuration Item Status Report” on page 147.

Click the Details button for the relevant alert to open the Configuration
Item Status Alert Notifications report.

You can then print the report, send it by E-mail, and open it in Excel or PDF
format. For details, see “Sharing and Storing Reports” in Working with
Applications.
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KPIs Over Time Reports

The KPIs Over Time Report option in the Dashboard Reports tab enables you
to view the status or value, over time, of selected CIs and KPIs that are

accessible from the Dashboard application.

This chapter describes: On page:
About the KPIs Over Time Report 156
Customizing the Report 157
Accessing KPIs Over Time Reports 157
Understanding KPIs Over Time Reports 158
KPIs Over Time Reports with Status Data 160
KPIs Over Time Reports with Value Data 168
Drilling Down to Mercury Diagnostics 171

155




Chapter 13 ¢ KPIs Over Time Reports

About the KPIs Over Time Report

156

Y VY VY Y

KPIs Over Time reports show the status or value, over time, of selected Cls
and KPIs that are accessible from the Dashboard application. The report is
also accessible from the View Explorer.

The report includes filtering (by CI, KPI, and time). It can be displayed as a
table or a chart.

For example, when you encounter a problem with a specific CI while
viewing the Dashboard, and the Performance and Availability KPIs are
attached to that CI, you can view the KPIs Over Time report of that CI’s
Performance and Availability. You can also receive a daily report showing all
Cls statuses in the past day.

You can also add a KPIs Over Time report to a custom report. For details, see
“Custom Report Manager” in Working with Applications).

You can also schedule when to run the report. For details, see “Scheduled
Reports” in Platform Administration.

The report is designed to provide information about the KPIs of higher level
ClIs; for example, Business Services, Application, Business Processes Cls, and
so on. It is not designed to provide information about the KPIs of monitor
Cls. To obtain similar information about the KPIs of monitor CIS, see “Trend
Report Manager” in Working with Applications.

The report displays data only for CIs whose KPIs are persistent. For details,
see “Persistent Data for KPIs” on page 160.

This chapter includes the following topics:

“Accessing KPIs Over Time Reports” on page 157
“Understanding KPIs Over Time Reports” on page 158
“KPIs Over Time Reports with Status Data” on page 160
“KPIs Over Time Reports with Value Data” on page 168
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Customizing the Report
After you have created the report, you can:

» change the time frame of the existing report by using the filters. For details,
see “Choosing the Tracking Range and Granularity” in Working with
Applications.

» change the CIs you want to display. For details, see “Filtering by CI(s)” on
page 143, and for more information see “Filtering Data Using Active Filters”
in Working with Applications.

» change the KPIs you want to display. For details, see “Filtering by KPI(s)” on
page 144.

> print the report, send it by e-mail, or save it in PDF or Excel format. For
details, see “Sharing and Storing Reports” in Working with Applications.

» customize the report by adding a header and a footer, by selecting to
automatically or manually generate the report, and/or by customizing other
display elements. For details, see “Customizing Reports” in Platform
Administration.

Accessing KPIs Over Time Reports

You can access the KPIs Over Time reports from different locations in
Mercury Business Availability Center.

To access KPIs Over Time reports:
1 Select Applications > Dashboard.
2 To open the KPIs Over Time page, you can:

» right-click a specific CI in the View Explorer and select the Go to Report
> KPIs Over Time Reports option

» right-click a specific CI in the right pane of Dashboard and select Go to
Report > KPIs Over Time Report

> select the KPIs Over Time Report option in the Reports tab

157



Chapter 13 ¢ KPIs Over Time Reports

Note: The context menu includes the KPIs Over Time Report option for all
ClIs except for monitors. The report displays data only for CIs whose KPIs are
persistent. For details, see “Persistent Data for KPIs” on page 160.

3 If relevant, click Configuration Items to select the relevant Cls for the report.
For details, see “Filtering by CI(s)”.

4 If relevant, click KPIs to select the relevant KPIs for the report. For details,
see “Filtering by KPI(s)”. If you do not select specific KPIs then the data of all
of the KPIs for the selected Cls is displayed in the report.

For details about the KPIs Over Time report, see “Understanding KPIs Over
Time Reports” on page 158.

Understanding KPIs Over Time Reports

You can select to display data only about status-based KPIs or about value-
based KPIs. To reflect these capabilities, two types of KPIs Over Time reports
are available:

> reports that display status information. For details, see “KPIs Over Time
Reports with Status Data” on page 160. To display such information, the
KPIs must be persistent. For more details, see “Persistent Data for KPIs” on
page 160.

> reports that display value information. For details, see “KPIs Over Time
Reports with Value Data” on page 168.
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KPIs Over Time reports display the status or value of each CI and each
instance of the attached KPIs. For example, when you select two Cls and the
Availability and Performance KPIs, the performance KPI is not attached to
the first CI, and the report has only three rows:

(d] KPI

First Availability

Second Availability
Performance

The statuses are shown over time, starting with the event and ending with
the next event.

This section includes the following topics:

> “Collecting Data” on page 159

» “Persistent Data for KPIs” on page 160

Collecting Data

To display the status or value of each CI and KPI instance in the KPIs Over
Time report, you must set specific attributes so Mercury Business Availability
Center collects the appropriate information.

These settings store the following information in the database for each CI
with the Save historical data for this ClI option selected:

» every status change for each KPI

» the current calculated value for each KPI, read at regular time intervals (the

default time interval is 15 minutes)

When the settings described above are first selected, the current status for all
of the CI KPIs is written to the database. As long as the settings remain the
same each time there is a change in status for one of the CI’s KPIs (for
example, from Critical to OK), the status change is written to the database.
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Note: Saving historical data for long periods of time or for many Cls and
KPIs can require a lot of database memory, so this option should be used
with care. When you no longer require data to be saved for a CI, deselect the
Save historical data for this Cl check box for that CI.

To save status data:

1 Select Admin > Dashboard > KPlIs.

Select the appropriate CI in View Explorer.

3 Select the Save historical data for this Cl option.

To save value data:

Make sure the Save historical data for this Cl option has been selected for
the CI (it is selected by default). For details, see the procedure above.

Set the saveValuesToPersistency global attribute to true in all of the rules.
For details, see “Configuring the Rules Global Parameters” in Repositories
Administration.

Persistent Data for KPIs

A KPI whose data is persistent is attached to a CI whose Save KPI data over
time for this Cl option has been selected. For details, see “Saving KPI Data
over Time for a CI” on page 32. This option is selected by default for
Business Services, Applications, Business Processes, and others. This option
is not available for Monitor type Cls.

KPIs Over Time Reports with Status Data
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If you select the Statuses option when you generate a KPIs Over Time report,
the report displays only the status of the relevant KPIs. Those KPIs may also
have values in the Mercury Universal CMDB but the status report will not
show those values.

The reports can be displayed in graph or table format.
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This section includes the following topics:

“View as Graph” on page 161
“View as Table” on page 167

View as Graph
The graph shows all of the selected CIs and KPIs.

Configuration Ttem = KP1 Status

Y7 app_world_2
@ trxl_EUM
D trs_general

Performance
Perfarmance

Perfarmance

T T T T
2/5/2003 /72005 8/9/2005 8/11/2005
2:04 PM 2:04 PM 2:04 AM 2:04 AM

||:| ok [ warning  [] Minor [ Major [ critical [0 Downtime  [] Mo Data |

When you select Cls and do not select specific KPIs, all of the KPIs that have
been attached to the selected Cls and have historical data in the database are
displayed.

The graph displays the following information:

Item Description
Configuration Item The name of the selected configuration item.
KPI The name of the KPI. The information for each KPI

of each Cl is displayed in a separate line.

Status The status of each KPI of each CI during the selected
time period.

You can drill down:

to a specific segment of the time period. For details, see “Drilling Down by
Time Segments in Status KPIs Over Time Reports” on page 163.

to display status information about the children that contribute to the
status of the selected CI's KPI. For details, see “Drilling Down to Influencing
Children” on page 164.
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> to display status information about the parents of the CI whose status is
influenced by the status of the selected CI's KPI. For details, see “Drilling Up
to Influenced Parents” on page 165.

Tooltips are shown for each status. The background of the tooltip reflects
the color of the status according to the KPI's objectives.

Details - Performance

Configuration Item: app_world_1 =dit

Status: o],8

Start Time: SF7/05 7:158 AM
End Time: SF7/05 2:14 PM
Duration: 12:15:19

The tooltip displays the following information:

Item Description

Details The name of the KPIL

Configuration Item The name of the CI whose KPI status is displayed.
Status The status of the KPI.

Start Time The time when an event occurred, starting the

sampling period for that event.

End Time The time when a new event occurred, ending the
sampling period of the previous event.

Duration The duration of the sampling period.

This section includes the following topics:

» “Drilling Down by Time Segments in Status KPIs Over Time Reports” on
page 163

» “Drilling Down to Influencing Children” on page 164

» “Drilling Up to Influenced Parents” on page 165
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Drilling Down by Time Segments in Status KPIs Over Time
Reports

Click any time segment in the graph time footer to drill down (zoom) on all
of the CI and KPI information for that period of time. The time segment you
zoom on is split into four equal parts that can also be zoomed until each
time segment is one minute long.

The From date and time of the segment you select becomes the From date
and time of the whole time footer and the To date and time of the segment
you select become the To date and time of the whole time footer.

For example, if the time period you selected is from 7/13/05 6:14 AM till
7/13/05 4.:44 PM, the time footer is split into four equal segments as follows:

Configuration Ttem = KPL Status

bpm_profy Performance I I . ENE N N ] ]
bpm_profs avalabilty I
Dbpm_profs OT Impact e
(Deverareen Performance Y
(Deverreen availabilty -
T Grayray Performance

(Dorayray availabilty I ——

T T T T
7/13/05 8:51 AM 7/13/05 11:29 AM 7/13/05 Z:06 PM 7/13/05 4:44 PM

|I QK O warning O Minar O Major B Critical O Mo Data |

If you drill down on the first segment of the time footer, the From date and
time of that segment is 7/13/05 6:14 AM, and its To date and time is what is
indicated under the second tick of the time footer: 7/13/05 8:51 AM.
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164

The drilled down report time From and To fields display those dates and
times, and the time footer of the report displays this period of time split into
four equal parts: (8:51-6:14)/4=39 mn. The first part starts at 6:14 AM, and
ends 6:14+:39=6:53, the second part starts at 6:53 and ends at 6:53+:39=7:32,
and so forth:

Wiew: From: 7/12/05 &114 AM Tor 7/12/05 2:51 AM Israel Standard Time 4 L3 @
Configuration Itermns: Filtered {3)

KPIs: All

Report type: @ statuses O values |
Configuration Item = KPI

(T bprm_profi Performance _
[Tbprm_profi Availability

(T bprm_profi OT Impact

@EverGreen Performance

[TEversreen Availability

@GrayRay Performance

[Marayray Availability

71305 6:53 AM 7/13/05 7:32 AM FAL3/05 8111 AM 7713405 §:51 AM
|l oK O ‘warning O Minor O Major W Critical O Mo Data ‘
enge . .
Drilling Down to Influencing Children
P Click the Drill to influencing children button for a specific CI’s KPI to display

status information about the children that contribute to the status of the
CI’s KPI.

For example, the view has the following hiearchy.

= ln:c': Monitors Wiew
| ‘:::' app_waotld_1 edit
= {::' app_world_2
(7 tex1_gum
@ trx_General
ol @ trw_sarm
¥ @ trx_weekly_plan

If you drill down the app_world_2 CI and the Performance KPI, the
information that is displayed is the status of all of the Performance KPIs for
all of the children of the app_world_2 CI that have a Performance KPI and of
the parent itself.
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ﬂ If you click the Drill to influencing children button for the app_world_2 CI

and the Performance KPI in the following graph:

Configuration Item = KP1 Status

i.¥ app_world_2
0 trdl_EUM
D tr_general

Perfarmance
Perfarmance

]
| |
Performance 1

T T T T
/572003 /72005 8/9/2003 8/11/z005
2:04 PM 2:04 PM 2:04 AM 2:04 AM

|D (=18 D Warning D Minor D Mazjor D Critical I:‘ Downtirne D Mo Data |

then the drilled down report displays the status of all of the Performance
KPIs for all of the children of the app_world_2 CI that have a Performance
KPI as follows:

Configuration Item = KPI Status

7 trxdl_EUM
7 tr_zeneral
@ trx_sam

O f_epelilly,_ollem

Performance
Performance

Performance

Performance

T T T T
2/5/2005 &/3/2005 &/9/2005 &f11/2005
504 PM Z2:04 PM S04 AM 2:04 AM

L&
o

||:| ok [ warning  [] Minor  [] Majer [ critical [0 Downtime  [] Mo Data |

If the selected CI and KPI do not have influencing children, then the report
displays the message: No influencing children found.

Note: When you drill down to the level of the monitor CI, the report does
not display information because historical data is not collected for monitor
CIs. To obtain similar information about the KPIs of monitor CIS, see “Trend
Report Manager” in Working with Applications.

Drilling Up to Influenced Parents

Click the Drill to influenced parents button for a specific CI’s KPI to display
status information about the parents of the CI whose status is influenced by
the status of the selected CI's KPI. A CI may have more than one parent but
the parent CIs that are displayed in the report are the parent CIs that are
part of the view.
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For example, if you drill up to influenced parents for the trx_weekly_plan CI
and the Availability KPI, the information that is displayed is the status of all
of the Availability KPIs for all of the parent(s) of the trx_weekly_plan CI and
of the influencing child.

=] app_world_2

[ (3 tewa_gum

¥ @ trx_General

¥ @ trw_sarn

=] @ trx_weekly_plan
= bprn_tx_from_location
= bprn_tx_from_location
= trx_weekly_plan from rmetal_kalvin_1
= trx_weekly_plan fram metal_kalvin_2
= trx_weekly_plan from virtual_host 1
= trx_weekly_plan fram virtual_host_ 10

= trx_weekly_plan from virtual_host_2

The report about the status of trx_weekly_plan CI displays information about
the Availability and Performance KPIs as follows:

Configuration Item = KPI Status
1
@trx_weekly_plan Parformance I
. i
s comtblly_llem Availability i

T T T T
/572003 /7 z003 /272003 2/11/2005
2:12 PM 2:12 PM 212 AM 2:12 AM

||:| oK D W arning D Minor D Mazjor D Critical I:‘ Downtirme D Mo Data |

If you drill down to influenced parents for the Availability KPI, the report
displays the status of the Availability KPI for the app_world_2 CI (parent of
trx_weekly_plan CI) as follows:

Configuration Item = KPI Status

o el o
. app_warld_2 Awailability I

T T T T
2/5/2005 /772003 /972003 /1172005
2:12 PM 2:12 PM 8i12 AM 2:12 AM

||:| ok [ warning  [] Minor [ Major [0 critical [0 Downtime  [] Mo Data |

If the selected CI and KPI do not have influenced parents, then the report
displays the message: No influenced parents found.
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The table shows all of the selected Cls and KPIs. When you select CIs and do
not select specific KPIs, all of the KPIs that have been attached to the
selected CIs are displayed.

Configuration Item=

KPI

Start Time

@hpm_prnfl
@bpm_profl
@hpm_prnfl
@bpm_profl
@hpm_prnfl
@bpm_profl
@hpm_prnfl
@EverGreen
@EverGreen
@GrayRay

@GrayRay

Perforrnance
Performance
Perforrnance
Performance
Perforrnance
Availability

OT Impact

Performance
Availability

Performance

Availability

7413705 6:12 AM
7/13/05 7113 AM
7413705 7128 AM
7/13/05 7:43 AM
7413705 B:12 AM
7/12/05 4:47 PM
7/12/05 4:44 PM
7/12/05 4:47 PM
7/12/05 4:47 PM
7/12/05 4:44 PM
7/12/05 4:47 PM

End Time Duration Status
7/13/05 7:13 AM 00:59:35 9 oK
7/13/05 7:28 AM 00:15:15 1 Minar
7/13/05 7:43 AM 00:14:30 wMajor
7/13/05 8:12 AM 00:29:01 1 Minar
7/13/05 8:51 AM 00:38:36 9 oK
7/13/05 8:51 AM 02:37:00 & oK
7/13/05 8:51 AM 02:37:00 9 oK
7/13/05 8:51 AM 02:37:00 & oK
7/13/05 8:51 AM 02:37:00 9 oK
7/13/05 §:51 AM 02:37:00 Uninitialized
7/13/05 8:51 AM 02:37:00 i Critical

The table displays the following information:

Item Description

Configuration Item The class icon and the name of the CIL.

KPI The name of the KPI. The information for each KPI
of each Cl is displayed in a separate line.

Start Time The time when an event occurred, starting the
sampling period for that event.

End Time The time when a new event occurred, ending the
sampling period of the previous event.

Duration The duration of the sampling period.

Status The status of each KPI of each CI during the selected
time period.

The table shows the list of all of the events sorted by CI by default. You can
sort the table by different elements by clicking the relevant column header.
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Note: The number of lines that can be displayed in the table is not limited.
This might slow performance when displaying the table; in such cases it is
recommended to limit the time period or the number of Cls and KPIs you

want to display.

KPIs Over Time Reports with Value Data

168

If you select the View Value over Time option when you generate a KPIs over
Time report, the report displays only the values of the relevant KPIs. Those
KPIs may also have statuses in CMDB but the value report will not show
those statuses.

Reports of this type are relevant for KPIs with business rules that calculate
meaningful values, such as rules for calculating percentage, volume,
financial impact, or Real User Monitor values.

You can select the number of sampling points in the Every boxes.
The report can be displayed as a graph or as a table.

This section includes the following topics:

> “View as Graph” on page 169

> “View as Table” on page 171



View as Graph

Each KPI instance is represented by a separate graph. The legend lists the
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color followed by the name of the CI and a specific KPI. If a CI data is shown

in more than one graph, the CI has the same color in all of the graphs.
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M EverGreen Performance (36)
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Mote: The report will show data only on Configuration Iters that have historical data for the selected value-based KPIs,

If only two KPIs are selected for one CI, the first KPI appears as the left y-axis

and the second KPI as the right y-axis. This is helpful for correlating an

event.

169



Chapter 13 ¢ KPIs Over Time Reports

170

Performance (%)

a0

an
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&0

a0
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30
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If only one KPI is presented in each chart, the KPI objectives are shown as
horizontal colored lines (the colors correspond to the objective colors) as
follows:

Ewerdreen Performance (3]
ol GreenVellow_Stripes Performance (36)

(=14

Warning

Minaor

Major

8305 11:53 PM

405 1:00 A
24505 1:00 AM
B8M05 1:00 AM
8105 1:00 AM
20205 1:00 AM
85905 1:00 AM
8M005 1:00 AM

Note: All values in the graph are averaged by time frame.

Tooltips are available for each point in the graph and display the exact data
for the point.

Value: 83,333

You can drill down each point in the graph to display the data in the period
of time that corresponds to your selection. For example, if you have selected
to display information every day for the past week, then drilling down on
one point displays the detailed information for every hour of the selected
day, and then drilling down on one hour displays the detailed information
for 5 minutes intervals in the hour, and so forth down to a minute interval.
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View as Table

The table shows the list of all filtered ClIs and KPIs. Only existing KPIs
should appear.

Configuration _ 7/11/05 2:55 7712705 1300 7/13/05 1:00  7/14705 100 7/15/05 1:00  7/16/05 L:00
Item PM AM AM AM AM AM
bprn_profl OT Impact ($) - 0.00 0.00 0.00 0.00 0.00
bprn_profl Availability (%) 100,00 83.33 83.33 83.33 83.33 83.33

Perf
bprn_profl STTONMENEE g g 58.74 59.04 59.36 59.69 58.94

(%)

The table displays the selected Cls and KPIs values in the selected time
period.

You can sort the CIs and KPIs by clicking the relevant column header.

Drilling Down to Mercury Diagnostics

If Mercury Diagnostics is enabled, you can drill down to Mercury
Diagnostics views from the KPIs Over Time report for Business Process Step
Cls in the Monitors View and End User Monitors View, and for the
Diagnostics Probe Group, and Diagnostics Probe Cls in the Diagnostics
View.

By default, if Mercury Diagnostics is enabled, the Application KPI is
automatically added to all relevant Cls in the CMDB. The relevant Cls are
the logical CIs. For details, see Mercury Diagnostics User’s Guide.

The following table displays the Diagnostics drill down options for Cls in
KPIs Over Time reports:

Cl Type Diagnostics drilldown options

Diagnostics Probe Group » Summary View (Probe Group Summary)
» Layers View (Load)

Diagnostics Probe » Summary View (Probe Summary)
» Layers View (Load)

Business Process Step » Transactions View

> Layers View
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172

For example, in the Monitors View, click the down arrow to the right of a
Business Process Step CI and select one of the following options:

Configuration Item KPI Status
[=:Add to cart Performance
[JAdd to cart Availability
[=:Add to cart plication
Transactions Wiew ' 6."'3."'2006I 6.-"3.-"2006I

1z:56 PM G156 PM

Layers Wiew

||:| (a4 D Warning D Minor D Major . Critical . Cowntirne D Mo Data |

The Mercury Diagnostics views accessed via the right-click options that are
available from the KPIs Over Time report are as follows:

Summary View. This option is available for all Diagnostics Probe Cls. This
option is displayed only if you have installed Diagnostics.

This option opens the Probe Summary View in the Mercury Diagnostics
application, for the probe group and for the time frame specified in the View
box in the KPIs Over Time report.

For more information about Diagnostics, refer to Mercury Diagnostics User’s
Guide.

Layers View. This option is available for all Business Process Monitor, and
Diagnostics Probe Cls. This option is displayed only if you have installed
Diagnostics.

The Layers (Load) view displays the performance metrics for the Diagnostics
layers where processing has taken place in your application, for the
transaction that corresponds to the Business Process Monitor CI or for the
selected Probe CI and for the time frame specified in the View box in the
KPIs Over Time report.

For more information about Diagnostics, refer to Mercury Diagnostics User’s
Guide.

Transactions View. This option is available for all Business Process Step CI.
This option is displayed only if you have installed Diagnostics.
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The Transactions view displays performance metrics for the transactions
that are being executed by your applications, with the transaction
corresponding to the Business Process Step CI highlighted, and for the time
frame specified in the View box in the KPIs Over Time report. For more
information about Diagnostics, refer to Mercury Diagnostics User’s Guide.

The right-click options that are available from the KPIs Over Time report are

a subset of the Drill to Diagnostics options available in Dashboard. For
details, see “Drill to Diagnostics” on page 12.
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Raw Data Over Time Reports

The Raw Data Over Time Report option in the Dashboard Reports tab
enables you to view raw data over time for selected configuration items,
received in the data samples from Business Process Monitor sources for the
transaction from location ClIs (for Business Process Monitor) or from
SiteScope Monitor, SiteScope Measurement Group, and SiteScope
Measurement Cls (for SiteScope).

This chapter describes: On page:
About Raw Data Over Time Report 175
Accessing the Raw Data Over Time Report 176
Understanding the Raw Data Over Time Report 179

About Raw Data Over Time Report

The Raw Data Over Time report displays raw data over time for selected
configuration items, received in the data samples from Business Process
Monitor sources for the transaction from location CIs (for Business Process
Monitor) or from SiteScope Monitor, SiteScope Measurement Group, and
SiteScope Measurement ClIs (for SiteScope).

The report displays raw data over time in graph or table format.
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You can also:

» add this report to a custom report. For details, see “Custom Report Manager”
in Working with Applications.

» schedule it. For details, see “Scheduling User Reports or the Performance
Update Report” on page 300 in Platform Administration.

Once you have created the report you can:

» change the time frame of the existing report by using the filters. For details,
see “Choosing the Tracking Range and Granularity” in Working with
Applications. The time frame is limited to Past week for performance reasons.
If you wish to use another time frame, you may select Custom; be aware that
selecting this time frame might reduce the report performance.

» change the CIs you want to display. For details, see “Filtering by CI(s)” on
page 143.

» change the raw data measurements you want to display. For details, see
“Filtering by Raw Data Measurements” on page 188.

» use the Advanced Options to change the way the data is presented in the
report. For details, see “Selecting Advanced Options” on page 190.

» sort the table by its columns by clicking on the relevant column header.

» print the report, send it by e-mail, or save it in PDF or Excel format. For
details, see “Sharing and Storing Reports” in Working with Applications.

» customize the report by adding a header and a footer, by selecting to
automatically or manually generate the report, and/or by customizing other
display elements. For details, see “Customizing Reports” in Application
Administration.

Accessing the Raw Data Over Time Report
You can access the Raw Data Over Time report.

To access the Raw Data Over Time report:
1 Select Applications > Dashboard.

2 In the View list, select an appropriate view.
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To display the Raw Data Over Time page, you can:

» right-click the appropriate BPM transaction from location in View
Explorer and select the Raw Data Over Time option

» right-click a specific CI in the right pane of Dashboard and select
Go to Report> Raw Data Over Time

» select the Raw Data Over Time option in the Reports tab

Select the appropriate time frame. For details, see “Choosing the Tracking
Range and Granularity” in Working with Applications.

Due to the large number of measurements that can occur in a specific time
period, which might create performance issues, the maximum length of
time you can select is Past Day, and the maximum custom value you can
specify is: 48 hours.

Select the appropriate filters. For details, see “Filtering by Raw Data
Measurements” on page 188.

If relevant, click Configuration Items to select the relevant ClIs for the report.
For details, see “Filtering by CI(s)” on page 143.

If relevant, click Raw Data Measurements to select the relevant
measurements for the report. For details, see “Filtering by Raw Data
Measurements” on page 188.
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Note:

» Due to performance issues, the maximum raw data value is limited to the
last 1000 for one measurement, and to the last
2000/<nbr-of-measurements> per measurement if you select more than
one measurement. This limitation exists for the table format and for the
graph format of the report.

» If you do not select specific raw data measurements then the default
measurements assigned to the CI (if any) are automatically selected. If
the CI does not have default raw data measurements, then the first
measurement is automatically selected.

» The breakdown raw data measurements are listed only if Enable
breakdowns was selected for the transaction from location in Monitor
Administration. For details, see in “Enable/Disable Transaction
Breakdown for the Transaction Monitor” in End User Management Data
Collector Configuration.

8 If relevant, select Advanced options to modify the report’s appearance.

9 Click Generate to generate the report.
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Understanding the Raw Data Over Time Report

¥alue

» graph format; the graph legend lists the selected raw data measurements.
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The type of information displayed in the report depends on the type of CI
you select. For more details about Business Process Monitor ClIs, see below.
For more details about SiteScope ClIs, see “Raw Data Over Time Reports for a
SiteScope Monitor Source” on page 186.

This section includes the following topics:

“Raw Data Over Time Reports for a Business Process Monitor Source” on
page 180

“Best Practices for Raw Data Over Time Reports for a Business Process
Monitor Source” on page 184

“Raw Data Over Time Reports for a SiteScope Monitor Source” on page 186
“Filtering by Raw Data Measurements” on page 188

“Selecting Advanced Options” on page 190

“Tooltips” on page 190

Raw Data Over Time Reports for a Business Process
Monitor Source

The Raw Data Over Time report displays raw data over time for selected
configuration items, received in the data samples from Business Process
Monitor sources for the transaction from location Cls.

You can work in two different modes by selecting the
Transactions/Locations or the Regular hierarchy for the Business Process
Monitor source. For details, see “Business Process Monitoring” in Source
Manager Administration.

If you select the Transactions/Locations hierarchy, you can select the
transaction from location in the filter. You can then triage the problem by
checking the transaction breakdowns and comparing the results of this
transaction from different locations.

If you select the Regular hierarchy, you can select only the transaction in
the report filter. The report helps you understand at what time the
transaction response time was critical and why it was critical. In the report
table and graph, the data from all of the locations is displayed, sorted by
time, in the same graph or table, without location information.
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Usually, if the Response Time and Availability raw data measurements are
available for the CI, they are automatically selected. The other raw data
measurements that are listed are breakdown raw data measurements for the
Business Process Monitor transaction from location.

The table displays the following information:

Item Description

Time The sampling time.

Transaction Response (Business Process Monitor raw data measurement)
Time (ms)

The transaction response time in milliseconds. This
raw data measurement is selected by default. All
measurements where the transaction was not
available are removed from the report.

Transaction Availability (Business Process Monitor raw data measurement)

The availability of the transaction. For details, see
“About Raw Data Over Time Report” on page 175.
This raw data measurement is selected by default.
Only the unavailable transactions are displayed
(their value is 1).

Client Time (Business Process Monitor raw data measurement)

Displays the average amount of time (in
milliseconds) that passes while a request is delayed
on the client machine. Client-related delays can
include browser think time, CPU think time, HTML
page processing time, time needed to open sockets,
application delays caused by heavy applets, and so
forth.

Note: Client time is calculated by subtracting all
other measured times from the total transaction
time.
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Item

Description

Connection Time

(Business Process Monitor raw data measurement)

Displays the average amount of time (in
milliseconds) needed to establish an initial
connection with the Web server performing the
transaction. The connection measurement is a good
indicator of problems along the network or whether
the server is responsive to requests.

DNS Time

(Business Process Monitor raw data measurement)

Displays the average amount of time (in
milliseconds) needed to resolve the DNS name to an
IP address, using the closest DNS server. The DNS
Lookup measurement is a good indicator of slow
DNS resolution or other problems with the DNS
server.

SSL Handshaking Time

(Business Process Monitor raw data measurement)

Displays the average amount of time (in
milliseconds) taken to establish an SSL connection
(includes the client hello, server hello, client public
key transfer, server certificate transfer, and other—
partially optional—stages). After this point, all of
the communication between the client and server is
encrypted.

The SSL handshaking measurement is only
applicable for HTTPS communications.

Network Time to First
Buffer

(Business Process Monitor raw data measurement)

Displays the average amount of time (in
milliseconds) that passes from the moment the first
HTTP request is sent until receipt of ACK. The
network measurement is a good indicator of
network quality (look at the time/size ratio to
calculate download rate).
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Item

Description

Server Time to First Buffer

(Business Process Monitor raw data measurement)

Displays the average amount of time (in
milliseconds) that passes from the receipt of ACK of
the initial HTTP request (usually GET) until the first
buffer is successfully received back from the Web
server. The server time to first buffer measurement is
a good indicator of Web server delay.

Note: Because server time to first buffer is being
measured from the client, network time may
influence this measurement if there is a change in
network performance from the time the initial
HTTP request is sent until the time the first buffer is
sent.

Time to First Buffer

The sum of Network Time to First Buffer and Server
Time to First Buffer.

Download Time

(Business Process Monitor raw data measurement)

Displays the time that passes from the receipt of the
first buffer until the last byte is received.

Download time is a combination of server and
network time, since the server typically sends data
over multiple connections, and is therefore working
while data is being transmitted over the network.

Retry Time

(Business Process Monitor raw data measurement)

Displays the overall amount of time that passes
from the moment an HTTP request is started until
the moment an HTTP or TCP error message is
returned. Retry time relates only to HTTP or TCP
errors that execute a retry after the error.

All raw data measurements (except for Transaction Response Time and
Transaction Availability) are all weighted breakdowns, as they appear in the
Transaction Breakdown Report, and by default they are not selected. For
details, see “Understanding the Transaction Breakdown Reports” in Using

End User Management.
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Note:

» The BPM either reports Network and Server Time to First Buffer
separately, or reports Time to First Buffer as a whole; hence the Network
Time to First Buffer, Server Time to First Buffer, and Time to First Buffer
never return values on all three.

» The GDE Sample is trans_t for all of the raw data measurements.

Best Practices for Raw Data Over Time Reports for a
Business Process Monitor Source

This section provides tips that will help you use the Raw Data Over Time
Report in the most efficient way. You must first decide whether it is worth
using the Raw Data Over Time report, then configure the data collectors,
and then analyze the report to find where the problem occurs.

To decide if you should use the Raw Data Over Time report:
> Do not use on a daily basis:

» This report should not be used on daily basis. In order to get an overall
picture about the monitored application open End User Management
reports. End User Management report shows the general trend of the
applications performance and availability.

» The Raw Data Over Time report is not efficient when the Business
Process Monitor is configured to report data at low frequency. For
example, if the Business Process Monitor agent reports data every 15
minutes, all of the data can be seen in End User Management reports,
and there is no need to open the Raw Data Over Time report.
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> Use the Raw Data Over Time report when there are
performance/availability problems:

> When the monitored application is actually having performance
and/or availability problems.

» The end users complain about the bad performance, but there is no
indication of any problem in the Business Process Monitor reports in
End User Management.

» There seems to be a problem between transaction scheduled runs. To
detect when exactly the performance problem happens, increase the
frequency to every half minute.

» If the peaks appear during a specific minute, it is very difficult to detect
it in the End User Management reports, which usually display the
average of all of the transactions in the specific time frame. If more
than one transaction appears in the time frame the average result may
hide the peak you are looking for.

> In such a case, to see all of the reported data, open the Raw Data Over
Time report.

To configure the data collectors in the most efficient way:

In Monitoring Administration set Enable Breakdown for the relevant
transactions. For details, see “Adding Transaction Monitors” in End User
Management Data Collector Configuration.

To detect the peaks in application performance increase the frequency of the
Business Process Monitor. The recommended frequency is one minute.

3 Change the frequency in all of the reporting locations.

Select Admin > CMDB, click Source Manager, click the Edit button to the
right of the Business Process Monitoring source adapter, and select
Transaction/Location in the Hierarchy structure list, and click OK.

185



Chapter 14 « Raw Data Over Time Reports

186

To analyze the report when there is a periodic behavior:

Open the Raw Data Over Time report and select the time period where you
expect to find the problems. Since the report displays large amount of data,
it is recommended to select short time periods. A time period of one day
should be enough to find a periodic behavior.

To better see the results, enlarge the report size in the advanced settings.

3 Once you detect a peak, travel with the navigation buttons to a previous day

and to the day before that. Try to find out whether the bad performance
problem appears at the same time each day.

To analyze the report when there is a problematic behavior:

To better understand the reason for the problematic behavior, open the
report for all of the KPIs that available in the KPI filter.

Try to find a correlation between the server/network/performance results.

Raw Data Over Time Reports for a SiteScope Monitor
Source

The Raw Data Over Time report shows data that is reported to Mercury
Business Availability Center from the Business Process Monitor. The main
goal of the report is to enable you to analyze application performance and
availability at crisis’s time. The biggest difference between the Raw Data
Over Time report and the End User Management report is that the Raw Data
Over Time report displays only raw data, which means that all of the data
that was reported to Mercury Business Availability Center will be shown in
the Raw Data Over Time report. No calculations are made over the reported
data.

The Raw Data Over Time report displays raw data over time for selected
configuration items, received in the data samples from SiteScope Monitor,
SiteScope Measurement Group, and SiteScope Measurement Cls.



Chapter 14  Raw Data Over Time Reports

The SiteScope Monitor CI is used by Mercury Business Availability Center
when the SiteScope source adapter is configured not to include
Measurements. The SiteScope Measurement Group CI and the SiteScope
Measurement CI are used when the source adapter is set to include
measurements. For details about the source adapter, see “SiteScope” in Source
Manager Administration.

Different sets of KPIs are displayed in the report depending on the type of CI
you selected. The KPIs available for SiteScope Monitor or SiteScope
Measurement Group ClIs are exactly the measurements that are reported by
SiteScope to Mercury Business Availability Center. The KPIs are named
according to the Measurement names. There are no explicit units for
SiteScope KPIs, but in most cases there are implicit unit indications in the
KPI name (for example, MB Free). The raw data values are all taken from the
ss_t GDE Sample and from the dValue field. For details, see “SiteScope
Measurement Rule” in Application Administration.

The report displays the following information:

If you select a SiteScope Measurement Group CI, the measurements are used
as KPIs. For example, if the SiteScope Measurement Group is cpu on bilbo,
whose measurements are: utilization, utilization cpu #1, and utilization cpu #2,
the Raw Data Over Time Report displays the measurements as KPIs.

Configuration Iterns Filker: cpu on bilbe
Faw Dats Measurernants Filker: All

| ] zmerrs ] w| S

Time = utilization cpu # 2 utilization utilization cpu # 1

12/6/05 1:18 PM 4 2 3
12/&/05 1:38 PM 11 11 11
12/86/05 1:44 PM 23 23 23
12/6/05 1:54 PM 14 13 13
12/6/05 1:58 PM 14 13 13
12/&/05 2:18 PM 17 17 17
12/6/05 2:35 PM 17 16 16
12/6/05 2:58 PM g 7 7
12/6/05 3:18 PM 5 5 4
12/6/05 3:38 PM 14 15 15
12/6/05 3:55 PM iz 20 20
12/6/05 4:18 PM 20 20 20
12/6/05 4:38 PM 12 19 20
12/6/05 4:58 PM 5 5 5
12/6/05 5:18 PM 5 4 3
12/6/05 5:38 PM & 2 2
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> If you select a SiteScope Measurements CI, a single KPI that corresponds
exactly to the measurement is displayed. For example, if the SiteScope
Measurement is utilization, the Raw Data Over Time report displays the
measurement as KPIs

Contiguration Iterns Filker: utilization
Faw Data Measurements Filker: All

| ] t-2sofre | M|

Time = utilization
12/6/05 1:18 PM 3
12/6/05 1:38 PM 11
12/6/05 1:44 PM 23
12/&/05 1:54 PM 1z
12/6/05 1:58 PM 13
1z/6/05 2:18 PM 17
12/&/05 2:38 PM i&
12/&/05 2:58 PM 7
12/6/05 3118 PM =1
1z/6/05 3:38 PM 15
12/&/05 3:58 PM 20
12/6/05 4:18 PM 20
12/6/05 4:38 PM 12

12/6/05 4:58 PM
12/6/05 S:18 FM
12/6/05 5:38 PM
12/6/05 5:558 PM
12/6/05 6:18 PM
12/6/05 6:38 FM

BOROR W R

Filtering by Raw Data Measurements
To filter a report for specific raw data measurements, you must select them.
If a selected CI does not have raw data measurements, the message No

applicable measurements is displayed near the Raw Data Measurements
Filter.

Availability is always 0 or 1 as each point in the report represents one
transaction run that was either successful (1) or failed (0). You can use this
capability to pinpoint exactly when the transaction failed.
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To filter by Raw Data Measurements:

1 Click Raw Data Measurements Filter to open the Raw Data Measurements
Filter dialog box.

|7 Transaction Response Time
¥ Transaction Availability

[ client Tirme

[ Download Time

I_ Server Time to First Buffer
[T Metwork Tirme to First Buffer
[T Tirne ta First Buffar

[ 550 Handshaking Time

I_ Connection Tirme

[ ons Tirme

I_ Retry Timme

| B

(114 | Cancel

2 Select the appropriate Raw Data Measurement(s).

3 Click OK to save the selection.
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Selecting Advanced Options

The advanced options enable you to manipulate the report size and the
report scale.

To select Advanced Options:

Click Advanced Options to open the Advanced Options dialog box.

Graph width

) fute scale graph based on content
O set fixad graph width
Socupy | 1) pages.

Select one of the following:

> Auto scale graph based on content. This causes the graph to auto scale
based on a fixed number of points, depending on the type of view you
selected in the View box.

> Set fixed graph width. The graph is displayed with the width you select
in the Occupy ... pages list. The values are in pages in a range from 1 to 8.
You can display the report pages one after the other by scrolling the
report horizontally.

Select OK to save the changes.

Tooltips

The tooltip displays the raw data measurement, the sampling time, the
sampling value, and its unit.

Transacton Response Time

Time 2/9/05 5:12 AM
Yalue 10002 (=]
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Change Report

This chapter describes how to generate a Change report.

This chapter describes: On page:
Understanding Change Reports 191
Generating a Change Report for a CI 193
Viewing the Change History of a Specific CI 196
Viewing the Change History of CIs Linked by a Container Link 197
Relationship

Performing a Snapshot Comparison 199
Viewing Statistics 200
Determining the Number of Rows Per Table 201

Understanding Change Reports

A Change report displays information about the changes made to the
properties of those Cls that were assigned to keep this information. The
report displays:

» Changes that occurred in a selected CI and all its descendents.

» Information about which CI with a Container link relationship was added to
or removed from a CI.
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» Information about which CI, whose relationship was defined with a

TRACK_LINK_CHANGES qualifier, was added to or removed from a CI. For
information about qualifier conditions, see “Defining Qualifier Conditions”
in View Manager Administration.

A Cl is displayed in the Change report only when the following conditions
occur:

> At least one of the history-sensitive properties of the CI has been
updated.

» The property that was changed had been assigned the Change Monitored
attribute. For details, see “Creating CITs” in CI Type Manager
Administration.

» To view this feature you must enable the Change report. For details, see
“Enabling the Change Report” in Application Administration.

» The Change Report option is disabled in the context menus if the shared
CMDB feature is not installed.

You can also display real-time changes for a CI and its children for a limited
number (twenty by default) of CIs. Changes to these CIs and their children
are indicated by Change icons in Dashboard. For details, see “Viewing Real-
Time Changes to CI Properties” on page 78.

The Change report displays the changes that occurred in a specific time
frame (1440 by default; that is 24 hours) specified in the Changes period
parameter in the Infrastructure Settings. For details, see “Specifying the
Changes Period for the Change Report” in Application Administration.
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Generating a Change Report for a Cl

This section describes how to generate a Change report within a specific
time frame. The Change report displays the changes that occurred within a
defined time frame.

Note: The Change report option is also available for any CI or CI’s
descendents whose history-sensitive properties were modified.

Generating a Change Report

This section describes how to generate a Change report.

A typical Change report is as follows:

=
thange page size: |30 so| [ 5 &
cIchanges
54 4] 150> 5
CcIT . old -
CI label+= CI atbribute New Walue Change Date &Time Changer History
Nanme Value
. " Sun May 28 17:25:52 Discovery:
dancer.mercury, colil\192, 168, 89,31 IP IP DMS Mame dancer.mercury, ca.il Mone DT 2006 SNMP_NET_Dis_Connection
dancer.mercury, co.il Unix Host Name dancer Mone ISEl# 2'10‘303'628 AFERELE Discovery: Host_ID_Discover .ﬁ
. . Host Operating Sun May 28 17:32:19 " . [
dancer.mercury,co.il Unix Sustemn Sunos Mone DT 2006 Discovery: Host_ID_Discover .ﬁ
54 4 150> 5
Relationship changes
54l 5 15 ovs 190
- E t Container' Related"
Container label = t::: Related label change Dates&Time changer ontainers His:ory s
dancer.mercury. colil 0002eA101200 Sun May 28 17:25:52 IDT  Discovery: &l
[Unix) adcedier [interface) 2006 SMMP_MET_Dis_Connection &3]
dancer.mercury, couil Sun May 28 17:25:52 IDT  Discovery: &l
(Unisx] faldzel € A92.E3 B9 H( R 2006 SNMP_NET_Dis_Connection L83
dancer.mercury. co.il ) Sun May 28 17:125:52 IDT  Discouvery: &
(Unisx] feldeel @1 Afwrinen) 2006 SNMP_NET_Dis_Connection
dancer.mercury. co.il Sun May 28 17:125:52 IDT  Discouery: &
(Unisx] faldzel € enmplenmR) 2006 SNMP_NET_Dis_Connection L83
(djr';‘lif]"me"””'c"“"' added ¢TI telnet(telnet) gggsma"' 28 17:320% IDT o ery: Host_ID_Discover =
dancer.mercury, couil Mon May 29 10027144 IDT A &
(Unix) #Added CI HE(HE) 2006 User: admin ir=l
Fo To Wiew Statistics
Go To Visw Snapshots ] Al rsefe 0] ]
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The information in the Change report is divided into two tables:

» Cl changes. Displays information about the changes made to the properties
of ClIs, which were assigned to keep this information.

The following information is displayed in the Cl changes table:

Item Description

Cl Label The label of the path from the root to the CI.

CIT Name The name of the CIT (internal).

Cl Attribute The name of the CI attribute that was updated.

New Value The new value of the CI attribute.

Old Value The previous value of the CI attribute (before the
change).

Change Date & Time The date and time at which the update was
performed.

Changer The name of the user that manually modified the
CI's property, or the name of the Discovery Probe
that automatically discovered a change made to the
CI's property.

History Click the icon to view the change history for the CI.
For details, see “Viewing the Change History of a
Specific CI” on page 196.

> Relationship changes. Contains information about which CI, with a
Container link relationship, was added to or removed from a CI.
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The following information is displayed in the Relationship changes table:

Item Description

Container Label The label of the path from the root to the container
CL

Event type You can have one of the following values:

» Added Cl. A contained CI was added to the
container CI using a Container link relationship.

» Removed Cl. A contained CI that was linked to a
container CI using a Container link was removed.

Related label The label of the path from the root to the contained
CL

Change Date & Time The date and time at which the update was
performed.

Changer The name of the user that manually modified the

CI's property, or the name of the discovery probe
that automatically discovered a change made to the
CI's property.

History Click the icon to view the change history for the CI.
For details, see “Viewing the Change History of a
Specific CI” on page 196 and “Viewing the Change
History of CIs Linked by a Container Link
Relationship” on page 197.

Note: A backslash (\) in a CI name indicates a parent-child relationship with
the format: <parent_CI>\<child_CI>. For example, the entry
dancer.mercury.co.i\192.168.89.31 provides change information for the
192.168.89.31 CI which is the child of the dancer.mercury.co.il CI.

For details about the report’s functionality, see Working with Applications.
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To generate the Change report for a Cl:

1 Right-click a changed CI (as indicated by the icon) and select
Go to Report > Change Report to open the Change Report page.

2 Select the Change Report option to display the Change report for the
selected CI and its children Cls.

Viewing the Change History of a Specific Cl

This section describes how to view the changes in the properties of a specific
CL

Note: To display the Change History report, make sure that popups are not
blocked in your browser.

A typical Change History report is as follows:

3 CI History for 10.168.8.205 - Microsoft Internet Explor: - 10l x|
Jilh=]
CI atbibute New Walue Change Date&Time |Changer
Display Label 10.1£2.8.205 Tue May 232 15:04:31 ICMP_NET_Dis_IpC
IP Address 10,168,8.205 Tue May 23 16:04;31 ICMP_NET_Dis_IpC
IP Dornain Hame DefaultProbe Tue May 23 16:04:31 ICMP_NET_Dis_IpC
IP Metwaork Address  10.168.5.0 Tue May 23 16:04:31 ICMP_NET_Dis_IpC
IP DMS Mame labrnlqc3 2. mercury. cc Tue May 23 16:05:04 Host ID_Discowver
a5 ol 55 a5
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The page displays the following information:

Item Description

Cl Attribute The name of the CI attribute that was updated.

New Value The new value of the CI attribute.

Change Date & Time The date and time when the update was performed.

Changer The name of the user that manually modified the
CI's property, or the name of the discovery probe
that automatically discovered a change made to the
CI’s attribute.

To view the change history of a specific Cl:

) In the Change report, double-click the History icon for the required CI in
the ClI changes table. The History page opens.

For details about the report’s functionality, see Working with Applications.

Viewing the Change History of Cls Linked by a Container
Link Relationship

This section describes how to view the change history of ClIs linked by a
Container link relationship.

Note: To display the Change History report, ensure that popups are not
blocked in your browser.

197



Chapter 15  Change Report

198

A typical Change History report is as follows:

History for dancel Microsoft Internet Exp =10 x|
ik
CI attribute New ¥Walue Change Date&Time |Changer
Added CI 0003BA101500(interf: Sun May 28 17:25:52 SMMP_NET_Dis_Conne
Added €I 192,162,89.21(ip)  Sun May 28 17:25:52 SNMP_NET_Dis_Conne
Added <I 1finterface) Sun May 28 17:25:52 SHMP_NET_Dis_Conne
Added <1 shmplsnmpl Sun May 28 17:25:52 SHMP_NET_Dis_Conne
Dizplay Label dancer.mercury. co.il | Sun May 28 17:25:52 SNMP_NET_Dis_Conne
Hoszt DMS Mame dancer.rercury, co.il  Sun May 28 17:25:52 SMNMP_NET_Dis_Conne
Host SMMP Sys-Mame dancer Sun May 28 17:25:52 SNMP_MNET_Dis_Conne
Host Wendor Sun Microsysterns Sun May 28 17:25:52 SHMMP_MET_Dis_Conne
Added CI telnet(talnat) Sun May 28 17:32:19 Host_ID_Discover
Host Mame dancer Sun May 28 17:32:119 Host ID_Discover
Host Sperating Syster Sun< s Sun May 28 17:32:19 Host_ID_Discover
1111 1141 11411 11411
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The page displays the following information:

Item Description

Cl Attribute The name of the CI attribute that was updated.

New Value The new value of the CI attribute.

Change Date & Time The date and time when the update was performed.

Changer The name of the user that manually modified the
CI's property, or the name of the discovery probe
that automatically discovered a change made to the
CI’s attribute.

For details about the report’s functionality, see Working with Applications.

To view the change history of Cls linked by a Container link relationship:

In the Change report, do the following in the Relationship changes table:

» To view the change history of the container CI, double-click the Container’s
) History icon for the required CI.

» To view the change history of the related CI, double-click the Related’s
s History icon for the required CIL.

The CI History page opens.

Performing a Snapshot Comparison

This section describes how to perform a snapshot comparison if snapshots
for the selected view were saved in Mercury Application Mapping. For
details about snapshots, refer to Mercury Application Mapping
documentation.

To perform a snapshot comparison:

1 At the bottom of the Change Report window, click View Snapshots to open
a separate window in your Web browser displaying the snapshots that were
saved for the selected view.
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Note: The View Snapshots option appears only if snapshots for the selected
view were saved.

Select the two snapshots you want to compare.

3 Click Compare to open a separate window in your Web browser. The

window is divided into two sections. Each side displays a hierarchical tree
structure of all of the CIs in the topology map for that snapshot version.

For details about the Change report, see “Generating a Change Report for a
CI” on page 193.

Viewing Statistics

200

You can view the statistics on the number of Cls that were removed from
and added to the selected view.

To view statistics regarding Cls that were added and removed from the
view:

At the bottom of the Change Report window, click View Statistics to open
the View Statistics window.

/3 http://labm2su o =] |
View Statistics

Remowved CIs=6
Added Relationships=2

Added CIs=3

o d Relat hi 5
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This window displays the following statistics:

Item Description

Removed Cls The number of CIs that were removed from the
view.

Added Relationships The number of relationships that were added to the
view.

Added Cls The number of CIs that were added to the view.

Removed Relationships The number of relationships that were removed
from the view.

For details about the Change report, see “Generating a Change Report for a
CI” on page 193.

Determining the Number of Rows Per Table

The information in a Change report is divided into pages. The number of
pages depends on how many rows appear in each table. You can determine
the maximum number of rows you want to appear in each table (Cl Changes
and Relationship Changes) of the Change report.

To determine the number of rows that appear in a table:

1 In the Change page size box, enter the maximum number of rows you want
to appear in each table of the Change report.

2 Click Set.

3 To view other pages, use the left and right arrows. The number between the
left and right arrows indicate which pages are currently being displayed. For
example, 1 - 2 of 3 means that the 1st and 2nd pages out of 3 are being
displayed.
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Report Repository

The Report Repository option in the Dashboard Reports tab enables you to

view all reports previously saved in Dashboard, Service Level Management,
and End User Management.

This chapter describes: On page:

Report Repository 203

Report Repository

The Report Repository page displays all reports previously saved in
Dashboard, Service Level Management, and End User Management (Triage

report only). For details, see “Report Repository” in Working with
Applications.
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Related Change Requests Report

This chapter describes how you can view change request information from
Change Control Management in Mercury Business Availability Center

Dashboard.
This chapter describes: On page:
About the Related Change Requests Report 205
Viewing the Related Change Requests Report for a CI 206

About the Related Change Requests Report

If you are working with Mercury Change Control Management, then Mercury
Business Availability Center provides an option that enables you to view the
impact of IT changes that have been submitted to the service desk. You view
this information in a Related Change Requests report, opened in Dashboard
for a specific CI.

The Related Change Requests report shows all change requests in the system
that have direct or indirect impact on the selected CI. It is generated by
Change Control Management, and provides a direct link to the original
change request.

You can view the report at any time to check the change requests in the
system for a CI. When a CI is registering a problem, by showing a status
other than OK, you can use the report to determine if the problem is due to
a submitted change, before beginning more extensive research into the
problem.
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In order to enable the integration and view the report in Dashboard, you
must set up the environment, and configure settings in Mercury Business
Availability Center. For details, see “Integrating with Mercury Change
Control Management” in Application Administration.

Viewing the Related Change Requests Report for a CI

206

The Related Change Requests report is opened from the context menu for a
Cl in Dashboard.

Note: You can print the report, send it by e-mail, or save it in PDF or Excel
format. For details, see “Sharing and Storing Reports” in Working with
Applications.

To view a Related Change Request Report for a Cl

In Dashboard, right-click the relevant CI and select Go to Report > Related
Change Requests.

Note: The Related Change Requests option is enabled only if Mercury
Business Availability Center is configured to work with Change Control
Management. For more information, see “Integrating with Mercury Change
Control Management” in Application Administration.
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2 The Related Change Requests report opens, listing all change requests that
impacted on the CI during the default time period. The list may include
change requests that resulted in a direct change to the CI (a CCI), or that
affected the CI as a result of a modification to the change request (an ACI).

&b s

Wiew Im Fram: 5/22/06 11:52 PM To: 5/29/06 11:52 PM Pacific Standard Time ilﬂ

Generate
Actual Start Time = Actual End Time Description Severity Status Contact Level
S/24/06 06:52:17 AM S/24/06 07:52:17 AM Swap SCSI 0:1 to 15K RPM CRITICAL In Progress Release
S/24/06 07 :32:22 PM S/25/06 02:59:22 AM Uparade mermory CRITICAL In Progress Releasze
S5/24/06 10:36:26 PM S/24/06 11:36:26 PM Meed to upgrade mernary for LODAP server CRITICAL In Progress Release
S/24/06 11:28:47 PM Sf25/06 02:29:47 AM Feplace HED at micrwave farm CRITICAL  In Progress Release
S/25/06 02:40:26 PM Sf25/06 03:40:26 PM LOAP Mermory upgrade CRITICAL In Progress Release
S5/25/06 03:15:58 PM S5/25/06 04:15:58 PM Upgrade Mermary CRITICAL In Progress Release
S/25/06 05:14:13 PM Sf25/06 07:14:47 PM Mew Report for Sales Forecasting CRITICAL  Pending Approval Releasze
S5/25/06 11:00:00 PM S5/25/06 11:30:00 PM Tina's test CRITICAL  Pending Approval Sanders, Gabbie Release

For information on the parameters in the report, see “Report Parameters” on

page 207.

3 You can change the time frame for the report by using the filters. For details,
see “Choosing the Tracking Range and Granularity” in Working with

Applications.

Report Parameters

The information displayed in the report is as follows:

Item

Description

Actual Start Time

The time at which execution of the change request
began.

Actual End Time

The time at which execution of the change request
ended.

Description

A linked description of the change request. The link
opens the change request in the service desk system,
where you can see more information on the
requested change. (You may need to enter login
information for the service desk system.)
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Item

Description

Severity

The degree of impact of the change request. The
severity level is defined in Change Control
Management.

Status

The status of the change request in Change Control
Management. You can configure Mercury Business
Availability Center to include additional status
levels used in Change Control Management. For
details, see “Integrating with Mercury Change
Control Management” in Application
Administration.

Contact

The owner of the selected change request.

Level

The level of the change request in the hierarchy in
Change Control Management. Possible values are
Release or Change.
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Real User Monitor Views in Dashboard

This chapter describes the content and structure of the Real User Monitor

views.
This chapter describes: On page:
About Real User Monitor Views 211
KPIs Used for Real User Monitor Cls 213
Real User Applications View 214
Real User End Users View 219
Real User Locations View 222
Real User Servers View 225
All RUM Monitors View 227

About Real User Monitor Views

The Real User Monitor views present real-time performance, availability, and
other data for your network and servers, collected by Real User Monitor by
monitoring real traffic generated by end users. The data enables you to
analyze the business impact of detected performance issues related to end
users, and helps you to identify the cause of delays. From the views, you can
access various Real User Monitor reports, where you can analyze the

collected data to isolate the root cause of detected problems.

For information on Real User Monitor functionality, see “Introducing Real
User Monitor Administration” in Real User Monitor Administration.

211




Chapter 18 ¢ Real User Monitor Views in Dashboard

212

Y Y Y Y Y

The CIs and relationships for the incoming Real User Monitor samples are
created by the Real User Monitor source adapter (described in “Real User
Monitor” in Source Manager Administration). The hierarchical structure for
each Real User Monitor view is determined by the TQL for the view
(described in “Working with Pattern Views” in View Manager Administration).

The views include information about applications, containers, pages, end
users, servers, user sessions, and so forth.

The Real User Monitor views are:

“Real User Applications View” on page 214
“Real User End Users View” on page 219
“Real User Locations View” on page 222
“Real User Servers View” on page 225

“All RUM Monitors View” on page 227

Note: You can also see Real User Monitor applications data in the Monitors
View and the End User Monitors View. For an explanation of the data in
these views, see “Real User Applications View” on page 214.

Tip: If you are not using Real User Monitor in your Mercury Business
Availability Center system, then it is recommended that you deactivate the
Real User Monitor views. For more information, see “Creating and Editing
Views” in View Manager Administration.
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KPIs Used for Real User Monitor Cls
The following KPI are used for the CIs in the Real User Monitor views:

» Performance. Displays information on the average download time of a page
or transaction, or the percentage of sessions with no page performance
problems, for an application monitored by Real User Monitor.

> Availability. Displays information on the average availability of a page,
transaction, or session, for an application monitored by Real User Monitor.

» Volume. Displays information on traffic volume, such as: page hits,
transaction runs, amount of sessions, errors, events.

» Latency. Displays information on the average round-trip time for packets
travelling between the end users and the server monitored by Real User
Monitor.

» Component Availability. Displays information on the percentage of
application pages without server errors for a monitored server.

» Bandwidth. Displays the amount of traffic (in bytes) between the server and
end users accessing the server (for traffic in both directions), including both
HTTP and HTTPS traffic.

For more details about the KPIs, see “Dashboard KPIs Detailed Description”
in Application Administration.
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Real User Applications View
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The Real User Applications view displays data on the pages and transactions
accessed in the applications monitored by Real User Monitor, and data on
errors and events for the applications.

The applications are configured in Monitor Administration. For information
on configuring applications to be monitored, see “Configuring
Applications” in End User Management Data Collector Configuration.

This section includes the following topics:

» “Hierarchy” on page 215
» “CI Types and Their Context Menu Options” on page 216

Note: The hierarchies in the Real User Application view are also displayed in
the Monitoring View and the End User Monitors View.
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Hierarchy

The Real User Applications view generally contains the following
hierarchical structure:

= 1..: Real User Applications
=] JPetStore - Application
ro Application Sessions «gp————— RUM Sessions Monitor
El “.* Business Processes -————— End User Management Application Related Grou

O [ alias-Koi - Business Process Step
k2 alias-Kei moniter ~———————— RUM Page Manitor
@ 07 Index

2 [ index to Signout -4————— Business Process Step

&2 Index ta Signout ronitor -s——— RUM Transaction Monitor
ShoppingCard
Signon
Signon - Shopping Business Process Step
SignonFarm
Signout
urn Errars - RUM Errors Events
ZFailedPages - RUM Application Error Monitor

Bad user reguest

Request not found RUM HTTP Error Monitar

Request refused

BERBD . D000

Server error

F .7 Rum Info Events -¢———— RUM Informational Events

The TQL for the view is built as follows:

Depends On logical_application Depends On
ftored B.V \\
. o Depends On™ *n

i on i 42
Fun_infa_éveriis rum_app_sessleaniarai oy Imi_grmors BUITI_App_group
lh‘bni‘:or\ed By / lru'bnitored By ll:l ends On
Ton e Ton i3
rurmn_info_ewvent_rmaonitor rurn_http_emor_monitor TUIm_app_emor_monitar bp_group Depends On

L
Depends g,iD ends On

lbonitared By bEtep lbonitared By
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Note: The TQL nodes use the internal names for the CITs.

Cl Types and Their Context Menu Options

This section provides a description of each CIT in the Real User Applications
view, and the Real User Monitor-related options that are available for each
CIT.

The Go to Report options are described in “Menu Options for CIs” on
page 79.

CITs
The CITs are:

Application. An Application CI is created for, and with the same name as,
each application configured in Monitor Administration.

Note: The Application CI does not show information on volume, even
though the Volume KP1I is defined for each of the child CIs. Volume does not
propagate up to Application, because it shows volume of different traffic
types for each of the child groups, and these cannot be logically
amalgamated.

Business Process Group. Business Process Group Cls are created
automatically with a default name by Mercury Business Availability Center.

Business Process Step. Business Process Step Cls are added automatically by
Mercury Business Availability Center using the names of the pages and
transactions configured for the application in Monitor Administration.

End User Management Application Related Group. An End User
Management Application Related Group Cl is automatically created for each
application configured in Monitor Administration, using a default name
from Mercury Business Availability Center.
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> RUM Application Error Monitor. A RUM Application Error Monitor CI is
automatically created for, and with the same name as, each error event
configured for the application in Monitor Administration.

» RUM Errors Events. A RUM Error Event CI is created with a default name by
Mercury Business Availability Center for each application configured in
Monitor Administration which has error events defined.

» RUM HTTP Errors Monitor. A RUM HTTP Error Monitor CI is automatically
created for, and with the same name as, each HTTP error event configured
for the Real User Monitor engine in Monitor Administration. When a new
Real User Monitor engine is created in Monitor Administration, four default
HTTP error events are automatically created for the engine (bad user request,
request not found, request refused, and server error), and the corresponding
RUM HTTP Error Monitor Cls are added to the Application branch in the
views.

> RUM Informational Event Monitor. A RUM Informational Event Monitor CI
is automatically created for, and with the same name as, each informational
error event configured for the application in Monitor Administration.

» Rum Informational Events. A RUM Informational Event CI is created with a
default name by Mercury Business Availability Center for each application
configured in Monitor Administration which has informational error events
defined.

> RUM Page Monitor. A RUM Page Monitor CI is automatically created for
each page that is configured for the application in Monitor Administration.
The name of the CI comprises the page name and the word monitor (for
example, p1 monitor).

» RUM Session Monitor. RUM Session Monitor CIs are created with a default
name by Mercury Business Availability Center.

» RUM Transaction Monitor. A RUM Transaction Monitor CI is automatically
created for each transaction that is configured for the application in
Monitor Administration. The name of the CI comprises the transaction
name and the word monitor (for example, transaction1 monitor).

217



Chapter 18 ¢ Real User Monitor Views in Dashboard

218

Menu Options

Different menu options are available depending on the type of Cls:

Go to Report Menu Option

Type of CI

Session Analyzer
Event Count Over Time

Event Summary

Application

Event Count Over Time

Business Process Group

Event Count Over Time

Business Process Step

Event Count Over Time

End User Management Application
Related Group

Event Count Over Time

RUM Application Error Monitor

Event Summary

RUM Error Event

Event Count Over Time

RUM HTTP Error Monitor

Event Summary

RUM Informational Event Monitor

Event Summary

RUM Informational Event

Session Analyzer
Event Count Over Time

Event Summary

RUM Session Monitor

Event Count Over Time

RUM Transaction Monitor
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Real User End Users View

The Real User End Users view displays data for the end-user groups that are
configured for Real User Monitor in Monitor Administration. The data
includes information for each end-user group on the availability,
performance, and volume of sessions that were accessed by end users.

If IP addresses that have not been configured in end-user groups in Monitor
Administration are received in Real User Monitor samples, then a hidden
Dynamic Node Factory creates a separate branch for them in the view, under
a RUM End User Group CI called Unconfigured.

For information on configuring end-user groups to be monitored, see
“Configuring End-User Groups” in End User Management Data Collector
Configuration.

This section includes the following topics:

> “Hierarchy” on page 220
> “CI Types and Their Context Menu Options” on page 221
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Hierarchy

The Real User End Users view generally contains the following hierarchical
structure:

=] 1a Real User End Users
= i.* Rum End Users - RUM End User Groups
g % Mercury Israel [192,168.80.0-192, 168,89, 255 — — RUM End User Group
ro Mercury Israel [192,162,80,0-192,168,89,255] -————— RUM End User Group monitor
k=S Mercury USA [200,0,1,0-200,0,1,255] - RUM End User Group
=] w Unconfigured [MAA-N/A] - RUM End User Group
=) PRIVATE IP ADDRESS LAN [10.168.8.0-10.168.5,255] <+—— RUM End User Group monitor

The TQL for the view is built as follows:

rum_end_user_groups

Depeids Cn

Depends On Depends On

rum_end_user_group_container
Depends On Lb Depends On
epends On

rum_end_user_group RLIM End User Group

Monitored By

Monitored By

H
N--

»
RUM End User Group Maonitor

Note: The TQL nodes use the internal names for the CITs.
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Cl Types and Their Context Menu Options

This section provides a description of each CIT in the Real User End Users
view, and of the Real User Monitor-related options that are available for
each CIT.

The Go to report options are described in “Menu Options for CIs” on
page 79.

CITs
The CITs are:

RUM End User Groups. RUM End User Groups Cls are created automatically
by Mercury Business Availability Center using a default name.

RUM End User Group. A RUM End User Group CI is created automatically
for each end-user group configured in Monitor Administration. The name
comprises the configured end-user group name, together with the IP range
of the end-user group.

RUM End User Group Monitor. A RUM End User Group Monitor CI is
automatically created for each end-user group configured in Monitor
Administration that has been received in Real User Monitor samples. The
name comprises the end-user group name together with the IP range of the
end-user group.

In addition, a RUM End User Group Monitor CI called Private IP Address
Lan (with an IP range) is created for IP addresses received in Real User
Monitor samples, but not included in end-user groups configured in
Monitor Administration.

Menu Options

Different menu options are available depending on the type of Cls:

Go to Report Menu Option Type of CI

End User Summary RUM End User Groups

End User Summary RUM End User Group

End User Summary RUM End User Group Monitor
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Real User Locations View

222

The Real User Locations view displays data for end-user groups, organized by
location. The locations displayed are those configured in Monitor
Administration. The data includes information on the availability,
performance, and volume of sessions that were accessed by end users.

If IP addresses that have not been configured in end-user groups in Monitor
Administration are received in Real User Monitor samples, then a hidden
Dynamic Node Factory creates a separate branch for them in the view, under
a RUM Location Container CI called Unknown.

For information on configuring end-user groups to be monitored, see
“Configuring End-User Groups” in End User Management Data Collector
Configuration.

This section includes the following topics:

» “Hierarchy” on page 223
> “CI Types and Their Context Menu Options” on page 224
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Hierarchy

The Real User Locations view contains the following hierarchical structure:

= 1..':': Real User Locations
=] @ Rurn Locations -g——————— RUM Location Container
= @ France - RUM Location Container
= ISP [193.168.76.0-193. 1-— RUM End User Group Manitor

The TQL for the view is built as follows:

i

Locations root

l Depends On

i

Countries

Depends COn

i

States

Monitored By
Depends On

ﬁ J onitored By
Cities

Monitored By 7

EUM Monitar

Note: The TQL nodes use the internal names for the CITs.
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Cl Types and Their Context Menu Options

This section provides a description of each CIT in the Real User Locations
view, and of the Real User Monitor-related options that are available for
each CIT.

The Go to Report options are described in “Menu Options for CIs” on
page 79.

CITs
The CITs are:

RUM Location Container. A RUM Location Container CI is created for each
location defined in Monitor Administration (for end-user groups), when
data is received for that location in the Real User Monitor samples. A RUM
Location Container CI called Unknown is created for samples without a
configured location.

RUM End User Group Monitor. RUM End User Group Monitor Cls are
created for each end-user group for which an IP address has been received in
the Real User Monitor samples. The name comprises the configured end-
user group name together with the IP range of the end-user group.

In addition, a RUM End User Group Monitor CI called Private IP Address
Lan (with an IP range) is created for IP addresses received in Real User
Monitor samples, but not included in end-user groups configured in
Monitor Administration.

Menu Options

Different menu options are available depending on the type of Cls:

Go to Report Menu Option Type of CI
Triage RUM Location Container
Triage RUM End User Group Monitor
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Real User Servers View

The Real User Servers view displays information on bandwidth usage and
server errors for the servers monitored by Real User Monitor.

For information on configuring servers to be monitored, see “Defining a
Server Name” in End User Management Data Collector Configuration.

This section includes the following topics:

> “Hierarchy” on page 225
» “CI Types and Their Context Menu Options” on page 226

Hierarchy

The Real User Servers view contains the following hierarchical structure:

= 1..':': Real User Servers
=] = Rurn Servers -+—— RUM Servers
= [ 1920001 4-—— Host
22 192.0,0.1-———-——— RUM Server monitor

The TQL for the view is built as follows:

pit

rum_:sewers
iDepends On
8
Host
iMnnitDred By
£

rum_server_maonitar

Note: The TQL nodes use the internal names for the CITs.
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Cl Types and Their Context Menu Options

This section provides a description of each CIT in the Real User Servers view,
and of the Real User Monitor-related options that are available for each CIT.

The Go to Report options are described in “Menu Options for CIs” on
page 79.

CITs
The CITs are:

RUM Servers. The RUM Servers CI is automatically created with a default
name by Mercury Business Availability Center.

Host. A Host CI is automatically created for each host (server) for which
information has been received in the Real User Monitor samples. If a name
has been defined for the server in Monitor Administration, the CI uses the
that name. Otherwise, the CI name will generally be the IP address of the
host.RUM Server monitor. A RUM Server Monitor CI is automatically
created under each Host CI, using the same name.

Menu Options

Different menu options are available depending on the type of Cls:

Go to Report Menu Option Type of CI

Server Summary RUM Servers

Server Summary Host

Server Summary RUM Server Monitor
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All RUM Monitors View

Y VY VY Y

The All RUM Monitors view includes all of the hierarchies from other views
for Real User Monitor views. For details on these hierarchies, see the
following sections:

“Real User Applications View” on page 214
“Real User End Users View” on page 219
“Real User Locations View” on page 222

“Real User Servers View” on page 225
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Using the SAP Solution

The SAP solution of Mercury Business Availability Center enables you to
view and control your mission-critical SAP systems and applications.

This chapter describes: On page:
About Using the SAP Solution 232
SAP Solution Architecture 233
Collecting SAP System Information 234
Viewing SAP Information in Dashboard 235
Menu Options 240
Showing Impact for SAP CIs 241
Isolating a Problem for SAP ClIs 242
Viewing Changes Made to SAP System ClIs 243
Show Content 248
CCMS Counters 250
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About Using the SAP Solution

232

The SAP solution of Mercury Business Availability Center, integrating
SiteScope, Business Process Monitor, and Mercury Application Mapping (if
you are using Shared CMDB) enables you to gain visibility and control over
your mission-critical SAP systems and applications.

The SAP solution provides:

» asingle operation console consolidating all SAP monitoring information

» automatic discovery and modeling of SAP-related elements, as well as their

relations to other systems in the organization’s IT

» change discovery and notification, for quicker problem resolution

» display of transport deployment impact, for move-to-production risk

analysis

» proactive monitoring of end-user experience in SAP systems

> a bridge between IT and line-of-business people using the SAP Solution

Manager business processes’ hierarchy monitoring

> the ability to distinguish between SAP-specific problems and general ones
» examination, over time, of SAP CCMS monitoring data

» Service Level Management of SAP systems’ service level commitments

Note: You must have a SAP license to view the SAP_Systems view in Mercury
Business Availability Center.
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SAP Solution Architecture

The architecture of Mercury Business Availability Center SAP solution is
illustrated in the following diagram:

SAP System S

B Jco
- = In
Mercury

= " SiteScope
. =] F o
Discovery = Pid ey
Probe - &
R’F{: Vi

-~ JCo

CCMS. — — —
-
=~

Mercury ~ aou
- = source
Business D“/ adagter
Process
Monitor
Mercury
Application (=
Mapping
Server

Help desk/basis team /

Most of the SAP Cls are created by automatic discovery. The configuration
for those ClIs is saved into the CMDB. Some of the relationships to Business
Process Monitor and SiteScope ClIs are created by automatic mechanisms
unique to the SAP solution.

The architecture of the SAP solution includes the following components:

» The Discovery Probe discovers SAP-related entities and the general entities
(such as hosts) that are related to them using CCMS. The Discovery Probe
communicates with the shared CMDB using a Remote Function Call (RFC)
via a Java Connector (JCO).

» Mercury SiteScope SAP CCMS Solution Set communicates with the SAP
system and retrieves CCMS monitoring data using a Remote Function Call
(RFC) via a Java Connector (JCO).

233



Chapter 19 » Using the SAP Solution

» Mercury Business Process Monitor collects data on the performance and

availability of Business Process Monitor transactions carried out on the SAP
system.

» Mercury Application Mapping Server collects change information from the

Shared CMDB and stores it in the History database (only when you selected
to work with Shared CMDB).

» Mercury Business Availability Center is used as the central console for

viewing all of the data and performing analysis actions.

Collecting SAP System Information

234

The Automatic Discovery component discovers the actual SAP IT entities
and stores them as Cls in the CMDB.

All configuration actions of SAP ClIs are performed inside the CMDB
Administration application. All SAP Cls appear in the SAP Systems view
under a root CI called SAP Systems.

All SAP system metrics are monitored by SiteScope monitors.

SAP business processes/transactions are simulated using Business Process
Monitor pre-recorded VUGen scripts. Each script includes one or more
Business Process Steps and are executed from a specific location. All Business
Process Monitor-related Cls are stored in the CMDB as non-SAP-related Cls
with links to the appropriate SAP-related Cls.

Information about the SAP System is available in Dashboard in all of the
relevant tabs like other information.

The SAP Systems views includes information from the SAP IT entities, SAP
system metrics monitored by SiteScope monitors, and information about
the SAP business processes/transactions simulated by Business Process
Monitor scripts.
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Viewing SAP Information in Dashboard

You can view SAP information in the SAP Systems view in Dashboard. For
details about how to work with the Console tab, see Chapter 5, “Dashboard
Console.”

The SAP Systems view in View Explorer is as follows:

Wigw: |SP.P Systems J

1.
= ..: SAP Systerms
B [ mie
Application Component:

=]

< Business Processes

% Clients

*

%% Hosts

=]

“¢ Locations

*

D5 osAp Configuration

=]

Transports

*
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The following graph describes the various layers and drill-downs available in
the topology of the SAP Systems view.

SAP Applicati
l—b COmnglf:rerII;n - EE N Manitar
Application o | SAP Application SAP EP o .
Componenis Companents *( rransactions [ Steps o BPM Monitor
| g | Locations | Location g BRI Monitar
Business - Business - ;
™| Procass Group | ™| Process Steps ) B Monitar
| | Transports = Transport Lagand
ot | [ Sowee
Components Camponent
-l e SAP - - _-m
SAP System e Canfig File Drit
Support Support Sarne
| Packages Package = el Ik
- Host Application
Web
i1 Host
Gateway
. Wiork
- Hasts - Procazs | CCME
Hi= Host R
| CCMS
M= Host Dalabase
\—' CCMS
. Host
SiteSoope
Manitor
. Clients - Client ‘ »| coms

This section includes the following topics:

> “Cls” on page 237
» “KPIs” on page 240
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Cis

The ClIs are as follows:

SAP System. SAP System is a logical unit, grouping together SAP-related ClIs
(and possibly other CIs as well) into one homogeneous SAP deployment.

SAP Applications. SAP Applications is a logical unit, grouping together
Application Components.

SAP Application Component. A SAP Application Components may include
other SAP Application Components and some SAP transactions with some
common denominator.

SAP Transaction. A SAP Transaction CI is part of a business process defined
in the SAP System. It is comprised of request-response couples called dialog
steps. The end user uses SAP transactions to carry out actions on the SAP
System.

Business Process Step. Business Process Steps (BPM transactions inside a
script) are emulated SAP transactions executed on a Business Process
Monitor machine. They are used to supply proactive monitoring of end user
experience.

BPM Monitor. The BPM Monitor Cls represent Business Process Monitor
entities used to monitor user experience.

Solution Manager Projects. The Solution Manager Projects CI type includes
SAP Business Project Cls, SAP Scenario Cls, SAP Business Process Cls, and
SAP Business Process Step Cls. The Solution Manager Projects hierarchy is
specified by the user in SAP Solution Manager.

Locations. The Contained Group Locations is a logical unit, grouping
together Contained Locations Cls.

Contained Locations. Location ClIs are created as part of the Business Process
Monitor hierarchy when working with the Transactions/locations option.

To separate the SAP Business Process steps locations status from the Location
CI (from the Business Process Monitor), the Contained Locations Cls are
created by the SAP solution and are connected to the SAP Business Process
steps (identified by following the naming convention or by manually
linking them).
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The regular Location CI is connected to all Business Process steps both
regular and SAP, but the Contained Location ClI is connected only to the SAP
Business Process steps.

The Locations information represents the locations specified in BPM Profile
> BP Step > BPM transaction from location in Platform Administration.

Business Processes. The Contained Group called Business Processes is a
logical container that contains all of the Business Process steps attached to
all of the SAP transactions.

Transports. A Transport represents packaged change requests that include
the changes that are to be deployed onto the system.

Client. A client is an organizational and legal CI in the SAP system. The
main objective of the client is to keep the data isolated: the data in a client
can only be visible within that client; it cannot be displayed or changed
from another client. Each client on a system can represent a unique working
environment.

Hosts. Hosts is a logical unit, grouping together Host Cls.

A Host CI represents the physical machine on which a server is installed.
This is not a SAP-specific element.

Application Gateway. An Internet Transaction Server (ITS) component.
Establishes the connection to the R/3 System and performs the processing of
tasks that are required to move data between R/3 applications and the
Internet.

Web Gateway. An ITS component. A web server extension that establishes
the connection between ITS and the Web server and forwards user requests
to the Application Gateway.

R/3 Application Server. SAP R/3 Application Server is SAP’s integrated
software solution for client/server and distributed open systems.

R/3 Application servers and databases are displayed under Hosts. You can
also have several levels of hosts under the Hosts CI, SiteScope Monitor Cls,
and CCMS Monitor Cls.

Work Processes. Each work process CI is a logical, single-instance
representation of all of the work processes of the same type existing on the
R/3 server.
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Several types of work processes are available:
» Dialog Work Process. Executes dialog programs (ABAP).

» Update Work Process. Responsible for asynchronous database changes
(controlled by a COMMIT WORK statement in a dialog work process).

» Update2 Work Process. Used for statistical, non-critical updates (for
example, result calculations).

> Background Work Process. Executes time-dependent or event-controlled
background jobs.

» Enqueue Work Process. Executes locking operations (if SAP transactions
have to synchronize themselves).

» Spool Work Process. Performs print formatting (to printer, file, or
database).

Database. A database management system holding the data tier, including
all of the SAP elements: SAP transactions, programs, work processes, and so
forth. This is not a SAP-specific CI.

Software Component. A software component installed on the SAP System,
for example: SAP_ABA (cross-application component), SAP_HR (human
resources), and so forth.

Support Package. A Support Package contains quality improvements for the
SAP system, or adjustments due to legal changes.

Configuration File. Configuration files are used to enter configuration
parameters into the system/servers.

CCMS Counters. CCMS Counters (also called Measurements) are pieces of
information elements, relevant to SAPD, retrieved from SAP CCMS (Computer
Center Management System).

Monitor. The monitors are SiteScope entities used to monitor the various CIs
that exist in the CMDB. The monitors that are most likely to appear in the
SAP view are host monitors: CPU, memory, disk space, and so forth. These
monitors appear in the SAP view only if they are manually attached to the
Host CI.
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KPis

Different Key Performance Indicators (KPIs) are displayed depending on the
selected CI. For details about the displayed KPIs, see “Cls Created by the
Discovery Process” in Discovery Manager Administration.

The SAP-related KPIs displayed in the Console tab are as follows:

SAP. The SAP KPI indicates problems related to the SAP infrastructure that
are reported by CCMS.

Transactions. At the group level, displays the worst status of all of the child
Cls.

At the monitor level, displays the worst status of the Performance and
Availability KPIs for the CI.

Locations. At the group level, displays the worst status of all of the child Cls.

At the monitor level, displays the worst status of the Performance and
Availability KPIs for the CI.

The other KPIs displayed in the views are not SAP-related. For more details
about those KPIs, see “Dashboard KPIs Detailed Description” in Application
Administration.

Menu Options

240

A list of all of the context menu options available in the SAP Systems view is
available in Chapter 2, “About Menu Options for CIs”.

Different menu options are available depending on the type of Cls:

Context Menu Option Type of Ci

Show Impact All SAP-specific CI types

Problem Isolation All SAP-specific CI types

SAP Transport Changes Report SAP System and SAP Transports Cls
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Context Menu Option Type of CI

SAP Transaction Changes Report SAP System and SAP Transaction Cls

Show Content Configuration Files, Software
Components, and Support Package Cls

Showing Impact for SAP Cls

The Show Impact option enables you to select a CI, which is defined by a
correlation rule as a root cause CI, and to display all of the CIs that are
affected by it in a separate dialog box.

For example, a transport affects specific transactions. Using Show Impact
you can see the impact of Transport Cls on Transaction Cls and the impact
of Transaction CIs on Transport Cls.

For example, when this procedure is performed on a transport, the dialog
box displays all of the elements that have been impacted by the transport:

| =2 |IHierarchicaI Layouk vI i] = = | e, |’§|E§’E| { Q i; = "‘”} j:A *ﬁ* \ | x
MIIGIZ(QUUNU

SAP_Transport_Transaction[2]
IMTRANS
| SAP_Transport_Transaction[2]

inspection systen Label: inspection system for testint monitorin

Configuration Item Type: SAP Application Component

Category Status Correlation Is new

change E Mew Ed Mew
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To show the impact of a root cause object:

1 In Mercury Business Availability Center, click Applications > Dashboard >

Console and in the View list, select SAP Systems.

2 Click the gray arrow to the right of the element. A menu opens. Select

Application Mapping > Show Impact.

Isolating a Problem for SAP Cls

242

You can isolate a CI’s problem in a separate browser dialog box. The Problem
Isolation option enables you to retrieve root cause information for CIs that
are affected by a chain of correlation rules. The output of problem isolation
displays a logical map that describes a chain of trigger/affected CITs that
affect the CI.

For example, when the Problem Isolation procedure is performed on a
transaction, the dialog box displays the transports that have impacted the
transaction.

| 5 3 |IHierarchicaI Layout 'I ﬂ | | i3 [EEE_&_E

AR PG E N
MIBKa00370

SAP_Transport_Transaction[2]

ZMTRANS

To isolate a problem:

Select Applications > Dashboard > Console and in the View list, select SAP
Systems.

Click the gray arrow to the right of the element. A menu opens. Select
Application Mapping > Problem Isolation.



Chapter 19 ¢ Using the SAP Solution

Viewing Changes Made to SAP System Cls

Changes made to the properties of all types of Cls are discovered by
different types of discoveries. For details, see “Performing a SAP Discovery”
in Application Administration. Those changes are displayed in the Change
report available as a right-click menu option for each one of the relevant CI
types. For details about the Change report, see “Change Report” on

page 191.

Some of the changes made to the SAP Transactions Cls are caused by the
corresponding Transport Cls. Those specific changes are processed by
correlation rules in discovery and are displayed in the SAP Transaction
Changes report and the SAP Transport Changes report.

This section includes the following topics:

> “SAP Transaction Changes Report” on page 244
> “SAP Transport Changes Report” on page 246
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SAP Transaction Changes Report

You can display a SAP Transaction Changes report to track changes made to
a SAP Transaction CI when a transport was discovered. The SAP Transaction
Change report displays those changes.

To access the SAP Transaction Changes report:

Right-click a SAP System CI or a SAP Transaction CI in the View Explorer
and select Application Mapping > SAP Transaction Changes report or click
the gray arrow corresponding to a SAP System CI or a SAP Transaction CI in
the Console tab, and select Application Mapping > SAP Transaction Changes
report to display the SAP Transaction Changes report.

Marne

Marne

Mame

Mame

HEJE
=l MIG{SAP System)
MI&
= ZMTRANS1{SAP Transaction)
ZMTRANSL Devclass ZINSPECTION_FOR_MAM Prograrm ZMPROGL
Prograrm Version Screen 0100
= CIT Name = SAP Transport
Tie Name Description Creation Date User Target System
MIEK200518 [(SAP Transport] MIEK900518 2006.02.21 14:15:05:00 Sigalit Sade TRM
MIGKI003F0 [SAP Transport) MIGK200370 2006,01.17 11:20:49%;:00 Sigalit Sade
MISK 900516 [SAP Transport) MIEKS00516 2006&,02.20 15:54:11:00 ofer Mekmal TR.M
MISKI00508 (SAP Transport] MIEKS00502 2006,02.20 14:53:25:00 Sigalit Sade TR.HM
MIEK200416 [SAP Transport] MIEKS00416 2006.01.26 10006:18:00 Sigalit Sade
MIGKI00432 [SAP Transport) MIGKI00432 2006,01.26 11:22:40:00 Sigalit Sade
MISK 900422 [SAP Transport) MIsKS00422 2006,01.26 11:09:22:00 Sigalit Sade
MISKI00442 [SAP Transport] MISKS00442 2006,01.26 12:20:52:00 Sigalit Sade
= ZMTRAMNSZ{SAP Transaction)
ZMTRAMNSZ Devclass ZIMSPECTIOM_FOR_MAM Prograrm ZMPROGZ_3
Prograrm Version Screen o100
=l CIT Name = SAP Transport
Tite Name DescHdption Creation Date User Target System
MIGK200418 [(SAP Transport) MIGK200418 2005,01,26 10:09;11;00 Sigalit Sade
MIEK 900434 [SAP Transport) MIsKS004324 2006,01.26 11:29:58:00 Sigalit Sade
MIEKI00516 (SAP Transport] MIGK300516 2006,02.20 15:54:11:00 Ofer Mekrmal TRH
MIEKI00373 [(SAP Transport] MIEKI003Z73 2006,01.17 11:32:02:00 Sigalit Sade
MIGKI00424 [SAP Transport) MIGKI00424 2006,01.26 11:11:1%:;00 Sigalit Sade
MISK 900520 [SAP Transport) MIEKS00520 2006,02.21 14:37:58:00 Sigalit Sade TR.HM
El ZMTRAMS3(SAP Transaction)
ZMTRANSZ Devclass ZIMSPECTIOM_FOR _MAM Prograrm ZMPROGZ_2
Program Yersion Screen 0100
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The table displays information about the SAP systems with changed
transactions, and under each transaction the SAP transports that have
changed during the past week (you can modify the default):

» The SAP System level:

» Name. The name of the SAP system with a new transaction.

» The SAP Transaction level:
» Name. The name of the SAP transaction that has changed.
» Devclass. The development class that includes the transaction.
» Program. The name of the program that runs the transaction.
> Program Version. The version of the program that runs the transaction.
>

Screen. The first screen that opens when you load the transaction.

» The SAP Transport level:
» Name. The name of the transport that has changed.

Description. A description of the transport.

>

» User. The name of the user who created the transport.

» Creation Date. The date when the transport was created.
>

Target System. The target system for non-local transports.
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SAP Transport Changes Report

You can display a SAP Transport Changes report that includes the transports
discovered in the past week, the changes that are included in each transport,
and under each change the SAP transaction that is impacted by this change.

To access the SAP Transport Changes report:

Right-click a SAP System CI or a SAP Transport CI in the View Explorer,
select Application Mapping > SAP Transport Changes report or the gray

v arrow corresponding to a SAP System CI or a SAP Transport CI in the
Console tab, and select Application Mapping > SAP Transport Changes
report to display the SAP Transport Changes report.

HEJE
=l MIG{SAP System)
Marne MI&
= MI6GK900424(SAP Transport)
Marne MISKS00424 Cescription Table called by Include  User Sigalit Sade
& Program-
ZMTRANSZ_3
Creation Date 2006,01,26 11:11:1%:00 Target Systemn
=l Table:ZMTAB_BY_INCLZ_3{SAP Transport Change)
Chject Hame ZMTAB_BY_IMCLZ_3 Object Type Table
[El CIT Mame = SAP Transaction
Tie Name Devclass Program Program Wersion Screen
ZMTRANS3 (SAP Transaction) ZMTRANS3 ZINSPECTION_FOR._MAM ZMPROGZ_3 o100
ZMTRANS2 (SAP Transaction) ZMTRANSZ ZINSPECTION_FOR_MAM ZMPROGZ_3 Q100
=l Table:ZMTAB_BY_PROGZ_3{SAP Transport Change)
Object Harme ZMTAB_BY_PROGZ_3 Ohbject Type Table
El CIT Name = SAP Transaction
Titde Name Devclass Program Program Wersion Screen
ZMTRANSZ (SAP Transaction) ZMTRANSZ ZINSPECTION_FOR_MAM ZMPROG2_3 0100
ZMTRANS3 (SAP Transaction) ZMTRANSZ ZIMSPECTION_FOR._MAM ZMPROGZ_2 o100
[ MI6GK900516(SAP Transport)
Marne MIEK 900516 Deascription transporting inspection  Uzer Ofer Mekrmal
of MAM
Craation Date 2006,02,20 15:54:11:00 Target Syztem TRN
=l Transaction:ZMTRANSZ{SAP Transport Change}
Object Name ZMTRANSZ Chjedt Type Transaction
El CIT Mame = SAP Transaction
Tie MName Devclass Program Program Wersion Screen
ZMTRANS2 (SAP Transaction) ZMTRANSZ ZIMSPECTION_FOR._MAM ZMPROGZ_2 o100
-
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The table displays information about the SAP systems with the transports
discovered during the past week (this default is configurable), under each
transport the changes that are included in the transport, and under each
change the SAP transaction that is impacted by this change:

The SAP System level:

> Name. The name of the SAP system.

The SAP Transport level:

» Name. The name of the transport that has changed.
» Description. A description of the transport.

» User. The name of the user who created the transport.

» Creation Date. The date when the transport was created.

» Target System. The target system for non-local transports.

The SAP Transport Change level:

> Object Name. The change that has been made.

Object Type. The object that changed.

Title. The name of the transaction followed by (SAP Transaction).
Name. The real name of the transaction.

Devclass. The development class that includes the transaction.
Program. The name of the program that runs the transaction.

Program Version. The version of the program that runs the transaction.

Y Y Y Y Y Y Y

Screen. The first screen that opens when you load the transaction.

Note: Transports that are older than a month are automatically deleted from
the CMDB. The default is configurable.
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Show Content

The Show Content option displays a configuration file details, the software
components file, or the support packages file of the SAP system discovered
by the automatic discovery process.

This section includes the following topics:

» “Configuration File Details” on page 248
> “Software Components File” on page 249

» “Support Packages File” on page 250

Configuration File Details

Right-click a Configuration File CI and select the Show Content option to
display the corresponding configuration file. For example:

~MI6_DWEEMES00_CALDEROME (read-only)

#parameter created be: DNISSANT  17.12,2002 20:36:03
loging'system_client = 500
SAPSYSTEMMAME = MI&
INSTANCE_MAME = DYEBMGSO0
SAPSYSTEM = 00
SAPGLOBALHOST = calderane
rdispfwp_no_dia= 5§
rdispfwp_no_vb =15
rdispfwp_no_vbZ = 2
rdispfwp_no_eng = 1
rdispfwp_no_btc = ¢
rdispfwp_no_spo =1
zosaysystem_language =E
PHYS_MEMSIZE = 763

sapguifuser_scripking = TRUE

Details about the SAP configuration file are provided in the SAP product
documentation.
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Software Components File

Right-click a Software Component CI and select the Show Content option to
display the software components file. For example:

~sofbware_components {read-only)

Mame = IDES

Package Level =

Tvpe = Main component
Description =

Release = 4.6C

Mame =PI

Package Level = A

Tvpe = Main component

Description = PI 2003 _1_46C ; Add-On Delka Upgrade
Release = 20035_1_<aiC

Mame = SAP_AB4

Package Level =

Tvpe = Main component

Description = Componente multiaplicaciones
Release = 46C

The software components file shows the following information:

Name. The name of the software component.
Package Level. The level of the package.
Description. A description of the package.

Release. The release number.
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Support Packages File

Right-click a Support Package CI and select the Show Content option to
display the support packages file. For example:

support_packages (read-only)

Marne = DM1K900013
Type = Patch has been applied
Description = Sprachenexport Z1 16,09,2002 (BUCHERT)

Marmne = SAPK-03A7GINSDF
Type = Patch has been applied
Description = Solution Toals Plugin (ST-PI 0034 _620)

Marne = SAPK-10001INLSOFE
Type = Patch has been applied
Description = LS0OFE 100 (Learning Salution - Fronk End)

The support packages file shows the following information:

» Name. The name of the support package.
» Type. The type of support package.

» Description. A description of the package.

CCMS Counters

The CCMS Counters Dynamic Nodes collect the samples from SiteScope and
display them as ClIs under the elements they are monitoring.

To view SiteScope samples under a CCMS Counters node:
1 Select Applications > Dashboard, click Console.
2 In the View list, select SAP Systems.

3 Select Background.
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The Console page displays the samples from SiteScope.

Background =
sap @+* ack @

TSR

Mame SAaP Ack Mame 5AP Ack
MM cap coms M ... EndedWpBTC * @ +* M spp coMS M ... berOfwWpBTS ¥ @+ B

LT}

D+

Details - SAP

sap cors monitor
ternplates/entire
sustemf/mis/ 3

L nnes services/background/mis
‘calderone_mis_00
Y..oAbackgroundfendedwpbtc

Status: (81

Calculation Rule: SiteScope Vertical Rule

Held status since: 215706 02:57:49 AM

0.0 AP CCMS Monitor
Templates/Entire
Svstern/MIGSRS 3
Services/Background/MI&
\icalderone MI&_O0VY,, LB
ackground/EndedwpRTC

Message !

The tooltips includes the following information:

>

>

>

Cl Name. The name of the CI.

Status. The status of the CI (calculated according to one of the status
calculation methods). It may also display:

> Not up to date for decayed ClIs, indicating that the CI has passed its
timeout period. (For a SiteScope CI, this status is displayed after a
SiteScope monitor is disabled.)

> Stopped when a Business Process profile is stopped.

Calculation Rule. The name of the rule that calculates the KPI status or
value.

Held Status Since. The date and time since which this CI has held its
current operational status.

Message. The value(s) returned by the monitor the last time it ran, as
displayed in SiteScope. This may simply be the retrieval time and file size
or it may include specific parameters for a server component.

Last Update. The date and time that the last update for the CI was
received by Dashboard. This information is not always displayed.
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» Measurement. The name of the measurement from SiteScope. This
information is not always displayed.

» Monitor. The monitor type that the CI represents. This information is
not always displayed.
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Working with the Siebel Solution
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Using the Mercury Business Availability
Center for Siebel Solution

This chapter describes the Mercury Business Availability Center for Siebel
solution that you use to monitor the performance of Siebel Enterprises.

This chapter describes: On page:
Introducing the Mercury Business Availability Center for Siebel 255
Solution

Mercury Business Availability Center for Siebel Solution Architecture | 258

Viewing Siebel Information in Dashboard 260
Context Menu Options 262
Viewing Changes Made to Siebel Enterprise Cls 263
Viewing Configuration File CI Details 264

Introducing the Mercury Business Availability Center for
Siebel Solution

This section presents the Mercury Business Availability Center for Siebel
solution that you use to monitor the performance of Siebel Enterprises.

This section includes the following topics:

> “About Using the Mercury Business Availability Center for Siebel Solution”
on page 256

> “Business Availability Center for Siebel Diagnostics Tools” on page 257
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About Using the Mercury Business Availability Center for
Siebel Solution

Mercury Business Availability Center for Siebel solution, integrating
SiteScope, Business Process Monitor, and Mercury Application Mapping (if
you are using Shared CMDB), enables you to gain visibility and control over
your mission-critical Siebel applications.

The Siebel solution provides:

» a single operation console consolidating all Siebel monitoring information

» automatic discovery and modeling of Siebel-related elements, as well as

Y VY VY Y

their relationships to other systems in the organization’s Information
Technology (IT) department

change discovery and notification for quicker problem resolution
proactive monitoring of end-user experience in Siebel enterprises
the ability to distinguish between Siebel-specific problems and general ones

management of Siebel-related service level commitments

Note: You must have a Mercury Business Availability Center for Siebel
license to view the Siebel Enterprises view in Mercury Business Availability
Center.

Mercury Business Availability Center for Siebel solution consolidates Siebel
components and business processes in the Siebel Enterprises view to gain
real-time visibility over the entire Siebel infrastructure from a business
perspective.

Mercury Business Availability Center for Siebel solution also monitors,
reports, and issues alerts on the performance and functionality of the Siebel
eBusiness applications and servers that comprise your Siebel Enterprise
business process infrastructure.
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Using Mercury Business Availability Center for Siebel solution, your IT
operation can analyze how each link in the Siebel Enterprise chain is
affecting the user experience of customers, partners, suppliers, and
employees. This enables your IT team to more accurately assess the resulting
impact on business performance. It also enables the IT team, Siebel
application support team, and Siebel Expert Services to take any steps that
might be necessary to maximize availability, performance, and service levels
to provide quality of service for all Siebel applications and end users.

The Siebel Enterprises view is available in the Dashboard. For details, see
“Viewing Siebel Information in Dashboard” on page 260.

Right-click the CIs in the Siebel Enterprises view to access additional
information and diagnostics tools. For details on the right-click menu, see
“Context Menu Options” on page 262. For details on the diagnostics tools,
see below.

Business Availability Center for Siebel Diagnostics Tools

You access the Business Availability Center for Siebel information from the
Applications menu. The following diagnostics tools are available:

SARM - User Trace Breakdown. Enables you to view Siebel real user
monitoring information coming from Siebel Application Response
Measurement (SARM). For detailed information on this tool, see Chapter 21,
“Using the SARM - User Trace Breakdown Diagnostic Tool”.

Database Breakdown. Enables you to determine the cause of slow database
response time by analyzing the database activity carried out as a result of
running a Business Process Step. For detailed information on this tool, see
Chapter 22, “Using the Siebel Database Breakdown Diagnostic Tool”.

Tasks. Enables you to view details of the operating system processes running
on the various Siebel Application Servers. For detailed information on this
tool, see Chapter 23, “Using the Siebel Tasks Diagnostic Tool”.

Process. Enables you to view details of the Siebel Application Server
processes, for all monitored Siebel enterprises. For detailed information on
this tool, see Chapter 24, “Using the Process Diagnostic Tool”.
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Mercury Business Availability Center for Siebel Solution
Architecture

The architecture of the Mercury Business Availability Center for Siebel
solution is illustrated in the following diagram:

Real User Monitor Siebel Enterprise Mercury

Probe* ﬁ SiteScope
_____ Real User _ » ﬁ System Maonitoring ﬁ

Monitoring % — — Sibel Diagnostics ~ ™

Discovery Mercury
Probe - e Business Process
— -Top - Shd Maonitor

54 M
i U
Win ™

Real User

Monitor E Mercury Business Awvailability Center

Engine* Siebel solution
Mercury

\ Application
Mapping
Server®
\M /V =
— l Legend
Optional

Most of the Siebel CIs are created by automatic discovery. The configuration
for those ClIs is saved into the CMDB. Some of the relationships to Business
Process Monitor and SiteScope ClIs are created by automatic mechanisms
specific to the Mercury Business Availability Center for Siebel solution.
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The architecture of the Mercury Business Availability Center for Siebel
solution includes the following components:

The Discovery Probe discovers Siebel-related CIs and other ClIs (such as
hosts) that are related to them.

If you selected to work with shared CMDB, the Discovery Probe also
communicates with Mercury Application Mapping. In such a case, Mercury
Application Mapping and Mercury Business Availability Center share a
CMDB. Mercury Application Mapping server collects information on
changes made to CI’s properties, stores that information in the History
database, and makes it available from the Siebel views in Mercury Business
Availability Center. For details about shared CMDB, see “Sharing the
Mercury Universal CMDB Environment” in Working with the CMDB. For details
about the History database, refer to Mercury Application Mapping
documentation.

The Real User Monitor Probe monitors real user traffic and sends it to the
Real User Monitor engine, that processes and stores it.

Mercury SiteScope communicates with the Siebel Enterprise system and
retrieves system monitoring information using the srvrmgr CLI tool. It is
also used as a middleware for all of the Siebel diagnostics tools.

Mercury Business Process Monitor collects data on the performance and
availability of the Siebel Enterprise by running transactions that correspond
to Business Process Steps. It is also used for Database Breakdown, and can be
leveraged in SARM; for example, user sessions can be correlated to the
corresponding Business Process Monitor transactions.

Mercury Business Availability Center is used as the central console for
viewing all of the data and performing analysis actions.
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Viewing Siebel Information in Dashboard

260

In Dashboard, access the Siebel Enterprises view to view information about
the Siebel IT entities, the Siebel enterprise metrics monitored by SiteScope
monitors, and information about the Siebel business processes/transactions
simulated by Business Process Monitor scripts.

The Siebel Enterprises is as follows:

view: |siebel Enterprises J
= —}n: Siebel Enterprises -
[ & =iebel
Applications
%" Business Processes
. Hosts
.7 Locations
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The following graph describes the various layers and drill-downs available in
the topology of the Siebel Enterprises view.

- - - Siebel . BP
| EELEE " | Application | Steps [
- BPM
| Locations - ?_ﬂt:::lid - Transar_:tionlf
Location
Business Business
> Processes > Pg:cess
Siebel | eps
Enterprises Legand
=  Host »| Web Server
Siebol Web
Server —-Diilld
Extension rdenn
- . Same
B Hosts > Y * |ovel link
Siebel Web
Application
_ Siebel
Hams-| Host ™ Gateway
Siebel Siebel Siebel
- Host | Application | Component Ha
Server Group Component
L Host » Database

Note: The ClIs, their hierarchy, and their KPIs are detailed in “ClIs Created by
the Discovery Process” in Discovery Manager Administration.

The Siebel Enterprises view is enabled by default. Other Siebel views are
disabled by default. To enable those views, select Dashboard & Service Level
Management in the Edit View Properties dialog box. For details, see
“Defining View Properties” in Working with the CMDB.
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The Siebel Topology and Siebel Web Topology views are created when you
run the discovery package. They display the results of the Siebel discovery
and are intermediate views whose information is included in the Siebel
Enterprises view.

The Siebel Service uses the Siebel BPM Locations Linkage, Siebel BPM
Locations Linkage Automatic, Siebel BPM Locations Linkage Manual, Siebel
Host Monitor Linkage, and Siebel SiteScope Measurement Linkage views to
automatically link measurements and monitors to ClIs. Those views are used
for debugging purposes.

Context Menu Options

A list of all of the context menu options available in the Siebel Enterprises
view is available in Chapter 2, “Dashboard Menu Options”.

The right-click options available from the Siebel-specific CITs are listed in
“Go to Siebel Diagnostics” on page 24. An additional right-click option is
Cross-Performance Report. For details, see “Siebel Cross-Performance” on
page 22.

Different menu options are available depending on the type of Siebel-
specific CIs you right-click:

Type of CIT Context Menu Option

Siebel Site Siebel Database Breakdown
Siebel SARM

Siebel Application Siebel Database Breakdown

Siebel Application Server Cross-Performance Report
Show Tasks in Error
Show Running Tasks

Show Processes
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Type of CIT Context Menu Option

Siebel Component Group | Cross-Performance Report
Show Tasks in Error
Show Running Tasks

Show Processes

Siebel Component Cross-Performance Report
Show Tasks in Error
Show Running Tasks

Show Processes

Siebel Web Server Cross-Performance Report
Extension
Siebel Web Application Cross-Performance Report

Viewing Changes Made to Siebel Enterprise Cls

You can assign Cls to keep change information. For details on assigning ClIs
to keep change information, refer to the Mercury Application Mapping
documentation.

When the discovery process discovers changes made to the properties of
those CIs, the changes are displayed in the Change report available as a
right-click menu option for each one of the relevant CI types. For details
about the Change report, see “Change Report” in Using Dashboard.
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Viewing Configuration File Cl Details
The Show Content right-click option displays configuration file details.
The following configuration files are available:

> Siebel.cfg. The siebel.cfg configuration file is taken from the application
server installation. To access the siebel.cfg file, access the Siebel Enterprises
view, right-click the relevant Siebel Application Server CI, and select Show
Content.

~siebel (read-only)

[Internet]

Tabletwner = 3IEBEL
Sqlstyle = OracleCBO
[155C04]

155CDAProdDetBusComphame = Internal Product
155CDAPradDetBusObjMame = Internal Product
155CDAProdDetiewMame = Product Detail Key Features Yiew
155CDRHeaderBusObiMame = Quote
155CDAHeaderBusCompMame = Quote
155CDAIntegrationobjMame = Quote
ISSCDaLiskIkemBusCompharne = Quote Tkem
155CDAHeaderviewName = Quote Detail Yiew

155CDAaGetMyPriceFields = List Price, Product Mame, Current Price, Pricing Comments, Met Price, Start Price

['Wireless: applicationList]

Siebel Sales Wireless = WirelesssalesObjMar_enu

Siebel Service Wireless = WirelessServiceObjMgr_enu

Siebel PRM Wireless = WirelesseChannelObijMar_enu
115iebel eService Wireless = WirelesseServiceObjMgr_enu
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> parameters.cfg. The file includes the output of the list parameters for
component command using srvrmgr. To access the siebel.cfg file, access the
Siebel Enterprises view, right-click the relevant Configuration File CI, and
select Show Content.

parameters (read-only)

PA_ALIAS PA_VALUE PA_DATATYPE PA_SCOPE PA_SUBSYSTEM PA_SETLEVEL  Pa_DISP_SETLEVEL
18K ThiSpace String  Subsystem Database Access Meversel  MNever set YN NN 1K Tak
32MThispacs String  Subsystem Databass Access Mevsr set  Never sst WON NN 32K Ta
ActuateConnStr String  Subsystem Infrastructure Actuste Reports Never st Never set YN NN Act
ActusteProtocolame String  Subsystem Infrastructurs Actusts Reports Never st Never sst WO NN A
ActusteReportCastDomain  CHANGE_ME String  Subsystem Infrastructurs Actusts Reports Server level  Server level set
ActusteReportCastHost String  Subsystem Infrastructurs Actusts Reports Never st Never set YN,
ActuteReporiCastlang  LANG_INDEPENDENT String  Subsystem Infrastructure Actuate Reports Server level  Server level set
ActudteReportPalivet 30 Integier  Subsystem Infrastructure Actuate Reports Server level  Server level set VNN
ActusteReportServerHost String  Subsystem Infrastructurs Actusts Reports Never sst Never set WON NN
ActusteRequestPollnterval  10,0,0,10 String  Subsystem Infrastructurs Actuste Reports Defautt value  Default valus YN
ActusteRoxDir ISishel Reports/ String  Subsystem Infrastructurs Actuste Reports Server level  Server level sst YN
ActuateServerEnabled False Boolean  Subsystem Infrastructure Actuate Reports Defaull value  Default value YONT
AddToCan AutoGuote TRUE String  Subsystem Infrastructure Shopping Servic Defaul value  Default value YN N
AddToCanGatoiew HONE String  Subsystem Infrastructure Shopping Servic Defaul value  Default value VN b
&nanLogin False Boolean  Subsystem Object Manager Default value  Defaut value ¥ NN N OM -
AnshymousQuots FALSE String  Subsystem Infrastructurs Shopping Servic Defautt value  Default valus YN
sssetBasedOrderingEnabled  False Boolean  Subsystem Object Manager Default value  Defaut value YONN
SutoQuoteDefaullOwner  TRUE String  Subsystem Infrastructure Shopping Servic Default value  Defaull value ¥ N
AutoRestart True Boolean  Subsystem Process Management Defeutt value  Defaull value YONN N A
BusinessServiceCusryAccessList String  Subsystem Object Manager Mevsr set  Never sst HONN N
CACeHFilehame String  Subsystem Networking Mevsr set  Never sst NN YN CA certific
CCAEnable False Boolean  Subsystem Infrastructure CCA subsystem Defautt value  Defaul value YN NN
CCAMsrchartia esalestest String  Subsystem Infrastructurs CCA subsystem Detfaut valus  Default value YN
cCaserverHost ics2testicd.com String  Subsystem Infrastructure CCA subsystem Defeut value  Defaul value ¥ N

265



Chapter 20  Using the Mercury Business Availability Center for Siebel Solution

266



21

Using the SARM - User Trace Breakdown
Diagnostic Tool

Mercury Business Availability Center for Siebel SARM Diagnostics is a user
trace breakdown diagnostic tool that processes the data in the User Session
Trace output files produced by Siebel’s SARM process. This data can be
retrieved for a specific user in a specific time frame. It can also be retrieved
for a specific transaction of a prerecorded script.

This chapter describes: On page:
About the SARM - User Trace Breakdown Diagnostic Tool 267
Using the SARM - User Trace Breakdown Diagnostics Tool 268
Results - Analysis Page 275

About the SARM - User Trace Breakdown Diagnostic Tool

Siebel SARM tool records logs for each Siebel transaction activity in the Web
server or in the application server. It also records data about how long each
transaction remains in each tier of the Siebel enterprise: Network, Web
Server, Application Server, and Database. Siebel SARM tool logs Siebel real
user monitoring data into binary SARM files (with .sarm extension).

Mercury Business Availability Center interacts with SARM Analyzer (a Siebel
tool) using remote API calls to SiteScope. Those calls activate a batch file,
which copies files from Siebel, and then uses the SARM Analyzer to generate
user-readable files from the Siebel files. The user-readable files are then
copied using SiteScope remote API to Mercury Business Availability Center.
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The SARM - User Trace Breakdown diagnostic tool is built over the Siebel's
SARM tool. It produces required .csv and .xml files as part of the analysis
process, in which the Siebel SARM Analyzer package is utilized. The tool also
analyzes and displays a graphical view of the results. It retrieves the SARM
data for a specific user, in a specific time frame. It enables retrieving the
SARM data for a specific Business Process Monitor transaction that belongs
to a prerecorded script with Siebel breakdown enabled.

In the SARM - User Trace Breakdown tab, you can compare this breakdown
per user sessions, user transactions, or application servers to enable you to
identify the prime suspect for performance problems. You can also drill
down within these logs to determine which layer is responsible for the slow
response.

The SARM - User Trace Breakdown diagnostic tool is activated on demand.

Note: The Virtual User Generator script must be recorded using the Siebel
Web protocol. Select the Enable Siebel Breakdown checkbox while
configuring the Business Process Monitor in Monitor Administration. For
details, see “Editing Business Process Transaction Monitors” in End User
Management Data Collector Configuration.

Using the SARM - User Trace Breakdown Diagnostics Tool

268

You run the SARM - User Trace Breakdown diagnostics tool in two stages:

In the first stage, you provide details on the data you want to process. For
details, see “Configuring the SARM - User Trace Breakdown Diagnostic Tool”
on page 269.

In the second stage, you run the SARM - User Trace Breakdown diagnostics
tool. For details, see “Running SARM - User Trace Breakdown Diagnostic
Tool” on page 274.

The data is then displayed and you can generate different views and pie
charts to display the data in a user-friendly manner in the SARM - User Trace
Breakdown page. For details, see “Results - Analysis Page” on page 275.
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This section includes the following topics:

> “Configuring the SARM - User Trace Breakdown Diagnostic Tool” on
page 269

» “Running SARM - User Trace Breakdown Diagnostic Tool” on page 274

Configuring the SARM - User Trace Breakdown Diagnostic
Tool

You can view data about the activity taking place in the Web server(s) and
application server(s) at a specific Siebel Enterprise and for a specific user, in a
specified period of time. Mercury Business Availability Center searches all of
the SARM files at the Siebel Enterprise, looks for the sessions of the specified
user, fetches the appropriate files, runs the SARM analyzer, and lists all of
the sessions used by the user.

Configuring the SARM - User Trace Breakdown Diagnostics Tool
You can configure the SARM - SARM - User Trace Breakdown diagnostic tool.

To configure the SARM - User Trace Breakdown diagnostics tool:

1 Click Applications > Business Availability Center for Siebel > SARM - User
Trace Breakdown to open the SARM - User Trace Breakdown Diagnostic Tool

page.
You can also access this page filtered for the selected CI, when you right-

click the CI and select the Siebel SARM option. For details, see “List of Menu
Options” in Using Dashboard.

SARM - User Trace Breakdown | Database Breakdown Tasks Process
SARM - User Trace Breakdown
Enterprises: Isiebel vI User: I
Fror: May 17 2006 10:42:32 AM Ta: May 17 2006 10:52:32 AM

(¥ Invoke Business Process Monitor Script

(¥ Advanced Options
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2 In the Enterprises list, select the Siebel Enterprise for which you want to
view SARM User Trace Breakdown data.

3 Enter the name of the user whose activity you want to trace in the User box.

4 Click the linked date in From or To to open a calendar and select a new date
and time if you want to change the default date and time.

5 You can then:

» Invoke a specific Business Process Monitor script. For details, see
“Invoking a Specific Business Process Monitor Script” on page 271.

» Specify where the files can be found:

> Automatically collected Web and application server logs. For details,
see “Using Automatically Collected Web and Application Server Logs
on page 272.

”

» The SARM logs of a specific application server and Web server. For
details, see “Using the SARM Logs for a Specific Web and Application
Server” on page 273.

> An already generated user session trace .xml file for a Siebel Enterprise,
a user, and a specific time frame. For details, see “Using a Pre-
generated User Session Trace .xml File” on page 273.

6 Click Run to run the diagnostic tool. For details, see “Running SARM - User
Trace Breakdown Diagnostic Tool” on page 274.
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Invoking a Specific Business Process Monitor Script

You can view data about a Business Process Monitor transaction of a specific
script running in the Web server(s) and application server(s) at a specific
Siebel Enterprise, and in a specified period of time. Mercury Business
Availability Center invokes the Business Process Monitor transaction, and
then analyzes the relevant session.

To invoke a specific Business Process Monitor script:

1 Expand the Invoke Business Process Monitor Script area in the SARM - User
Trace Breakdown page.

=

#) Invaoke Business Process Monitor Script

Application: Iauiad_bpml;l Script: Isiebel_cannon_auiad_bpm1_29_10_04;I Host: Icookie_041109;|

Tranzactions:

login_cannon_aviad_bprnl
goto_accounts_cannon_aviad_bpm1
goto_assets_cannon_aviad_bpmil
goto_orders_cannon_aviad_bpm1
logout_cannon_awiad_bpm1

Invoke Script

2 In the Application list, select the application.
3 In the Script list, select the script.

4 In the Host list, select the location of the Business Process Monitor running
the script.

5 Click Invoke Script to invoke the script transactions.
6 You can then:
» Specify where the files can be found:

> Automatically collected Web and application server logs. For details,

see “Using Automatically Collected Web and Application Server Logs”
on page 272.

» The SARM logs of a specific application server and Web server. For

details, see “Using the SARM Logs for a Specific Web and Application
Server” on page 273.
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> An already generated user session trace .xml file for a Siebel Enterprise,
a user, and a specific time frame. For details, see “Using a Pre-
generated User Session Trace .xml File” on page 273.

7 Click Run to run the diagnostic tool.

Using Automatically Collected Web and Application Server
Logs

You can run the SARM - User Trace Breakdown diagnostic tool on
automatically collected Web and application server logs.

To use automatically collected Web and Application server logs:

1 Expand the Advanced Options area in the SARM - User Trace Breakdown
page.

%) advanced Options

Analayze data in files:
[ Autornatically collact files.,

[ Specify the SARM lags faolders:

Application Servers: I

Web Servers: I

[ Specify a User Session Trace File:

Uzer Sezsion Trace File: I

Using SiteScope:

2 Select Automatically collect files to run SARM - User Trace Breakdown
diagnostics on all Web and application servers at the Siebel Enterprise. This
is the default.

3 Enter the SiteScope(s) that will be used to collect the data in the Using
SiteScope box.
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Using the SARM Logs for a Specific Web and Application Server
You can run the SARM - User Trace Breakdown diagnostic tool on the SARM
logs of a specific application server and Web server.

To use the SARM logs for a specific Web and Application server:

Expand the Advanced Options area in the SARM - User Trace Breakdown
page.
Select Specify the SARM logs folders to run SARM - User Trace Breakdown

diagnostics only on the specified Web and application servers for the Siebel
Enterprise:

a In the Application Servers box, enter the path to the SARM logs of the
application server(s).

b In the Web Servers box, enter the path to the SARM logs of the Web
server(s).

Note: The paths are relative to the SiteScope machine.

Select the SiteScope(s) that will be used to collect the data in the Using
SiteScope list.

Using a Pre-generated User Session Trace .xml File

You can run the SARM - User Trace Breakdown diagnostic tool on an already
generated user session trace .xml file for a site, a user, and a specific time
frame. Mercury Business Availability Center searches all of the SARM files at
the Siebel Enterprise, looks for the sessions of the specified user, fetches the
appropriate files, runs the SARM analyzer, and lists all of the sessions used
by the user that were active within the time frame.

To use a pre-generated User Session Trace File:

Expand the Advanced Options area in the Access the SARM - User Trace
Breakdown page.

Select Specify a User Session Trace File to work on an already generated user
session trace .xml file and in the User Session Trace File box, enter the path
to the trace file. The path is relative to the SiteScope machine.
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3 Select the SiteScope(s) that will be used to collect the data in the Using

SiteScope list.

Running SARM - User Trace Breakdown Diagnostic Tool

When you run the SARM - User Trace Breakdown diagnostic tool, the SARM
- User Trace Breakdown page indicates the status of each step in the
procedure.

Check SiteScopes connectivity [ ]

Load Web Servers' session data [ ]

Extract Application Servers' session data [ ]

fnalyze results and prepare chars [ ]

Froceszing:

Total Progress: L ]

» Check SiteScopes connectivity. When the status indicator shows running

stripes, the SiteScopes connectivity is being checked. When the status
indicator is complete, the operation has completed.

Load Web Servers’ session data. When the status indicator shows running
stripes, the Web server session data is being loaded. When the status
indicator is complete, the loading has completed.

Extract Application Servers’ session data. When the status indicator shows
running stripes, the application server session data is being extracted. When
the status indicator is complete, the extraction has completed.
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> Analyze Results and Prepare Charts. When the status indicator shows

running stripes, the final results are being analyzed and charts are prepared.
When the status indicator is complete, the loading has completed.

» Processing. The progress in the current step.

» Total Progress. Indicates the total progress of the SARM - User Trace

Breakdown diagnostic tool.

After the process is complete, the page closes and the diagnostic results are
displayed on the SARM - User Trace Breakdown - Analysis page. For details,
see below.

Results - Analysis Page

In the SARM - User Trace Breakdown - Analysis page, you can view:

A chart that displays the segmentation between the average Application
Server time, Web Server time, Network time, and Database time for all of the
relevant requests that were found in the files

» The time distribution of the various sessions

» For each Business Process Monitor transaction, the timestamp of the session

it belongs to, the session id, the application server name, the average total
time of all requests that belong to that transaction, the number of request
and the maximal request time

» A comparison between application servers in terms of times' distribution.

» For each request, the request detailed information

Y Y Y Y Y Y

This section includes the following topics:

“Summary” on page 276

“Sessions” on page 279

“Transaction” on page 281

“Requests” on page 286

“Application Servers” on page 284
“Displaying Instance Details” on page 290
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Summary

The chart displays the segmentation between the average Application Server
time, Web Server time, Network time, and Database time for all of the
requests that were found in the files.

[Siter whistle, User: wrun, Frarm: 10/24/04 05:00:24 PM, To: 10/24/04 08:10:24 PM

£, . 5 i Transactions Application Servers Requests

Siebel Layer Breakdown

Avg. request time = 51.5949 seconds

B web Server

W &pplication Server
B Database

2l Metwork

Note: The drillable data is only accessible through the charts (not through
the tables).
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Drilling down one of the segments in the chart provides a pie chart that
displays the segmentation between the sub areas of that segment. If there is
another level of specification (available in Siebel 7.7), you can then drill
down to the sub area level. For example, you can drill down the Application
Server layer to access the segmentation between the areas of Application
Server.

Siebel Layer Breakdown

Avg. request time = 48,673 seconds

B Application Server

B Object Manager

B Communications Server Service
2l Build Web Page

You can then click segments of the Area Breakdown chart to open the
corresponding Sub Area Breakdown chart (if it exists).
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The breakdown is as follows:

Layer Breakdown

Area Breakdown

Sub Area Breakdown

Web Server N/A N/A
Application Server Application Manager Request Receipt (sessID SeqlD)
Object Manager Session Re-Login

Communications Server
Services

Communications Client Invoke Method

Communications Server Invoke Method

Build Web Page

Build View Layout

Show Applet, Build View Data

Build Applet
Get View Layout
Database Database Connector N/A
Network N/A N/A
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Sessions

Click the Sessions tab to open the sessions table.

|Site: whistle, User: wrun, From: 10/25/04 03:48:00 PM, To: 10/25/04 04:58:00 PM |

Summary ,n—-|Transactions Application Servers Requests
gl @8l
TN
Session ID Date Avg. Layer Breakdown No. of Max. -
Request Requests Reques|
Time Time
[ de4.174d5.417ca324 10/25/04 03:56:36 P 43,2222 [N 15 213,208
[T it4eqi74ds.417casze 10/25/04 03:55:56 pM 42,6520 (M 27 230,465
[ iide4.174d7.417c2369 10/25/04 03:55:32 pu 42,2012 [ 27 232,313
[ ii4e4.174d6.417ca358 10/25/04 03:55:20 P 440852 [N 27 23232
[ 1i4ed.174d5.417caz47 10/25/04 02:55:03 pn 4424 [N 26 224,70
[ ded.i74dd.417ca33f 10/25/04 03:54:55 P 50,4327 [ 27 263,644
[0 1.4e4.174d3.417ca338 10;’25;%4 oz:is4:42 P 4z.0scc [ 27 238.64
[ ded.i7dced17casbs 10/25/04 03:52:37 Py 43,0223 [ 27 235.87¢
[0 ides174caa17ca272 10/25/04 03:51:32 p 4e.4122 ([N 27 238.49¢
[ fded.i74c7.41702251 10/25/04 03:50:56 pa 45,1022 [ 27 238.26%
[T des174bea17ca20d 10/25/04 0z:43:50 pa 427622 ([N 27 226.128
1 3
EE@ Summary Chart | M web Server Ml Application Server Bl DataBase | Metwork

The default view shows all of the sessions that answer the criteria.
The page displays the following information for each session:

» Session Id. The ID of the session. You can drill the session ID to display
information about the session requests. For details, see “Requests” on
page 286.

Date. The timestamp of the session.
> Avg. Request Time (sec). The average time the request spent in the session.

Layer Breakdown. The breakdown of the layer into its areas relative to the
time spent by the session in each area: Web Server, Application Server,
Database, and Network. Tooltips display the average time the session spent
in each area.
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> No. of Requests. The number of requests that ran in the session.

» Max Request Time (sec). The maximum time spent by a request in the
session.

Note: Scroll to the right to see the rest of the information.

» Task ID. The ID of the task the request belongs to.

» Application Server. The name of the application server on which the session
is running.

> Web Server. The name of the Web server on which the session is running.

You can select one or more sessions and click Summary to display a
summary chart for the sessions you selected.

4] e v u]
Session ID Date Avg. Layer Breakdown No. of Max. -
Request Requests Reques
Time Time
[7 11.424.174d9.417ca324 10/25/04 03:56:36 p 43,2022 |G 15 213,20
[l 1i.ded.174d8.417ca37c 10/25/04 03:55:56 pM 43,5525 [ 27 230,465
[ 14es174d7.417c2365 10/25/04 03:55:32 pa 422012 [ 27 232,311
[ 1.4e4.174de.417ca358 10/25/04 03:55:20 M 44,0252 [ 27 232347
‘ »
% Qb %E Summary Chart M web Server ll Application Server [ll DataBase | Metwork

Siebel Layer Breakdown

Avg. request time = 44,9196 seconds

B web Server

B Application Server
B Database

| Metwarlk

Use the Select all, Invert selection, and Select none buttons (shown below)
to help you select the sessions.

] B2 B8
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For more details on the summary chart, see “Summary” on page 276.

Transaction

Click the Transactions tab to open the transactions table.

Site! cannon, User: aviad_bprndl, From: 11/2/04 04:01:04 &AM, To: 11/2/04 05:11:04 &AM

Somenary

Em———r e

slzle

I <+ 6 D
Transacton Name Total Layer Breakdown BPM Mo. of Max. Date A
Time Time Requests Request
Time
I_ goto orders cannon aviad bprmil o142 _ 3 041858 114240
B goto sssets cannon avisd bpmi 00834 .F\pplication Jerver: 0.0326 53':. 30,0897 117270
I— goto_accounts cannon _awiad bpmil 0.1064 _ 20,0738 11.l"2.|"DE
[T loain csnnon awisd bprat o.zso7 [ 14 02087 11/2/0|
[ goto_orders cannon _aviad bprml 01672 _ Z 0.1404 11.-"2.?'05
= goto assets cannon aviad bprad n.08a4 _ 2 0.0751 11/2/0
B goto sccounts cannon swiad bpril 01027 _ 30,0748 11/2/0
[T login cannon aviad bpmi ozo1+ [ 14 0.2055 11/2/0
I_ goto orders cannon aviad bprml 01761 _ 3 0.1434 11,-"2;"05
I goto sssets cannon awiad berma  0.0827 [ 3 00763 11/2/0
I_ goto accounts cannon awiad bprnl 0,1053 _ 3 00,0787 117270
[T login cannon aviad bpmi o.zs [ 14 0.2422 11/2/0—
WE B O
%5 % Ea Summary Chart | M web Server B Application Server ll DataBase | Metwork

If Mercury Business Availability Center knows the Business Process Monitor
transaction the request belongs to, the page displays the transaction name.
The application server time, Web server time, database time, and total time
are also displayed. For details on naming convention, see “Automatically
Attaching Business Process Steps to a Siebel Application CI by Following the
Naming Convention” in Application Administration.
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If the request belongs to a transaction that was executed by a user request in
the previous page, Business Availability Center for Siebel also provides the
Business Process Monitor time of that transaction. You can also run the
Transaction Analysis report for the transaction. For details, see “Transaction”
on page 281. For details on naming convention, see “Attaching Business
Process Steps to a Siebel Application CI without Following the Naming
Convention” in Application Administration.

You can click any part of the chart to get the tooltip that indicates the time
the transaction spent in the layer, area, or sub area.

This view is provided only for the user used by the Business Process Monitor,
and not for a real user, in order to be able to process this data. This way, all
of the requests that belong to that transaction are identified and data can be
generated. For details, see “Editing Business Process Transaction Monitors”
in End User Management Data Collector Configuration.

Note: You must enable Siebel breakdown for the Business Process Monitor
script monitoring your Siebel application. This can be done while
configuring the Business Process Monitor transaction in the Admin >
Monitors, and selecting Enable Siebel breakdown in the Transaction
Breakdown Settings area. For details, see “Editing Business Process
Transaction Monitors” in End User Management Data Collector Configuration.

The page displays the following information for each transaction:

» Transaction Name. The name of the transaction.
» Total Time. The total time the transaction ran in Siebel.

» Layer Breakdown. The breakdown of the layer into its areas relative to the

time spend by the transaction in each area: Web Server, Application Server,
Database, and Network. Tooltips display the average time the transaction
spent in each area.
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BPM Time. This column displays the time the invoked transaction ran in
Business Process Monitor (only when the transaction is invoked using
Invoke Business Process Monitor Script). This value is larger than the value
in the Total Time column as it includes client time, network time, and so
forth.

No. of Requests. The number of transaction requests that ran in this
application server.

Max. Request Time. The maximum time spent by any of the requests in the
transaction.

Date. The date when the transaction ran.
Session ID. The Id of the session.
Task ID. The Id of the task the transaction belongs to.

Application Server. The name of the application server on which the
transaction ran.

Web Server. The name of the Web server on which the transaction ran.

Drilling down a transaction will display all of the requests that belong to
that transaction. For details, see “Requests” on page 286.

Note: The BPM Time is displayed only when the SARM User Session Trace
breakdown diagnostics has been run after invoking a BPM script monitoring
the Siebel Application. Some additional tuning of Siebel Application\Web
Server environment variables is required. This is due to the fact that the
flush ratio of SARM files is approximately S times slower in the Web Server
than in the Application Server, and therefore running SARM with the
default value of SARM_MaxFileSize variable may not be enough for the
SARM User Trace Breakdown diagnostic tool to return data (contact Mercury
Customer Support for additional information).
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Application Servers
Click the Application Servers tab to open the Application Server table.

|Site: whistle, User: wrun, From: 10/25/04 03:48:00 PM, To: 10/25/04 04:58:00 PM |

Summary Sessions Transactions Application Servers Requests
il
A I
Application Server Avg. Request Time Layer Breakdown Mo. of Requests Max. Request Time
I%YE % %E Summary Chart W web Server Ml Application Server Ml DataBase | Metwork

Each application server is drillable and displays all of the requests that were
executed on that application server.

The page displays the following information for each application server:

» Application Server. The name of the application server. You can drill the
session ID to display information about the application server. For details,
see “Requests” on page 286.

> Avg. Request Time. The average time spent by a request executing in this
application server.

284



Chapter 21  Using the SARM - User Trace Breakdown Diagnostic Tool

> Layer Breakdown. The time consumption breakdown by layers into its areas
relative to the time spent by the request in each area: Web Server,
Application Server, Database, and Network. Tooltips display the average
time the request spent in each area.

> No. of Requests. The number of requests that ran in this application server.

» Max. Request Time. The maximum time a request spent in this application
server.

You can select one or more application servers and click Summary to display
a summary chart for the application servers you selected. For more details
on the summary chart, see “Summary” on page 276.

Use the Select all, Invert selection, and Select none buttons (shown below)
to help you select the sessions.

[ [ Fh
BE | | w0
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Requests

Click the Requests tab to open the requests table. You can also access this
information by clicking a session ID in the Sessions tab, or by clicking an

application server in the Applications tab.

[site: whistle, User: wrun, From: 10/25/04 03:4&:00 PM, To: 10/25/04 04:55:00 PM

Summary Sessions Transactions Application Servers| p, q ts
g =8
(4 (Jaraos b W
Request Transaction Total Layer Breakdown BPM Date Session ID &
I Name Time Time

o
1

z

(B )

]

[ )

]

T OOO0OooOooOoooOoooao
|

o] %l 88|

Summary Chart |

7,975

99,327

298,44

11.261

259,221

122,959

9.872

12,421

23,33

9.827

93,148

3,896

10/25/04 02:
10/25/04 0Z:
10/25/04 02:
10/25/04 0Z2:
10/25/04 02:
10/25/04 02:
10/25/04 02:
10/25/04 02:
10/25/04 02
10/25/04 02:
10/25/04 02:

10/25/04 02:

51:01 PM

51:01 PM

51:01 PM

S51:01 PM

51:01 PM

51:01 PM

51:01 PM

51:01 PM

F1:01 PM

51:01 PM

51:01 PM

51:01 PM

MW web Server Ml Application Server [l DataBase

11.424,173bc 41
11.424,173bc, 41
11.424,173bc. 41
11.424,173bc, 41
11.424,173bc. 41
11.424,173bc 41
11.424,173bc. 41
11.424,173bc, 41
11.424,172bc 41
1.424,173bc 41
1.424,173bc 41

11.4e4,173bc 41"
3

Metwork

The page displays the following information for each request:

» Request ID. The ID of the request. You can drill the request ID to display

information about the area where the request ran. For details, see
“Displaying the Area Details” on page 288.

» Transaction Name. The name of the transaction the request belongs to.

» Total Time. The total time spent to execute a request.
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Layer Breakdown. The time consumption breakdown by layers into its areas
relative to the time the request spent in each area: Web Server, Application
Server, Database, and Network. Tooltips display the average time the request
spent in each area.

BPM Time. This column displays the time the invoked request ran in
Business Process Monitor (only when the request is invoked using Invoke
Business Process Monitor Script). This value is larger than the value in the
Total Time column as it includes client time, network time, and so forth.

» Date. The date when the request ran.

» Session ID. The ID of the session on which the request ran.

Note: Scroll to the right to see the rest of the information.

» Task ID. The ID of the task the request belongs to.

» Application Server. The name of the application server on which the task

ran.

Web Server. The name of the Web server on which the task ran.

Note: The BPM Time is displayed only when the SARM User Session Trace
breakdown diagnostics has been run after invoking a BPM script monitoring
the Siebel Application. Some additional tuning of Siebel Application\Web
Server environment variables is required. This is due to the fact that the
flush ratio of SARM files is approximately 5 times slower in the Web Server
than in the Application Server, and therefore running SARM with the
default value of SARM_MaxFileSize variable may not be enough for the
SARM User Trace Breakdown diagnostic tool to return data (contact Mercury
Customer Support for additional information).

You can select one or more requests and click Summary to display a
summary chart for the requests you selected.
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Use the Select all, Invert selection, and Select none buttons (shown below)
to help you select the sessions.

i ]
For more details on the summary chart, see “Summary” on page 276.

Displaying the Area Details

In the request details page, click a request ID to display information about
the areas where the request ran.

The page displays the following information:

Area Name. The name of the area where the request ran. You can drill the
area name to display information about its sub areas. For details, see
“Displaying the Sub Area Details” on page 289.

» No. of Sub Areas. The number of sub areas in the area.

» Total Execution Time. The total time spent by the request executing in the

area.

Avg. Execution Time. The average time spent by the request executing in the
area.

Max Execution Time. The maximum time spent by the request executing in
the area.

Recursive Invocations. The number of times requests were invoked by other
requests (recursive invocation) in the area.

Non-Recursive Invocations. The number of times requests were invoked
(non-recursive invocation) in the area.

Exclusive Memory Max Allocated Sub Area. The amount of memory used by
requests that entered only this area.

Max Response Time SARM node App String 1. The name of the method
invoked or workflow process involved.

Max Response Time SARM node App String 2. The name of the method
invoked or workflow process involved.
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Displaying the Sub Area Details

In the area details page, click the area name to display information about its
sub areas where the request ran.

e ] ]
Sub Area Name Area Name MNo. af Total Avg. Max Recursive MNon |
Instances Execulion Execution Execution Invocations Recursive |
Time Time Time Invocations |
Fequest Receipt (zezzID SeqlD] Application Server 1 2,893 2.8935 2,893 a 1
4 3
Lvl% QE‘ %E Summary Chart | M web Server B Application Server Bl DataBase | Metwork

The page displays the following information for each sub area:

Sub Area Name. The name of the sub area where the request ran. You can
drill the sub area name to display information about the session requests.
For details, see “Displaying Instance Details” on page 290.

» Area Name. The name of the area where the sub area is located.

> No. of Instances. The number of instances of the request.

> Total Execution Time. The total time spent by the request executing in the

sub area.

Avg. Execution Time. The average time spent by the request executing in the
sub area.

Max Execution Time. The maximum time spent by the request executing in
the sub area.
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> Recursive Invocations. The number of times requests were invoked by other

requests (recursive invocation) in the sub area.

Non-Recursive Invocations. The number of times requests were invoked
(non-recursive invocation) in the sub area.

Note: Scroll to the right to see the rest of the information.

Exclusive Memory Max Allocated Instance. The amount of memory used by
requests that entered only this sub area.

Max Response Time SARM node App String 1. The name of the method
invoked or workflow process involved.

Max Response Time SARM node App String 2. The name of the method
invoked or workflow process involved.

Displaying Instance Details

In the sub area details page, click the sub area name to display information
about the instances where the request ran.

RN EEE
Area Name Sub Area Mame Instance Total Awvg. Max Recursive Non M
Name Execution Execution Execution Invocations Recursive R
Time Time Time Invocations Ti
m
A

Application Server Request Receipt (sessID SeqlDl) 2,895 2,895 2,895 o 1
L) 3
I%TZ % EE Summary Chart W web server Bl Application Server ll DataRase Metwork
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The page displays the following information for each instance:

Area Name. The name of the area where the request ran.
Sub Area Name. The name of the sub area where the request ran.
Instance Name. The name of the instance where the request ran.

Total Execution Time. The total time spent by the request executing in the
instance.

Avg. Execution Time. The average time spent by the request executing in the
instance.

Max Execution Time. The maximum time spent by the request executing in
the instance.

Recursive Invocations. The number of times requests were invoked by other
requests (recursive invocation) in the instance.

Non-Recursive Invocations. The number of times requests were invoked
(non-recursive invocation) in the instance.

Note: Scroll to the right to see the rest of the information.

Max Response Time SARM node App String 1. The name of the method
invoked or workflow process involved.

Max Response Time SARM node App String 2. The name of the method
invoked or workflow process involved.
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Using the Siebel Database Breakdown
Diagnostic Tool

The Siebel Database Breakdown diagnostic tool enables you to analyze
database logs created on the Siebel application server, and extract
comprehensive information regarding database time spent by various SQLs.

This chapter describes: On page:
About Analyzing Siebel Database SQL Activity 293
Analyzing the Siebel Database Breakdown 296

About Analyzing Siebel Database SQL Activity

You analyze Siebel database SQL activity by examining information in the
Siebel application server logs. These logs contain a record of SQLs carried
out as a result of Siebel components activity.

Logs are constantly created and updated on the Application Server.
However, most of the time they are only logging errors, and do not include
the extensive information that Database Breakdown can display. To log the
extensive database time distribution information, the log level needs to be
brought up.

When the user runs Database Breakdown, after defining the analysis' scope
(Siebel Enterprise, Application, Business Process Step, and so forth, Business
Availability Center for Siebel automatically increases (via SiteScope) the
database log level for the selected component (if a specific component was
selected).
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Then, Business Availability Center for Siebel instructs the Business Process
Monitor to run the transaction you selected. During the transaction run, as
a result of the higher log level, database-related information is written into
the application server log.

When the transaction has finished running, the database log level for the
selected component is returned to normal by Mercury Business Availability
Center for Siebel.

To run the Database Breakdown tool:

1 Click Applications > Business Availability Center for Siebel > Database
Breakdown to open the Siebel Database Breakdown Configuration page.

Database Breakdown | Tasks SARM - User Trace Breakdown Process

Database Breakdown > Configuration

Select an enterprise: IsiebeI?B vl Select an application: IeEuents ;I User Mame: I

Available Transactions

I

#) Adwvanced options

Select a Siebel component: IeEuents Object Manager (JPM) ;I

Select a server; I-AII SErVers- vl
Uszing SiteScope: Icatapultl vl

Analyze |

You can also access this page filtered for the selected CI, when you right-
click the CI and select the Siebel Database Breakdown option. For details,
see “List of Menu Options” in Using Dashboard.

2 In the top part of the page:
a In the Select an enterprise list, select the Siebel Enterprise.

b In the Select an application list, select the Siebel application for which
you want to analyze data.
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The value in the User Name box appears automatically when you select the
application. The appropriate user name has been entered manually by your
administrator after discovery has taken place and the monitoring script was
recorded, but you can override it. For details, see “Deploying the SiteScope
Siebel Monitors” in Application Administration.

In the Available Transactions area, the transactions are listed when you
select a Siebel Enterprise and an application in the top part of the page.
Click the Business Process Monitor transaction whose activity you want to
analyze. (Note that the list of transactions includes only those for which you
have permissions.)

Note: For diagnostic purposes it is recommended to use a script running a
dedicated user. This will enable making sure diagnosis results refer to the
Business Process Monitor transaction intended to be analyzed.

In the Advanced options area:

a Select a Siebel component in the Select a Siebel component list. Only the
log level for that component will be brought up.

b Select a Siebel Application Server in the Select a server list. You can also
leave All servers selected.

c Select the SiteScope machine you want to use to monitor the Siebel
component in the Using SiteScope list.

Click Analyze to display the Siebel Tier Breakdown and Siebel Database SQL
Breakdown pie charts. For details, see “Analyzing the Siebel Database
Breakdown” on page 296.
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Analyzing the Siebel Database Breakdown

296

After you have created Siebel database logs, you can analyze them to
determine which of the component’s SQL operations, or parts of operations,
were responsible for slow database response time.

Click the Analyze button on the Siebel Database Breakdown: Configuration
page to open the Siebel Database Breakdown: Analysis page.

Blz/E

Transaction Name: siebel_login

Database source log file: SCCObjMgr_enu_166947.log (on serverisblapplq)

Siebel Tier Breakdown Siebel Database SQL Breakdown
Top 15 time-consuming 5QLs out of 33

B saoL =15
W sl ld=6
B saL ld=13
ol saL ld=18
ol saL ld=28
W saL ld=21
ol saL ld=17
ol saL ld=z0
ol saL ld=33
| saL ld=1
B saL ld=32
SQL ld=31
ol saL ld=30
| saL ld=1g
B saL ld=15

B Database Time
W Application Time

Transaction response time = 2.87 seconds Total databasze time = 0.13 seconds

The Siebel Tier Breakdown pie chart shows the transaction’s database time
relative to its application time.

The Siebel Database SQL Breakdown pie chart displays a breakdown of up to
15 of the most time-consuming SQLs.
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To view the database-specific time distribution of a specific SQL, click the
section of the pie representing that SQL. The Specific SQL Breakdown pie
chart is displayed.

gl 2|

Transaction Name: siebel_login

Database source log file: SCCObjMgr_enu_166947.log [on server:zblapplQ)

Specific Siebel 5QL Breakdown
SQLId = 16 (Time stamp: 2004-10-17 13:44.:18)

B Prepare Time

M Execute Time

M Iritial Fetch Time
ol Wite Time

SOL response time = 0.011 seconds

Measurements of Analyzed SQL Statement:

Statement

SELECT T1.COMFLICT_ID, T1.LAST_URD. T1.CREATED, T1.LAST_URD_BY, T1.CREATED_BY, T1. MODIFICATION_MUM,
T1.ROW_ID, T1.CACHE_RSLT_FLG, T DESC_TEXT, T1.QUERY_STRIMG FROM SIEBEL.S_APP_QUERY T1 WHERE
(T1,CREATED BY = 1-80 OR T1.PRIV FLG = 'W') AMD (T1.MAME = WebCallCenter ) ORDER BY T1.MAME, T1,.DESC_TEXT

For each SQL operation, you can view the various database times:
preparation time, execution time, initial fetch time, total time, and write
time (time stamp). This enables you to isolate the exact segment that was
responsible for the delay in the database response time. Underneath the
Specific SQL Breakdown pie chart, you can view the corresponding SQL
statement.

Note: You can print the report, open it as a PDF or e-mail it by clicking one
of the icons at the top of the report. For details, see “Sharing and Storing
Reports” in Working with Applications.
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Using the Siebel Tasks Diagnostic Tool

The Siebel tasks diagnostic tool enables you to view details of the Siebel
Application Server tasks, for each monitored Siebel Enterprise.

This chapter describes: On page:
About the Tasks Diagnostic Tool 299
Viewing Task Details 300
Using the Advanced Filter 302

About the Tasks Diagnostic Tool
Using the Siebel Tasks Diagnostics tool, you can:

» retrieve details of the Siebel Application Server tasks that are running, or
were run, on each Siebel Enterprise

» choose to view details of all tasks, regardless of status, or details of only
those tasks with a specific status

» choose to view task details for all components in all component groups on
all Siebel Application Servers, or for specific components in specific
component groups on specific Siebel Application Servers
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Viewing Task Details

300

To view details of Siebel Application Server tasks, you must select a Siebel
Enterprise. You may also define a certain task status, and a specific user
whose tasks you want to view. In addition, you can use the advanced filter
to select the specific component(s), component group(s), and Siebel
Application Server(s) for which you want to view task data.

The tasks detailed information is as follows:

Site: !whistle 'l Status: | -All statuses- _vJ User:

Advanced Filter:

Server: All servers, Component Group: All component groups, Component: All components, Using
: ; Apply
SiteScope:! rcal

Sl e v
SW_MNAME CG_ALIAS CC_ALIAS TK_LABEL TK_TASKID TK_PID TK_DISP_RUNSTATE CC_RUNMOL &
whistle Systern ServerMgr 105432 4336 Running Interactive
whistle Callcenter  SCCObiMar_ipn sadmin 105431 1988 Running Interactive
whistle Systern ServerMgr 105430 Completed Interactive
whistle Systern ServerMgr 105429 Completed Interactive
whiztle Systern ServerMgr 105428 Cormpleted Interactive

Y VY VY Y

SV_NAME. The name of the server on which the task is running.
CG_ALIAS. The name of the component group the task belongs to.
CC_ALIAS. The name of the component the task belongs to.

TK_LABEL. The name of the user who is running the tasks. Note that some
tasks (such as the ones belonging to the system component group) do not
have a user.

» TK_TASKID. The Id of the task.

» TK_PID. The operating system process ID that deals with the task.

One process can deal with more than one task.

This column displays data only for tasks whose TK_DISP_RUNSTATE is
running.

TK_DISP_RUNSTATE. The state of the task: Running, Paused, Stopping,
Completed, Exited with Error, or Killed.
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» CC_RUNMODE. The mode used to execute the task: Interactive or Batch.
» TK_STATUS. A description of the task—added by the task. If

Y Y Y Y Y Y Y

TK_DISP_RUNSTATE is Exited with Error, TK_STATUS displays the error
message.

TK_START_TIME. The time when the task started to execute.
TK_END_TIME. The time when the task stopped executing.
TK_PARENT_T. The task that caused this task to execute.
CC_INCARN_NO. The number of times the task was restarted.
TK_TASKTYPE. The urgency of the task.

TK_PING_TIM. For future use.

TK_IDLE. For future use.

To view task details:

Click Applications > Business Availability Center for Siebel > Tasks to open
the Task Diagnostics Tool page.

You can also access this page filtered for the selected CI, when you right-
click the CI and select the Show Tasks in Error or Show Running Tasks
option. For details, see “List of Menu Options” in Using Dashboard.

From the Enterprise box, select the Siebel site for which you want to view
task data.

From the Status box, select the specific status—Running, Paused, Stopping,
Completed, Exited with Error, or Killed. Alternatively, you can select to view
tasks of all statuses.

If you want to focus on the tasks of a specific user, fill in his name in the
User box.

If necessary, click the Advanced Filter link to filter the list of tasks. For
details, see “Using the Advanced Filter” on page 302.

Click the Apply button. The task information you requested is retrieved
from the Siebel Application Server(s) and displayed on the Tasks Diagnostic
Tool page.
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Note the following:

» To sort the tasks by a specific column, click the column heading.

ﬂ ﬂ ﬂ ﬂ To move between pages, use the First, Previous, Next, and Last arrows above

the table.

Using the Advanced Filter

302

Use the advanced filter to filter the list of tasks you want to display.

To use the Advanced Filter:

In the Task Diagnostics Tool page, click the Advanced Filter link to open the
Tasks Diagnostics Tool Advanced Filter page.

Server:

Cormmponent Group:! I-F\II COMPOnent Qroups- ;I
Camponent: I-F\II COMponents- ;I
Uzing SiteScope: IADIDF\S ,I

OK| Cancel | Help |

Select, in the Server list, the specific server whose task data you want to
view.

Select the specific component group for which you want to view task data in
the Component group list.

Select, in the Component list, the specific component for which you want
to view task data.

Select, in the Using SiteScope list, the SiteScope machine you want to use to
retrieve task data from the Siebel Application Server, if you do not want
Business Availability Center for Siebel to use the default SiteScope machine.

Click OK to save the filter settings and close the Advanced Filter dialog box.
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Using the Process Diagnostic Tool

The Siebel process diagnostic tool enables you to view details of the Siebel
Application Server processes, for each monitored Siebel Enterprise.

This chapter describes: On page:
Viewing Process Details 303
Using the Advanced Filter 306

Viewing Process Details

Using SiteScope, you can retrieve details of the Siebel Application Server
processes that are running, or were run, on each Siebel Enterprise. You can
view the details of all processes, regardless of status, or you can view only
the processes with a specific status. Similarly, you can choose to view process
details for all components in all component groups on all Siebel Application
Servers, or for specific components in specific component groups on specific
Siebel Application Servers.

When an application has performance/availability issues, you may use the
process diagnostics to verify that all Siebel processes are up and running and
that none of the processes is using 100% CPU.
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304

The tool filters processes by site, application server, component group,
component, process type, and process id.

Erterprize! Isiebel vl Server: I—AII servers- vI Cormnponent group! I-AII Companent groups- ;I
Advanced Options: Siebel Commponent: -All cormponents-, Process Tepe: -All process types-, Using SiteScope: catapultl Ap

You enter the process input information: Siebel Enterprise name,
application server name, and component group in the Process Diagnostics
page. The report returns, a list of processes with information about their
memory usage and the CPU consumption columns.

To view a Siebel process diagnostics:

Click Applications > Business Availability Center for Siebel > Process to open
the Siebel Process Diagnostics page.

You can also access this page filtered for the selected CI, when you right-
click the CI and select the Show Processes option. For details, see “List of
Menu Options”.

In the Enterprises list, select the name of the Siebel Enterprise.

3 In the Server list, select the name of the application server. Select All servers

if you want to display the process diagnostics for all of the application
servers.

In the Component Group list, select the name of the component groups.
Select All component groups if you want to display the process diagnostics
for all of the component groups.

If necessary, click Advanced Options to open the Process Diagnostics Tool -
Advanced Filter page. For details, see “Using the Advanced Filter” on
page 306.

Click Apply to display the process diagnostic information. The process
information you requested is retrieved from the Siebel Application Server(s)
and displayed on the Tasks Diagnostic Tool page.
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Note the following:

To sort the processes by a specific column, click the column heading.

To move between pages, use the First, Previous, Next, and Last arrows
above the table.

The processes detailed information is as follows:

Site: Icannon;l Server: I-AII seruers-;l Component group: I-Allcomponent groups-;l
Advanced Options: Using sitescope: rca3 Apply |
b= el
Sl
Server Component group Component + Process Type Process ID CPU(a) Memory (KB}
cannon TxnRoute siebprac 2996 o 2188
Cannon TxnMerge siebproc 2980 (1} 2008
cannon SynchMgr siebmtsh 2972 ] 2396
cannon Systern SRProc siebrntsh 2112 0 2504
cannon System SREBroker siebmtsh 3052 ] 1844

» Server. The name of the server on which the process runs.

» Component Group. The name of the component group. If the process does

not have a task attached, then the Component Group column is empty.

Component. The name of the component. If the process does not have a
task attached, then the Component column is empty.

Process Type. The name of the operating system process that deals with the
Siebel process.

» Process ID. The process identifier.

» CPU (%). The percentage of the host machine CPU that the relevant process

instance is currently using.

Memory (KB). The amount of memory (in KB) that the relevant process
instance is currently using.
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Using the Advanced Filter
Use the advanced filter to filter the list of processes you want to display.

To use the Advanced Filter:

1 In the Process Diagnostics Tool page, click the Advanced Filter link to open
the Process Diagnostics Tool - Advanced Filter page.

Siebel Component:

=4l components-
Process Type: I-AII process types- 'I
Process Id: I

Uszing SiteScope: IADIDAS 'I

2 Select the Siebel component in the Siebel Components list. Select All
components if you want to display the process diagnostics for all of the
Siebel components.

3 Select the process type in the Process Type list. Select All process types if you
want to display the process diagnostics for all of the process types.

4 In the Process Id box, enter the process Id.

5 In the Using SiteScope list, select the SiteScope that will be used for
retrieving the processes' information.

6 Click OK to close the Advanced Filter page.
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Working With Deep Transaction Tracing

This chapter describes the Deep Transaction Tracing data available in
Dashboard. Deep Transaction Tracing provides a monitoring layer for
collecting information about the behavior of transactions within the target

machine.
This chapter describes: On page:
Introducing Deep Transaction Tracing Monitor 309
Viewing Deep Transaction Tracing Information in Dashboard 310
Deep Transaction Tracing Reports 313

Introducing Deep Transaction Tracing Monitor

Deep Transaction Tracing enables component level breakdown for your
Business Process Monitor transactions. This is achieved through integration
with Bristol’s TransactionVision application, to provide an additional level
of business process monitoring in Mercury Business Availability Center.
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TransactionVision technology enables monitoring of a transaction at the
component level within a target machine. As the transaction flows through
the target machine via CICS, JMS, EJBs, servlets, and WebSphere MQ,
TransactionVision tracks and analyzes the interaction with each
component.

TransactionVision sends the data on the transaction’s path through the
monitored components to Mercury Business Availability Center; in Mercury
Business Availability Center, the received data is mapped to a Deep
Transaction Tracing monitor that is correlated with the appropriate Business
Process Monitor transaction. In Dashboard, you can then see availability
and performance information for the transaction within the target machine,
and you can open breakdown reports for the transaction at component
level.

For information on setting up the integration with TransactionVision, see
“Administering Deep Transaction Tracing” in Application Administration.

Viewing Deep Transaction Tracing Information in
Dashboard

310

You can view Deep Transaction Tracing information for transactions in
Dashboard in the Deep Transaction Tracing View.

Note: The Deep Transaction Tracing View is added to the Views list in View
Explorer once the Deep Transaction Tracing package is installed. If the view
is not in the Views list, contact your administrator.
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The Deep Transaction Tracing View is displayed like any other view in
Dashboard. The view contains all Business Process CI types (such as Business
Process Group, Business Process Step, Business Process Transaction from
Location), and in addition contains all Deep Transaction Tracing Monitor
Cls. Its structure is as follows:

Wiew! |Deep Transaction Tracing J

1
=] ..: Deep Transaction Tracing Wiew
5 bprn_prf2

£3 @ locl
¥ @ locz
B &3 tu_prfl
+ @ Checkout
B O - Business Process Step
%35& Login -#4——————— Deep Transaction Tracing Monitor
= Login fram locl -.———  BPM Transaction from Location
= Login from locz 44— BPM Transaction from Location
+ @ Shopping
+ @ Subrmitorder

The Deep Transaction Tracing Monitor Cls in the view are dynamically
created by a Dynamic Node Factory, based on the incoming samples from
TransactionVision. Each Deep Transaction Tracing Monitor CI is given the
same name as the Business Process Monitor transaction it relates to, and is
added to the hierarchy under the relevant Business Process Step CI, using its
own icon.
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312

Under the Business Process Step, you can see information on both the
emulated user experience (as shown for the BPM Transaction from Location
CIs) and on how the transaction behaved in the target server (as shown for
the Deep Transaction Tracing Monitor CI).

Performance (L #7  Awvailability @4° DT Total Impact DT Failed Impact DT Late Impact
CI Name Performance Awvailability DT Total Impact DT Failed Impact DT Late Impact
& ~ ™ .
& Login ¥ o2 [ B $0 $0 0
= Login from locl + i - L
= Lagin from locz + Q+2 Qs+

The KPIs for the Deep Transaction Tracing Monitor are:

Performance. Displays information on the performance of the components
within the target machine. The displayed status is calculated by the
TransactionVision application. The status is calculated in Mercury Business
Availability Center based on a value and threshold provided by
TransactionVision.

Availability. Displays information on availability of the components within
the target machine. The displayed status is based on the objective values
defined in Mercury Business Availability Center.

DT Total Impact. Displays information on total financial loss for the
organization. This value is calculated by adding the values of the DT Late
Impact and the DT Failed Impact KPIs. Status is based on the objective value
defined in Mercury Business Availability Center (default threshold = $100).

DT Failed Impact. Displays information on financial loss due to failure of
the transaction within the target machine. Status is based on the objective
value defined in Mercury Business Availability Center (default threshold =
$100).

DT Late Impact. Displays information on financial loss due to failure to
complete the transaction within a time limit set in the TransactionVision
application. Status is based on the objective value defined in Mercury
Business Availability Center (default threshold = $100).
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Deep Transaction Tracing Reports

From the Deep Transaction Tracing view, you can access reports in the
TransactionVision application that provide you with breakdown
information for the transaction at component level.

The reports are opened from the menu options for a Deep Transaction
Tracing Monitor CI in the Console and Filters tabs: Select Deep Transaction
Tracing Reports, then select the required report type from the displayed list.
TransactionVision opens in a new browser dialog box, displaying the
selected report for the relevant transaction.

In order for Mercury Business Availability Center to open the reports, you
must configure the URL to point to the TransactionVision machine, and the
required user name and password. For more information, see “Configuring
Parameters to Open the TransactionVision Reports” in Application
Administration.

Note: Your Web browser should be set to accept all cookies when working
with Mercury Business Availability Center. If this is not done, you may
encounter problems when drilling down to the Bristol TransactionVision
reports.

This section includes the following topics:

» “Tracking Report” on page 313
» “Service Level Report” on page 315

> “Component Topology Report” on page 316

Tracking Report

The Tracking Report menu option opens the Transaction Tracking Report,
which lists information for every instance (run) of the Business Process
Monitor transaction over a specified time period. The displayed information
includes start time, response time, and the result of the run.

313



Chapter 25  Working With Deep Transaction Tracing

To see more detailed breakdown of behavior on the target machine for a run
of the transaction, click the Tx Class link to drill down to the Transaction
Details report; from there, click an event link to drill down to an event
details report.

» Transaction Tracking Report- {Show Form) Project: TEST

Transaction Tracking Report
(17513 transactions, showing 1-20)

Label BpmTransaction BEpmScript ¥alue|

T= . . Response Completion Result
Class SEGE UG Time State State

Login 01/26/2006 09:45:23.038 Completed  Success Lagin WwebSphere -
Login 01/26/2006 09:46:23.866 0.02 Completed Success Login WwebSphere -
Login 01/26/2006 09:47:23,957 0.03 Completed Success Login webSphere -
Login 01/26/2006 09:48:21.957 0.02 Completed Success Lagin WwebSphere -
Login 01/26/2006 09:49:19.832 0.02 Completed Success Login WwebSphere -
Login 01/26/2006 09:50:20.191 0.02 Completed  Success Login webSphere -
Login 01/26/2006 09:51:20.582 0.02 Completed Success Lagin WwebSphere -
Login 01/26/2006 09:52:21.,159 0.02 Completed Success Login WwebSphere -
Login 01/26/2006 09:53:21 487 0.02 Completed  Success Login webSphere -
Login 01/26/2006 09:54:21.346 0.02 Completed Success Lagin WwebSphere -
Login 01/26/2006 09:55:21.549 0.03 Completed Success Login WwebSphere -
Login 01/26/2006 09:56:22.628 0.00 Completed  Success Login webSphere -
Login 01/26/2006 09:57:22.719 0.02 Completed Success Lagin WwebSphere -
Login 01/26/2006 09:58:23.423 0.02 Completed Success Login WwebSphere -
Login 01/26/2006 09:59:235.5844 0.02 Completed  Success Login webSphere -
Login 01/26/2006 10:00:21.173 0.00 Completed Success Lagin WwebSphere -
Login 01/26/2006 10:01:21.173 0.02 Completed Success Login WwebSphere -
Login 01/26/2006 10:02:22.594 0.02 Completed  Success Login webSphere -
Login 01/26/2006 10:03:25.972 0.02 Completed Success Lagin WwebSphere -
Login 01/26/2006 10:04:20,379 0.02 Completed Success Login WwebSphere -

Go to |Jage:|1 'l Mext Mext 10 Last Page

For more detailed information on the report and on how to set viewing
options, refer to the TransactionVision documentation, available from the
Help menu in the TransactionVision application.
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Service Level Report

The Service Level Report menu option opens the Service Level Analysis
report, which provides a graphical view of response time for the transaction
over time. The displayed information includes average response time,
maximum response time, and transaction volume over each reporting time
period.

Service Level Analysis

Response Time (sec)

6

A

Transaction Volume

Moy Mov Now Now Nov Mov Mov Dec’ Dec’ Dec Dec’ Dec Dec’ Dec Dec Dec Dec Jan Jan Jan Jan Jan Jan Jan Jan Jan Jan Jan Feb Feb Feb
13 16 19 22 25 26 30 03 06 089 12 15 18 21 23 26 29 01 04 O7 10 13 15 18 21 24 27 30 02 05 O7

- A

For more detailed information on the report and on how to set viewing
options, refer to the TransactionVision documentation, available from the
Help menu in the TransactionVision application.
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Note: You need Adobe SVG Viewer 3 installed on your local machine to see
the Service Level Analysis report. Download from the Adobe Web site
http://www.adobe.com/svg/viewer/install/main.html.

Component Topology Report

The Component Topology menu option opens the RTM report, which
displays a top view map for the flow of information across components in
the target machine, over a specified time period. The report shows activity
for all components on the machine during the time period, not for any
individual transaction. The report also displays statistics on the interaction
between components (for example, failed, late, and total counts for events).
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For more detailed information on the report and on how to set viewing
options, refer to the TransactionVision documentation, available from the
Help menu in the TransactionVision application.
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Using the Mercury Business Availability

Center for SOA Solution

You can monitor your SOA environment and view that data in dedicated
views and reports using some of the Mercury Business Availability Center

components to collect the monitoring metrics.

This chapter describes: On page:
Mercury Business Availability Center for SOA Solution Architecture 321
Mercury Business Availability Center for SOA Views and Reports 324
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Mercury Business Availability Center for SOA Solution
Architecture

SOA data is collected by different Mercury Business Availability Center

components:
Diagnostics Web services Mercury
monitor SiteScope
E — — Diggnostics monitoring— — — - ‘J::;Jnier\;\-;ﬁii::;_ _ _-.ﬁ
\ Mercury
\ Discovery Business Process
Probe g - _ T Monitor
\ _Tapotody™ "53cting,

Mercury Business Availability Center
SOA solution

Most of the SOA CIs and their relationships are created by automatic
discovery. The configuration for those CIs is saved into the CMDB.
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The architecture of the Mercury Business Availability Center for SOA
solution includes the following components:

The Discovery packages are used by the Discovery Probe to discover,
identify, and map the SOA-based applications in your system, starting from
the UDDI registry, and from Web services deployed on top of IBM
Websphere, BEA WebLogic, and IIS (Internet Information Services). This
information is then used to create SOA-related Cls and other ClIs in the
CMDB. It also creates the hierarchy of CIs displayed in the SOA UDDI
Registry, the SOA Web Services, the SOA Rogue Services, and other views. A
rogue service is a service which is not registered in the UDDI registry.

If you selected to work with shared CMDB, the Discovery Probe also
communicates with Mercury Application Mapping. In such a case, Mercury
Application Mapping and Mercury Business Availability Center share a
CMDB. Mercury Application Mapping server collects information on
changes made to CI's properties (changes of the SOA infrastructure: hosts,
application servers, and so forth.) and functional changes of the web
services (changes to WSDL; for example if a new parameter or a new
operation were added or if an operation was removed). This information is
stored in the History database, and is available in the SOA-related views in
Mercury Business Availability Center. For details about shared CMDB, see
“Sharing the Mercury Universal CMDB Environment” in Working with the CMDB. For
details about the History database, refer to Mercury Application Mapping
documentation. For details about the change feature, see “Viewing Changes
Made to SOA CIs” on page 334.

Mercury Business Process Monitor collects data on the performance and
availability of the Web services by running transactions that run Web
services scripts. The Cls and relationships for the incoming Business Process
Monitor samples are created by the Business Process Monitoring source
adapter (described in “Business Process Monitoring” in Source Manager
Administration). This information is not supported in SOA reports; it is
available in the SOA views.
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» The Diagnostics Monitor monitors real user traffic to the Web services and

operations and sends it to the Diagnostics server, that processes and stores
it. The CIs and relationships for the incoming Diagnostics samples are
created by the Diagnostics source adapter (described in “Diagnostics” in
Source Manager Administration). Diagnostics data is available in the SOA
reports when you select the Real Data parameter. For details, see “Real Data
or Synthetic Data” on page 341.

Mercury SiteScope monitors the Web services and retrieves Web services
metrics and UDDI server health data. The CIs and relationships for the
incoming SiteScope samples are created by the SiteScope source adapter
(described in “SiteScope” in Source Manager Administration). SiteScope data is
available in the SOA reports when you select the Synthetic parameter. For
details, see “Real Data or Synthetic Data” on page 341.

Mercury Business Availability Center is used as the central console for
viewing all of the data and performing analysis actions.

Mercury Business Availability Center for SOA Views and

Reports

324

The SOA views present Web services performance, availability, and
throughput (load on the Web service) information collected by SiteScope
and Diagnostics monitors, about monitoring traffic to selected Web services,
operations, or servers. The data enables you to analyze the detected
performance issues, and helps you to identify the cause of delays. For
details, see Chapter 27, “SOA Views in Dashboard.” In addition, the views
display information about the system status impacting the Web service (see
more details below) and also changes indications (see above).

If the Web service is discovered on an application server (WebLogic,
WebSphere or 1IS) the Web service has a relationship with its host (the host
is a child of the Web service; if you monitor the host CPU for example, it has
a System KPI that propagates to the Web service). This help to triage Web
service problems, when the Web service has a performance/availability
problem due to a system issue.
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From the views you can drill down to the Mercury Business Availability
Center for SOA reports that present detailed information about the
performance, availability, and throughput over time, as well as the total
number of calls, the number of calls that are slow or end with a SOAP fault,
the least available Web services/operations, the slowest Web
services/operations, consumer information, and server information, and so
forth. For details, see Chapter 28, “Mercury Business Availability Center for
SOA Reports.”

The SOA reports can be used for problem isolation, Web service trending
and comparison, and for summary reports. For details, see Chapter28,
“Mercury Business Availability Center for SOA Reports.”
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SOA Views in Dashboard

Mercury Business Availability Center for SOA displays information about the
performance, availability, and throughput of the UDDI registry, Web
services, operations, SiteScope monitors, SiteScope Web services monitors,
and nested WSDL in the SOA UDDI, the SOA Web Services, and other views.

This chapter describes: On page:
About SOA Views in Dashboard 327
SOA Web Services View 329
SOA Rogue Services View 330
SOA UDDI View 331
Viewing Configuration File CI Details 333
Viewing Changes Made to SOA CIs 334
ClIs Discovered by the Discovery Process 334

About SOA Views in Dashboard

The data displayed in the SOA views enables you to analyze the detected
performance issues, and helps you to identify the cause of delays.

The hierarchical structure for each SOA view is determined by the TQL for
the view (described in “Working with Pattern Views” in View Manager
Administration).
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328

The SOA-related views are:

> “SOA Web Services View” on page 329
> “SOA Rogue Services View” on page 330
> “SOA UDDI View” on page 331

The SOA UDDI view includes the UDDI registries and all the Web services
that were discovered from the UDDI registries. It also includes their
operations and WSDL. The Web service providers (represented by the
business unit) are also discovered and linked to their respective Web
services.

Web services that were discovered from application servers like IIS,
Websphere, or WebLogic are available in the respective topology view (IIS,
Websphere, WebLogic Topology views). In such case, the Web service is
linked to the hosts on which it is deployed.

The same Web services might also be deployed on an application server (IIS,
Websphere, WebLogic) and can also be discovered from there. They are
represented by a single CI (as they have the sample key attributes) and are
included in the SOA UDDI View and also in the relevant application server
view.

Web services that are not registered in the UDDI registry do not appear in
the SOA UDDI View, but appear in the SOA Web Services View.

For information about the CIs and KPIs that are SOA-related, see “ClIs
Discovered by the Discovery Process”.

From the SOA views you can:

drill down to the Mercury Business Availability Center for SOA reports that
present detailed metrics information about the Web services, operations,
servers, or consumers. For details about the SOA reports, see Chapter 28,
“Mercury Business Availability Center for SOA Reports.”

use the right-click menu to access additional information; for example to
access the Mercury Diagnostics application. For details, see Chapter 2,
“Dashboard Menu Options.”
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» access User reports. User reports provide a list of all of the defined custom
reports, trend reports, and custom links that have been defined in the
system, that the current user has permissions to view. You can display the
reports in Excel format, create custom reports, and trend reports, and so
forth. For details, see “User Reports” on page 337.

SOA Web Services View

The SOA Web Services view includes all of the web services that were
discovered and stored in the CMDB. For details about the discoveries, see
Discovery Manager Administration.

The TQL for the view is built as follows:

4 3 3]

»
UDDI Registry Websphere J2EE Domain

. \ Cm’%ins ‘/
onitore Y f
Contains -";J;,'r Cortaing
"'. ) Caontainer link
H Depends On  WebService-. -
System Monitor Contaither link o
¥ Y

= J g

Host Configuration File WebService OperatioRepends On
lMonitored By Monitored By

o Contaiter link :
1

d o L4

System Monitor . 14 Business Process Step
| |
P 504 lMUnitnred By

System Monitor SOA Maonitor 1

"

ELIM Monitor

For details about the CIs displayed in this view, see “Cls Discovered by the
Discovery Process” on page 334.
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SOA Rogue Services View

330

The SOA Rogue Services view includes all of the web services that were
discovered and stored in the CMDB and that are not registered in the UDDI
registry. They also appear in the SOA Web Services View.

For details about the discoveries, see Discovery Manager Administration.

The TQL for the view is built as follows:
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SOA UDDI View

The SOA UDDI view represents information obtained by running the UDDI
discovery. The SOA UDDI view includes the UDDI registries and all the Web
services that were discovered from the UDDI registries. It also includes their
operations and WSDL. The Web service providers (represented by the
business unit) are also discovered and related to their respective Web
services. The business unit level represents the service provider.

The SOA UDDI View generally contains the following hierarchical structure:

Uddi Wiew

http:/fysayers2-il: 8080/ uddifinquiry -—— UDDI Registry
+ (@, 4 UDDI Node

+ .i. Account Services
+ Cuztorner Management Systerm
+ Cocurnent Services
HF: -4—— Business Unit
IT

mErcury

Cutlet Locator

+
B E--m m--E E--m --m m-m E--n
B E--E E--8 E--m B--B E--m E--

O &

Transaction Services

= ﬁ MonetaryTransactionService «——— Web Service
’ http:/fysayers2-il.mercury.co.il: 8080/ uddifdoc/dermos/bso/ManetaryTransaction, wsdl

i postTranzaction -qi Configuration File
Web Service Operation
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The TQL for the view is built as follows:

g
DDl Registry

lCnntains

Container link Weh SEWiC‘?\ Container link

Vs Y
¥ M
S J

Web Senvice Operation Configuration File

Note: Nested WSDL files are mapped to the Configuration File CIs. For
details, see “Viewing Configuration File CI Details” on page 333.

For details about the ClIs displayed in this view, see “Cls Discovered by the
Discovery Process” on page 334.
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Viewing Configuration File Cl Details

Right-click a Configuration File CI in the SOA UDDI View and select the
Show Content option to display the contents of the configuration file.

The configuration file displays the contents of the WSDL page
corresponding to the URL.

<7uml version="1.0" encoding="UTF-5"?»
<1-- edited with XMLSpy w2005 U (hetp:ffwww wmlspy.com] by mrkef (mrkef) --=
<wsdlidefinitions smins:impl="http: /fcompany.comfaccountsucfaccount”
amins:intf="http:ffcompany.comfaccountsucfaccount" sminsiwsdl="http: ffschemas.umlsoap.orgfwsdl™
aminsiwsdlsoap="http:fschemas.umlsoap.argfwsdlfsoaps"
aminsinsd="http:/fwww w3 org/2001/5MLSchema" umins: hittp="http: /fschemas.amlzoap.orgfwsdlhtp™
amins:mime="http:/fschemas.amlzoap.orgfwsdlmime"
targetMamespace="http:/fcompany.comfaccountsvefaccount"=
<wsdlitypes>
<schema elementFarmDefault="qualified"
targetMamespace="http:/fcompany.comfaccountsvefaccount”
amins="http:/fwww w3 org/ 2001/ 5MLSchema">
<element name="getAccount"=
<complesType=
<sequencef=
<fcomplexType=
=felement=
<element name="getAccountResponse">
<complesType=
<sequencef=

Nested WSDL appear in View Explorer as a list of Configuration File Cls
under the main Configuration File CI. For example:

http://<server_name>/uddi/doc/wsdl/account.wsdl
http://<server_name>/uddi/doc/wsdl/account_binding.wsdl
http://<server_name>/uddi/doc/wsdl/account_portType.wsdl

333



Chapter 27 » SOA Views in Dashboard

Viewing Changes Made to SOA Cis

Changes made to the properties of all types of CIs (changes of the SOA
infrastructure: hosts, application servers, and so forth) and functional
changes of the web services (changes to WSDL; for example if a new
parameter or a new operation were added or if an operation was removed)
are discovered by different types of discoveries. Those changes are displayed
in the Change report available as a right-click menu option for each one of
the relevant CI types. For details about the Change report, see “Change
Report” on page 191. For details about the UDDI Registry, WebSphere,
WebLogic, and IIS discoveries, see Discovery Manager Administration.

CIs Discovered by the Discovery Process

334

The following Cls are discovered by the SOA discovery processes. For details,

n o u

see “Performing a UDDI Discovery”, “Performing a WebLogic Discovery”, or
“Performing a WebSphere Discovery” in Discovery Manager Administration.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration.

The CIs are:

UDDI Registry. The UDDI Registry CI represents all of the UDDI registries
that were discovered in your network.

Business Unit. The Business Unit CI represents the service providers
discovered in your network.

Web Service Monitor. The Web Service Monitor CI represents the Web
services monitors discovered in your network.

Web Services. The Web Services CI represents the Web services discovered in
your network.

Web Service Operation. The Web Service Operation Cls represent the
operations discovered in your network.\

Configuration File. The Configuration File ClIs represent the URL of the
WSDL page used by the Web service.
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Mercury Business Availability Center for
SOA Reports

The Mercury Business Availability Center for SOA reports enable you to
proactively monitor the availability, response time, throughput, number of
calls, number of SOAP faults, and number of slow calls, to selected Web
service(s) or operation(s), by selected consumer or server.

This chapter describes: On page:
Overview of SOA Reports 335
SOA Reports 336
Filtering Using the Active Filter 338
Real Data or Synthetic Data 341
Limitations 342
Customizing the SOA Reports 342

Overview of SOA Reports

You use the SOA reports to view and analyze the health of access to Web
service(s) or operation(s).

For details on working with Mercury Business Availability Center reports, see
“Working in Reports” in Working with Applications.
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Report Access and Permissions

The availability of report data for a specific user is dependent on the profile
access permissions granted that user. Furthermore, access to specific data
within a profile can also be limited by the administrator using report filters.
For details on granting permissions, see “Configuring User Permissions” in
Platform Administration.

For details on setting report filters, see “Configuring Report Filters Globally”
in Platform Administration and “Report Filters” in Application Administration.

In addition, the SOA reports permissions is based on the views permissions.
An SOA report (except for the Top Metrics Report) is dependent on the
selected view. The user is able to display only views for which he has
permissions.

Only views that are assigned to SOA are available in the SOA reports. A view
can be assigned to SOA in the view properties. For details, see “Defining
View Properties” in View Manager Administration. By default, views created in
the SOA folder are assigned to SOA.

SOA Reports

336

The Mercury Business Availability Center for SOA application includes the
Business Availability Center for SOA reports and the User reports.

This section includes the following topics:

> “Business Availability Center for SOA Reports” on page 337
» “User Reports” on page 337
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Business Availability Center for SOA Reports
The Business Availability Center for SOA tab includes the following reports:

Health Report. Displays health metrics for the selected Web service(s),
operation(s), server, or consumer in a selected view. For details, see “Health
Reports” on page 343.

Top Metrics Report. Displays top metrics information about the traffic to
and from all of the monitored Web services or operations. For details, see
“Top Metrics Report” on page 355.

Metrics Over Time Report. Displays the performance over time of the
selected metric, over time, measuring access to selected Web services or
operations, by a server and/or consumer in a selected view. For details, see
“Metrics Over Time Reports” on page 373.

Consumer Summary Report. Displays a drillable summary of the metrics for
all of the consumers accessing the selected Web services or operations in a
selected view. For details, see “Consumer Summary Reports” on page 379.

Server Summary Report. Displays a drillable summary of the metrics for all
of the servers on which the selected Web services or operations of a selected
view are running. For details, see “Server Summary Reports” on page 385.

The data displayed in some of the reports is obtained from the Diagnostics,
or SiteScope monitors.

User Reports

User reports is a feature common to the Mercury Business Availability
Center applications. You configure and view user reports from the User
Reports tab.

For complete details on creating, viewing, and administering user reports,
see “Configuring and Viewing User Reports” in Working with Applications.
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Filtering Using the Active Filter

338

You can filter SOA reports using the Active Filters. The Active Filters have
two tabs: Web Services/Operations and Servers/Consumers. You can filter by
Web services, operations, server, or consumer. You can also select items from
both tabs to create more complex filters.

The first twenty consumers that invoke a Web service/operation that is
monitored by Diagnostics are registered in Diagnostics. The SOA reports
display their specific data separately. Any additional consumer’s data is
aggregated and displayed in the SOA reports under the Other IPs label.
Other IPs aggregates the data as follows: Availability and Response Time are
calculated as the average value of the Availability and Response Time of all
of the non-registered consumers, while Throughput, # of Calls, # of Slow
Calls, and # SOAP Faults are summarized. You can override the registered
consumers in Diagnostics. You can also modify the number of supported
consumers in Diagnostics. For details, see Mercury Diagnostics Installation and
Configuration Guide.

A server IP is equivalent to a Diagnostics probe. The SOA reports display the
server IP specific data separately for as many server IPs as there are probes.
For example, if there a 100 probes (server IPs) running a Web
service/operation, data can be displayed separately for each one of them in
the SOA reports.

This section includes the following topics:

> “Filtering by Web Services/Operations(s)” on page 339

» “Filtering by Server or Consumer” on page 340
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Filtering by Web Services/Operations(s)

You can filter the SOA reports by Web services or operations.

To filter by Web Services/Operations:

1 Click Configuration Items to open the Configuration Items Filter dialog box.

Web Services /Operations Servers,/Consumers

Selected CIs: (% web Services {7 Operations

Browse|Search

View: |Son Web Services J

S| S 504 Web Serices

= http:fflabrmzbac0z 2020/ uddifinguiry
- httpiffysayers2-il: 2080/ uddifinguiry
S&f Stock Quotes

[EZEz |

<g1' TestService

[#

4 TraderService

*

Fr | | B8
| | WO

[1]4 | Cancel | Help |

2 Click the Web Services/Operations tab.
3 In Selected Cls, select one of the following:

» Web Services. Displays a check box only for the Web services CIs
appearing in the view.

» Operations. Displays a check box only for the operation ClIs appearing in
the view.

You can select up to 20 Web services or operations. This number can be
modified in the Infrastructure Settings. For details, see “Customizing the
Number of Web Services or Operations That Can Be Displayed in the SOA
Reports” in Application Administration.
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340

Click Search when you want to search for a specific Cl in the current view or
in all views. For details, see “Using the Search Tool” in Working with the
CMDB.

In the View list, select the appropriate view. Only views for which the user
has permission and that have been assigned to SOA are displayed in the list.
For additional information on the available views, see For additional
information, see “Filtering Data Using Active Filters” in Working with
Applications.

5 Select the relevant CI(s).

6 Click OK to save the selection.

Filtering by Server or Consumer

You can select a specific server or consumer IP to filter SOA reports.

To filter by server or consumer:

In the Active Filters dialog box, click the Servers/Consumers tab.

Web Services /Operations Server/Consumer
“rou can filter by zerver, consumer, or both,

Filter by Server:

Server IP: I
Filter by Consurner:

% Registered consurner IP: I

{" Mon-registered consumer IPs

oK Cancel Help
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2 In the Server IP box, enter the server IP number, if you want to display
information about the Web services/operations working on the specific
server.

3 In Filter Consumer By, select one of the following:

> In the Registered consumer IP box, enter the consumer IP number if you
want to display information about the specific consumer. The consumer
should be one of the consumers registered in Mercury Diagnostics. This is
the default. For details, see Mercury Diagnostics Installation and
Configuration Guide.

» Select Non-registered consumer IPs, to display information about the
consumers that are not registered in Mercury Diagnostics. For details, see
Mercury Diagnostics Installation and Configuration Guide.

Note: If you select the Registered consumer IP without entering an IP value
in the box, then the filter includes all consumers.

4 Click OK to save the selection.

Real Data or Synthetic Data

You can select to display, in the SOA reports, data from the Diagnostics data
collector or from SiteScope monitors.

When you generate an SOA report, the Data Type selection is displayed in
the top part of the report.

I Data Type: (8 Real {0 Synthetic |

Select one of the following:

> Real. To display data that is based on Diagnostics.
> Synthetic. To display data that is based on SiteScope.
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Limitations

The SOA reports reflect the relative view of the user. Therefore, if in a
customized view, specific operations are attached to a Web service, the SOA
reports based on the view display information related only to the Web
service and the selected operations. Other operations connected to the Web
service in the CMDB are not displayed.

If the monitors attached to the operations are not added to the customized
view, the SOA reports display information that does not take into
consideration the thresholds defined in the monitors.

Customizing the SOA Reports

342

You can customize the SOA reports as follows:

print the report, send it by e-mail, or save it in PDF or Excel format. For
details, see “Sharing and Storing Reports” in Working with Applications.

add a header and a footer, automatically or manually generate the report,
and/or customize other display elements. For details, see “Customizing
Reports” in Platform Administration.

You can also schedule when to run the report. For details, see “Scheduling
User Reports or the Performance Update Report” in Platform Administration.
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Health Reports

The Health Report displays health metrics for the selected Web service(s),
operation(s), server, or consumer in a selected view.

This chapter describes: On page:
Accessing SOA Health Reports 344
Understanding Health Reports 345
The Health Summary Area 347
The Metrics Area 349
The SOAP Faults Area 351
Drilling Down to Other Reports 353
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Accessing SOA Health Reports

You can access the SOA Health reports from different locations in
Dashboard.

To access SOA Health reports from Dashboard:
To open the SOA Health page, you can:

» select Applications > Dashboard, select a view in View Explorer, right-click a
specific Web Service or Operation CI in View Explorer, and select the Go to
Report > Health Report option. In such a case, the Health Report is
displayed filtered by the specific Web service or operation.

» select Applications > Dashboard, select the Console, or Filters tab, select the
appropriate view in View Explorer, right-click a specific Web Service or
Operation CI in the right pane of Dashboard, and select Go to Report >
Health Report. In such a case, the Health Report is displayed filtered by the
specific Web service or operation.

To access SOA Health reports from the Mercury Business Availability Center
for SOA application:

1 Select Applications > Business Availability Center for SOA, and select the
Health Report option in the Business Availability Center for SOA tab.

2 In the View list, select the time frame of the report. For details, see
“Choosing the Tracking Range and Granularity” in Working with
Applications.

3 If relevant, click Active Filters to select the appropriate conditions for the
report. For details, see “Filtering Using the Active Filter” and “Filtering by
Server or Consumer” on page 340.

4 Select Real or Synthetic data. For details, see “Real Data or Synthetic Data”
on page 341.

5 Click Generate to generate the report.

6 Click the View as Graph tab to display the Health Report in graph format, or
click the View as Table tab to display the Health Report in table format.
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Understanding Health Reports

Health reports display the Availability, Response Time (sec.), Throughput, #
of Calls, # of SOAP Faults, and # of Slow Calls metrics for the selected Web
services, operations, server, and/or consumer, in a selected view.

You can drill down to different levels of the report to get more health
information about the item you selected. The levels are:

> Health Report. The report displays health information for the selected Web
services.

» Web Service Health. The report displays health information for the selected
Web service and its operations.

» Operation Health. The report displays health information for the selected
operation(s) and the servers on which the operations are running.

» Server. The report displays health information for the selected server.
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Navigation in the Health Report is as follows:

Health
Report
Lavel

Web
Service
Level

Health Report

Salact multipla
Web services ¥

Salact one
Web service

Health Summary for
Web services

Salact one

Web service Y

Health Summary for
salected Web service and its
operations + Metrics
+ SOAP Fault info

for Web service
Salact one
ticin
opera v
Health Summary for
Operation selected operation(s) and
Health their servers + Metrics
Lewval + SOAP Fault info
for cperations
Sslact one
y senver
Health Summary for
a‘::i[er: selected server + Metrics
Level + SOAP Fault info

for server

Select one
or multiple
operations

Note: The Metrics and SOAP Faults areas are not displayed if you select more
than one Web service. Click the appropriate Web service in the Health
Summary area to display the Metrics and SOAP Faults area for the Web
service at the Web Service Health report level.

For information on customizing the Health reports, or adding the Health
report to a custom report, see “Customizing the SOA Reports” on page 342.



The Health Summary Area

The Health Report includes the Health Summary area. It can display:

Chapter 29 ¢ Health Reports

> A list of same level items (Web services, operations, servers). In the following
example, the Health report displays only the Health Summary. To display

other metrics information, click on the required item.

Health Sumrmary

Service = ility (%0) P Time (5ec.)  Throughput +# of Calls # of SOAP Faults  # of Slow Calls
AddrBook 100,00 0.50 0.70 1,008 0 o & % | P
Account SoapService 0,00 0,00 0.20 238 238 o & % | P

> A tree (Web service/Operations, Operation/Servers). In the following

example, the Health report also displays other metrics for the first item in
the tree (for example, if the tree is a Web service/Operations tree, the other

metrics are displayed for the Web service).

Health Surmmmary

Service / Dperation = ilability (%) Time [Sec.) Throughput # of Calls # of SOAP Faults  # of Slow Calls

o 100,00 0,51 012 1,234 o o & #| | P
i pddaddr 100,00 0.50 0.0z 178 i o 8y b _}'
- Changeaddr 100,00 0.52 0.02 176 0 o &y & _}'
i Deleteaddr 100,00 0.50 0.0z 178 o 0 &y 8| | _}'
o et 100,00 0.54 0.02 177 o o B 8] | _}'
i Gataddy 100,00 0.52 0.0z 178 i o 8y b _}'
i GatMames 100,00 0.50 0.02 176 0 o &y & _}'
i Import 100,00 0.50 0,02 177 0 0 & 8| _}'

Note: The Health Summary area is the same in the View as Graph and View

as Table tabs.
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The report displays the following information:

» Operation

» Service/Operations
» Operation/Servers
» Server

Item Description
It can be: The name of the item whose health metrics are
> Service provided in the Health Summary.

Availability

The availability of the item. The background is
colored according to the thresholds specified in the
Availability KPI definition. The availability is
calculated as the number of successful calls to
the item, divided by the total number of calls
to the item, and multiplied by 100. For details,
see “How Dashboard KPIs Work” in Application
Administration.

Response Time (sec.)

The response time (in seconds) of the item. The
background is colored according to the thresholds
specified in the Response Time KPI definition. For
details, see “How Dashboard KPIs Work” in
Application Administration

Throughput

The number of calls to the item per minute. The
background is colored according to the thresholds
specified in the Throughput KPI definition. For
details, see “How Dashboard KPIs Work” in
Application Administration

# of Calls

The total of calls to the specific item. This is a
metrics taken from the Diagnostics sample.

# of SOAP Faults

The number of calls to the specific item that ended
in a SOAP fault. This is a metrics taken from the
Diagnostics sample.

# of Slow Calls

The number of calls to the specific item that were
slow. This is a metrics taken from the Diagnostics
sample. A slow call is a call with a response time
that is longer than the predefined threshold.
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The Metrics Area

The Metrics area displays metrics information for the item listed in the first
row of the Health Summary area. If multiple items were selected in the
Active Filters, the SOAP Faults area displays average information for all of
the selected items.

The Metrics area of the report includes the following elements in graph
format:

> Availability (%). The availability of the item over the selected time frame of the

report.
100.0
- /\
0.0
> Response Time (sec). The response time (in seconds) of the item over the selected
time frame of the report.

Availability (%)

- 0.&
[}
o
L2k
o
E 0.3
[
d
0
& 04

The Response Time graph displays information about the Average Response
Time (sec.) (olive line), the Max Response Time (sec.) (teal line), and the
Min Response Time (sec.) (blue line).

» Throughput. The number of calls to the item per minute, over the selected
time frame of the report.

0.016
H
2 0.0020
n
=
= o.o
=
=
2M4 gz sz ard a1
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The title line of the Metrics area includes the name of the item whose
metrics are displayed. If the Health Summary area displays a tree of
Operation/Servers the title line of the Metrics area is Aggregated data for
selected operations.

The Metrics area of the report is as follows in table format:

Metrics for: TraderService

Times #of Calls  # of SOAP Faults ilability (%) R Time (Sec.)  Max Resp Time  Min. Resp Time  Throughput (Calls/Min.)
8/14 i o 0,00 0,00 0,00 0,00 0,00
8/21 0 o 0.00 0,00 0,00 0,00 0.00
a/28 i o 0.00 0.00 0.00 0.00 0.00
/4 150 o 100,00 0,12 0.5% 0.10 0,01
3/11 0 o 0,00 0,00 0,00 0,00 0,00

350

The Metrics area displays the following information:

Item Description
Time The time units (hour) of the selected time period.
# of Calls The total number of calls to the item, per time unit.

# of SOAP Faults

The number of calls to the item that ended in a
SOAP fault, per time unit.

Availability (%)

The availability of the item, per time unit.

Response Time (sec.)

The response time (in seconds) of the item, per time
unit.

Max Response Time (sec.)

The highest response time (in seconds) of the item,
per time unit.

Min Response Time (sec.)

The lowest response time (in seconds) of the item,
per time unit.

Throughput

The number of calls to the item per minute of the
time unit.
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The SOAP Faults Area

The SOAP Faults area displays information for the item listed in the first row
of the Health Summary area. If multiple items were selected in the Active
Filters, the SOAP Faults area displays average information for all of the
selected items.

If you have selected to display synthetic data, the SOAP Faults area displays
only the Worst Consumers graph.

If you have selected to display real data, the SOAP Faults area displays the
following graph:

> Pie chart. Represents the faults distribution by type of SOAP fault that occurred
when accessing the item during the specified time period. The types of error are:
VersionMismatch, MustUnderstand, Sender, Receiver, and DataEncodingUnknown.
The tooltip displays the number of faults of the type represented by the slice. The
legend lists the SOAP Fault types.

» Worst Consumers. Shows, for the 5 worst consumers (with the largest number of
faulty calls), the number of successful calls (in green) and the number of faulty calls
(in purple) to the item.

g

o # Of Successful calls
= Wl # of SOAF Faults
ol

212.199.95. 146 10.162.24 214

#0f Calls

Worst Consumers
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» SOAP Faults. Shows the number of calls to the specific item that ended in a SOAP
fault over the selected time period.

SO0AP Faults

0
e M3 420 /21 9/22 2423 /24 225

The title line of the SOAP Faults area or of the SOAP Faults table includes the
name of the item whose metrics are displayed. If the Health Summary area
displays a tree of Operation/Servers the title line of the SOAP Faults area is
Aggregated data for selected operations.

The SOAP Faults area of the report is as follows in table format:

» The SOAP Faults Distribution table. The table shows the percentage of the
occurrence of each type of SOAP fault compared to the total number of SOAP faults:
VersionMismatch, MustUnderstand, Sender, Receiver, or DataEncodingUnknown.

SOAP Faults Distribution

50AP Fault Type = 50AP Faults

soapiRecaiver ig8z2.0

» The Worst Consumers table.The table displays the number of faulty calls to the
selected item in the Calls with errors (SOAP Faults) column and the number of
successful calls to the selected item in the Successful calls column, per consumer, for
the 5 worst consumers (with the largest number of faulty calls).

Warst Consurmners

Consumer-= # Of SOAP Faults # Of Successful calls
192.,168,80,1032 izz 1,024
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» The SOAP Faults Overtime table. The table displays the total number of calls to

the selected item that ended in a SOAP fault over the selected time period, per unit of
time.

SOAF Faults over time

Time = 50AP Faults
/20
P21
a2z
23
afz4
W25 igz2
afze
27

Drilling Down to Other Reports

You can drill down to:

The Health Report for the element’s component. Click the required element
in the Health Summary report to access details about the health of the
element’s components. For details about the elements’ components, see
“Accessing SOA Health Reports” on page 344.

The Consumer Summary report. Click the Drill Down to Consumers
Summary Report button to access the Consumer Summary report for the
selected element. For details, see “Consumer Summary Reports” on

page 379.

The Metrics Over Time report. Click the Metrics Over Time Report button to
access the Metrics Over Time report for the selected element. For details, see
“Metrics Over Time Reports” on page 373.

The Diagnostics report for the selected element. Click the Drill Down to
Diagnostics button to access Diagnostics reports for the selected element.
For details, see Mercury Diagnostics User’s Guide.

The Mercury Systinet 2 application. Click the Drill down to Systinet Service
Details button to access the Mercury Systinet 2 application, focused on the
relevant Web service. This option is relevant only when there is an
integration between Mercury Business Availability Center and Mercury
Systinet 2. For details on the integration with Mercury Systinet 2, see
“Integrating with Mercury Systinet 2” in Application Administration.
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> You can also drill down from each point in the graphs to display more
detailed information about the period of time represented by that point.
You can drill down to the smallest unit of time (1 hour).

» Use the breadcrumbs to go back up the levels you drilled down.
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Top Metrics Report

The Top Metrics option in the Web Services tab displays the top metrics
information about the traffic to and from all of the monitored Web services
or operations.

This chapter describes: On page:
Accessing Top Metrics Reports 355
Understanding Top Metrics Reports 356
Information Displayed When Web Services Is Selected 357
Information Displayed When Operations Is Selected 364
Drilling Down to Other Reports 371

Accessing Top Metrics Reports

You can access the Top Metrics reports from the Business Availability Center
for SOA application.

To access Top Metrics reports:

1 To open the Top Metrics page, select Applications > Business Availability
Center for SOA, and select the Top Metrics option in the Business
Availability Center for SOA tab.

2 In the View list, select the time frame of the report. For details, see
“Choosing the Tracking Range and Granularity” in Working with
Applications.

3 In Data Type, select Real or Synthetic data. For details, see “Real Data or
Synthetic Data” on page 341.
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4 In Report Granularity, select:

» Web services to display the top metrics information for the selected Web
services.

» Operations to display the top metrics information for the selected
operations.

5 Click Generate to generate the report.

6 Click the View as Graph tab to display the Top Metrics report in graph
format, or click the View as Table tab to display the Top Metrics report in
table format.

Understanding Top Metrics Reports

Top Metrics reports contain the following graphs/tables that provide
information about the traffic to and from all of the monitored Web services
or operations:

If you have selected Web Services If you have selected Operations
Least Available Web Services Least Available Operations
Slowest Web Services Slowest Operations

Web Services with Most SOAP Faults Operations with Most SOAP Faults
Web Services with Most Slow Calls Operations with Most Slow Calls
Most Active Web Services Most Active Operations

Least Active Web Services Least Active Operations

Note: You can customize the report. For details, see “Customizing the SOA
Reports” on page 342.
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Information Displayed When Web Services Is Selected

Y Y Y Y Y Y Y Y

When you select the Web Services report granularity, you select the type of
metrics you want to display in the report. The report includes graphs
representing the metrics behavior during the selected time frame.

This section includes the following topics:

“Least Available Web Services” on page 357
“Slowest Web Services” on page 358

“Web Services with Most SOAP Faults” on page 359
“Web Services With Most Slow Calls” on page 360
“Most Active Web Services” on page 361

“Least Active Web Services” on page 362

“Table Information” on page 363

“Tooltip” on page 363

Least Available Web Services

The Least Available Web Services graph displays the availability of the 5 Web
services with the lowest availability, during the selected time frame of the
report. The availability is calculated as the number of successful calls to the
Web service, divided by the total number of calls to the Web service, and
multiplied by 100.

Least Available web Services

100
20
ED
40
20

u}

Availability (%)

A ice app...ice BF MApi Emp..ist Calc

Hover over a tab in the graph to display a tooltip that provides information
about the Web service. For details, see “Tooltip” on page 363.
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The Least Available Web Services table displays the same information as the

graph.
(%) Least Available Web Services
Namespace Name Availability » Average # of Slow #of SDAP #of
[E] Response Time Calls Faults Calls
http:/fsystinat. carn/uddif account/s.0 Account_SoapSaruice 0.0% - ] a7s a7e By
http:ff systinet corn/uddif approval_production/S.0 approval_production_SoapService 0,.0% = o 29 29 E
http i/ www. mercury-inkeractive, com/wsdl/EPMAR,  BPMApI 0.0% - s z852 265z By
http i/ systinet comn/wsdl/demofuddifservicess ErnployeaList 0.0% - 1 472 a7z By
Cale 99.8% 0.53 i0 10 5,295 E

http 1/ ftarmpuri. orgd Calef wedlf

For details about the table, see “Table Information” on page 363.

Slowest Web Services

The Slowest Web Services graph displays the 5 slowest Web services in the
selected time frame of the report. A slow Web service is defined as having
the longest response time (no matter the threshold value). Each tab
represents the average of the response times for the Web service during the
time frame of the report.

Slowest Web Services

Average Responze Time

AddrBook

Cale Ane.ice

BPMARI

Emp..ist

Hover over a tab in the graph to display a tooltip that provides information

about the Web service. For details, see “Tooltip” on page 363.

The Slowest Web Services table displays the same information as the graph.

@) slowest Web Services

Mamespace Mame il A ge R —] # of Slow #of SOAP # of

P (0) Time calls Faults calls
http i ftermpuri orgfAddrB ook wsdlf AddrBook 99.8% 0.53 14 14 9,245 %
httpifftempuri orgs Calefwsdlf Calc 99,89 0,53 10 io0 5,295 E
http:/f systinet comn/uddif account/5. 0 Account_SoapService 0.0% 0 978 97a By
http i www. mercury- .
interactive. corn/wsdl/BEMARI] LD b0k S 2,652 ze52 @
http 1/ systinet, cornfwedl/ derno/uddif s ervices/ ErnployeeList 0.0% 1 478 a7z 0y
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For details about the table, see “Table Information” on page 363.

Web Services with Most SOAP Faults

The Web Services with Most SOAP Faults graph displays the 5 Web services
with the largest number of received SOAP faults, during the selected time
frame of the report. Each tab represents the total number of SOAP faults
received by the Web service.

Web Services with Most SOAP Faults

3,000
2 500
2,000
1,500
1,000

500

# of SOAP Faults

EF AR Emp...ist app..ice AddrBook Calc

Hover over a tab in the graph to display a tooltip that provides information
about the Web service. For details, see “Tooltip” on page 363.

The Web Services with Most SOAP Faults table displays the same
information as the graph.

@& web Services with Most SOAP Faults

Namespace Name Availability Average # of Slow  #of SOAP_
Response Time Calls Faults
http i fwww, mercury-interactive, com/wsdl/BPMAPIY BPMARI 0.0% ° 5 2,652
http i/ systinet com/wsdlfdemofuddif services/ EmployeeList 0.0% - 1 478
http i/ systinet comn/uddif approval_production/S.0 approval_production_ScapService 0.0% - ] 29
http:/ fternpuri. orgiAddrB ook fwsdlf AddrBack 99.8% 0.53 14 14
http:fftermpuri. orgd Calefwedly Cale 99.8% 0.53 10 10

For details about the table, see “Table Information” on page 363.
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Web Services With Most Slow Calls

The Web Services With Most Slow Calls graph displays the 5 Web services
with the highest number of slow calls, in the selected time frame of the
report. A slow call is defined as a call that lasts longer than a predefined
threshold. Each tab represents the total number of slow calls received by the

Web service.

Web Services With Most Slow Calls

# of Slow Calls

AddrBook Calc EP AR Emp..ist Ao ice

Hover over a tab in the graph to display a tooltip that provides information

about the Web service. For details, see “Tooltip” on page 363.

The Web Services With Most Slow Calls table displays the same information

as the graph.

(A Web Services With Most Slow Calls

Namespace Name Availability Average Response # of Slow _ #of SDAP # of

" (o) Time talls Faults  calls
httpifftempuri.orgfAddrBook/wsdly AddrBoak 99, 8% 0,53 14 14 9,245 E
http i fternpuri. orgd Calcfwsdlf Calc 99,5% 0.53 10 10 5295 @
hitpiffwww, mercary- . _
interactive, corn/wsdl/BEMARIS CHFEED BT o 2652 2652 @
http:/f systinet. com/wsdl/demo/uddifservices/ Ermployaalist 0.0% 1 473 478
http i systinet, comn/uddif account/5. 0 Account_SoapService 0.0% = [u] 978 a7E

For details about the table, see “Table Information” on page 363.
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Most Active Web Services

The Most Active Web Services graph displays the 5 Web services with the
highest number of calls, during the selected time frame of the report. Each
tab represents the total number of calls to the Web service.

Most Active Web Services

#of Calls
h
o
o
o

AddrBook Cal EFPrApi Emp..ist app...ice

Hover over a tab in the graph to display a tooltip that provides information
about the Web service. For details, see “Tooltip” on page 363.

The Most Active Web Services table displays the same information as the
graph.

# Most Active Web Services

Mamespace Name Availability Average # of Slow # of SOAP # of:

(%) Response Time cCalls Faults Ccalls
http:/ftamnpuri. org/AddrB o ok/wsdl/ AddrBoak 99.8% 0.53 14 14 o245 By
http:ffternpuri. orgf Calofwsdlf Cale 99.8% 0,53 10 in 5,295 E
hitp:ff www, mercury-interactive, comywsdIfEPMApI/  BPMARI 0.0% - 5 z,652  zesz B
http: /i systinet. cornfwsdlf derno/uddif services/ ErnployecList 0.0% - 1 472 a7z By
http: /i systinet. cornfuddif approval_production/5.0 approual_production_SoapService 0.0% - i} 29 2 By

For details about the table, see “Table Information” on page 363.
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Least Active Web Services

The Least Active Web Services graph displays the 5 Web services that
received the lowest number of calls (that is, were least used), during the
selected time frame of the report. Each tab represents the total number of

calls to the Web service.

Least Active Web Services

5,000
5,000
4,000
3,000
2,000
1,000

a
app.dice Emp...ist A, ice EPMARI Calc

#of Calls

Hover over a tab in the graph to display a tooltip that provides information
about the Web service. For details, see “Tooltip” on page 363.

The Least Active Web Services table displays the same information as the
graph.

% Least Active Web Services

Mamespace Name Availability Avarage #of Slow  #of SOAP # Ofi
(%) Response Time Calls Faults _ cCalls
http: /i systinet. cornfuddif approval_praduction/5.0 appraval_praduction_SoapSarvice 0.0% il 29 23 6y
http:ff systinet, comnfwsdlf dernofuddif service s/ Ermplogeelist 0,0% 1 478 478 E
http: /i systinet. comyuddif accounty'5.0 Account_SoapService 0.0% 0 978 ars By
http e /f www. rercury-interactive, corn/wsdl/BPMARI/  BPMARI 0.0% 5 2,652 ze52 6
Cale 99.8% 0.53 io io 5,295 E

http:fftempuri. orgf Calefwedlf

For details about the table, see below.
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Table Information

The metrics detailed information is displayed in the View as Table tab. It
includes the following data:

Item Description

NameSpace The name space of the Web service.

Name The name of the selected Web service.

Availability The average availability of the Web service during

the selected time frame of the report. The
availability is calculated as the number of
successful calls to the Web service, divided by
the total number of calls to the Web service,
and multiplied by 100.

Avg. Response Time (sec.) | The average response time (in seconds) of the Web
service during the selected time frame of the report.

# of Slow Calls The number of slow calls to the specific Web service
during the selected time frame of the report. A slow
call is a call with a response time that is longer than
a predefined threshold.

# of SOAP Faults The number of calls to the specific Web service,
during the selected time frame of the report, that
ended in a SOAP fault.

# of Calls The total number of calls to the specific Web service
during the selected time frame of the report.

Tooltip

Hover over a tab in the graph to display the tooltip that includes the
information listed in the table. For details, see above.

Namespace: httpi/ftempuriorg/AddrBookdwsdlf
Web Service: AddrBook
Name: Addaddr

Availability (%:): 0,999

Average Response Time: 535,399
# of Slow Calls: 2

# of SOAP Faults: 2

# of Calls: 1.893
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Information Displayed When Operations Is Selected

364

Y Y Y Y Y Y Y Y

When you select the Operations report granularity, you select the type of
metrics you want to display in the report. The report includes graphs
representing the appropriate metrics behavior during the selected time
period.

This section includes the following topics:

“Least Available Operations” on page 364
“Slowest Operations” on page 365

“Operations with Most SOAP Faults” on page 366
“Operations With Most Slow Calls” on page 367
“Most Active Operations” on page 368

“Least Active Operations” on page 369

“Table Information” on page 370

“Tooltip” on page 371

Least Available Operations

The Least Available Operations graph displays the availability of the 5 Web
services with the lowest availability, during the selected time frame of the
report. The availability is calculated as the number of successful calls to the
operation, divided by the total number of calls to the operation, and
multiplied by 100.

Least Available Operations

100
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del..urt ana...unt get...mes get..ces get...atas

Hover over a tab in the graph to display a tooltip that provides information
about the Web service. For details, see “Tooltip” on page 371.
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The Least Available Operations table displays the same information as the

graph.

(%) Least Available Operations
Namespace Web Service Name Availability . Average ;:u‘::: # of SOAP # of

P (96) Response Time calle Faults  Calls
http:/f systinet comn/uddif account/5. 0 Account_SoapService delete_userAccount 0.0% - 0 489 409 €Y
http:/fsystinat corn/uddif account/s. 0 Account_SoapSeruice anable_usarAccount 0.0% il 4gs  4zn €Y
httpiffsystinet comn/wsdl/demosuddif servicesf  Employeelist getEmployeeMares 0,0% = 1 478 478 E
bttp o f . e rcury- _
inberachive, cornyw sd1f BPMARIS BPMARI getBPMInstances 0,0% 2 1,326 1,326 E
el Gy BPMAR getBPMVersionData 0.0% = 3 1326 1,328 By

interactive, comy/wsdlf BPMARIS

For details about the table, see “Table Information” on page 370.

Slowest Operations

The Slowest Operations graph displays the 5 slowest Operations in the
selected time frame of the report. A slow operation is defined as having the
longest response time (no matter the threshold value). Each tab represents
the average of the response times for the operation during the time frame of
the report.

Slowest Operations

543
842
544
540
5329
538
537
536
535

Average Response Time

Export SetNames Diwide ena...unt get...mes

Hover over a tab in the graph to display a tooltip that provides information
about the Web service. For details, see “Tooltip” on page 371.
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366

The Slowest Operations table displays the same information as the graph.

@ slowest Operations

Namespace web Service MName ?;ﬁ‘;ilah“it’ :::;:ﬁse e ] 5;;‘:‘5 # DFFS:L?‘Z :;ﬁ:

httpifftermpuri, org/AddrB ook wedly AddrBook Export 99.5% 0,54 z 2 1,321 E
http:/fternpuri, orgiAddrB ook wadlf AddrBack GetHarnes 99.8% 0.54 2 2 1,320 @y
http 1/ fternpuri. argd Calcfwedlf Cale Divida 99.2% 0.54 3 3z 132z €Y
http i f systinet corn/uddif account/ 5. 0 Account_SoapService enable_userAccount 0,0% u] 489 489 E
httpiff systinet, comn/wsdl/demo/uddifservices/ Employeslist getEmployeadames 0,0% 1 475 478 E

For details about the table, see “Table Information” on page 370.

Operations with Most SOAP Faults

The Operations with Most SOAP Faults graph displays the 5 Operations with
the largest number of received SOAP faults, during the selected time frame
of the report. Each tab represents the total number of SOAP faults received

by the operation.

Operations with Most SOAP Faults
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# of SOAP Faults

Hover over a tab in the graph to display a tooltip that provides information
about the operation. For details, see “Tooltip” on page 371.

The Operations with Most SOAP Faults table displays the same information
as the graph.

(A Operations with Most SOAP Faults
Mamespace Web Service Name (Aqu“-ja)ilahility az:gzg:e Sﬁo‘:\f SI;‘::? :aﬁ:
Time Calls Faults

http i/ www, rmercury-interactive, comy/wedl/BPMARI,  BPMARI getBPMversionData 0.0% = 3 1,326 1,326 E
http s /f www. rercury-interactive, corn/w=dl/BPMApRI/  BPMARI getBPMInstances  0.0% 2 1,926 1,326 Y
http: /i systinet. corn/uddif account/5.0 Account_SoapServica enable_userccount 0.0% 0 4zs 4z 6
httpiff systinet, comiwsdlf dermos/uddif service s/ Ermployeelist getErmployesdames 0.0% 1 478 478 E
httpiff systinet, com/uddif approval_production/5.0 approval_production_SoapService delete_userAccount O0.0% 1] 29 29 E
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For details about the table, see “Table Information” on page 370.

Operations With Most Slow Calls

The Operations With Most Slow Calls graph displays the 5 operations with
the highest number of slow calls, in the selected time frame of the report. A
slow call is defined as a call that lasts longer than a predefined threshold.
Each tab represents the total number of slow calls received by the operation.

Operations With Most Slow Calls

# of Slow Calls
= PMINNRRRIRIRIRD
LAl N EE TN S oy B e il |

Multiply get. . ata Divide AddAddr ChangeAddr

Hover over a tab in the graph to display a tooltip that provides information
about the operation. For details, see “Tooltip” on page 371.

The Operations With Most Slow Calls table displays the same information as
the graph.

#  Operations With Maost Slow Calls

N Web N ilability A ge Resp #of Slow_ #of SOAP #of
amespace Service ame (&) Time Calls Faults Calls
http/ fternpuri. argd Calcfwadlf Cale Multiply 99,8% 0.52 3 3 1,327 €4
http:ffwww, mmercury- . .

Interactive. corn/ws dIf BPMADI/ BPMARI getBPMVersionData 0.0% 3 1,326 1,326
http:fftempuri.orgd Calef wadlf Cale Divide 99,8% 0.54 3 3 1,322
http:/itempuri.org/AaddrBookwsdl AddrBook  Addaddr 99,8% 0.53 2 2 1,320
httpi/fternpuni. org/AaddiBookiwsdl AddrBock  ChangeAddr 299,89 0.52 2 2 1,321

For details about the table, see “Table Information” on page 370.
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Most Active Operations

The Most Active Operations graph displays the 5 operations with the
highest number of calls, during the selected time frame of the report. Each
tab represents the total number of calls to the operation.

#of Calls
o
[
ch

Most Active Operations

Pultiply

get..ces

get..ata

Add Subtract

Hover over a tab in the graph to display a tooltip that provides information
about the operation. For details, see “Tooltip” on page 371.

The Most Active Operations table displays the same information as the

graph.

(& Most active Operations

Namespace Web Name Availability Average Response # of Slow #of S0AP #of_
P Service (24) Time Calls Faults  Calls

http i/ ftempuri orgd Calefwsdlf Calc Multiply 99.8% 0,52 3 3 1,327 E
http s fwww, mercury- . _

intaroctive. comnfned|/BPMADIS BPMARI getBPMInstances  0.0% 2 1,326 1,326 &
http i fwww, mercury- . . _

intaroctive comnfnedl/BPMADI/ BPMARI getBPMVersionData 0.0% 3 1,326 1,326 B
http i/ fternpuri, argd Calefwsdlf Calc Add 99.8% 0.53 2 2 1,323 @y
http 1/ fternpuri. argd Calcfwedlf Cale Subtract 99.8% 0.52 2 2 1,323

For details about the table, see “Table Information” on page 370.
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Least Active Operations

The Least Active Operations graph displays the 5 operations that received
the lowest number of calls (that is, were least used), during the selected time
frame of the report. Each tab represents the total number of calls to the

operation.

Least Active Operations

1,400 —
1,200
1,000
200
500
400
200
0

#of Calls

del...unt get...mes del...unt ena...unit AddAddr

Hover over a tab in the graph to display a tooltip that provides information
about the operation. For details, see “Tooltip” on page 363.

The Least Active Operations table displays the same information as the
graph.

(& Least Active Operations

Average # of # of °
calls™

Mamespace Web Service Name ?q‘jsi'ab““‘ Response Slow SOAP

Time Calls _Faults
http:/f systinat. cornfuddif approval_production/S.0 approval_production_ScapService delets_userfccount 0.0% = 0 29 2 6y
httpiff systinet, comiwsdlf dermos/uddif service s/ Ermployeelist getErmployesdames 0.0% 1 478 478 E
httpiff systinet, comi/uddif account’ 5.0 Account_SoapService delete_userdccount  0.0% 1] 489 459 E
http: /i systinet. corn/uddif account/5.0 Account_SoapService enable_userfccount 0.0% 0 489 489 €Y
http:/ftamnpuri. org/AddrB o ok/wsdl/ AddrBook Addaddr 99.8% 0.52 2 z 1,320 €Y

For details about the table, see below.
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Table Information

The metrics detailed information is displayed in the View as Table tab. It

includes the following data:

Item Description

NameSpace The name space of the Web service that runs the
operation.

Web Service The name of the Web service that runs the
operation.

Name The name of the operation.

Availability The average availability of the operation during the

selected time frame of the report. The availability
is calculated as the number of successful calls
to the operation, divided by the total number
of calls to the operation, and multiplied by
100.

Avg. Response Time (sec.)

The average response time (in seconds) of the
operation during the selected time frame of the
report.

# of Slow Calls

The number of slow calls to the specific operation
during the selected time frame of the report. A slow
call is a call with a response time that is longer than
a predefined threshold.

# of SOAP Faults

The number of calls to the specific operation,
during the selected time frame of the report, that
ended in a SOAP fault.

# of Calls

The total number of calls to the specific operation
during the selected time frame of the report.
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Tooltip

Hover over a tab in the graph to display a tooltip that includes the
information listed in the table above.

Namespace: http:/ftempuri.org/addrBookfwsdlf
Web Service: AddrBook
Name: AddAaddr

Availability (%): 0,999

Average Response Time: 535,399
# of Slow Calls: 2

# of SOAP Faults: 2

#ofcalls: 1,892

Drilling Down to Other Reports
You can drill down to:

» The Health Report for the selected service’s operations.

» From the View as Graph tab, click the bar that corresponds to a specific
Web service to open the Health Report of the Web service’s operations in
graph format.

ﬁ » From the View as Table tab, click the Health report drill down button
corresponding to a specific Web service to open the Health Report of the
Web service’s operation in table format.

For details, see “Drilling Down to Other Reports” on page 353.
» The Health Report for the selected operation’s servers.

» From the View as Graph tab, click the bar that corresponds to a specific
operation to open the Health Report of the operation’s servers in graph
format.

ﬁ » From the View as Table tab, click the Health report drill down button
corresponding to a specific operation to open the Health Report of the
operation’s servers in table format.

For details, see “Drilling Down to Other Reports” on page 353.
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Metrics Over Time Reports

The Metrics Over Time report displays the performance, over time,
measuring access to selected Web services or operations, by a server, or a

consumer.
This chapter describes: On page:
Accessing Metrics Over Time Reports 373
Understanding Metrics Over Time Reports 374
Drilling Down to Other Reports 377

Accessing Metrics Over Time Reports

You can access the Metrics Over Time reports from the Business Availability
Center for SOA application.

To access Metrics Over Time reports:

1 Select Applications > Business Availability Center for SOA, and select the
Metrics Over Time Report option in the Business Availability Center for SOA
tab.

2 In the View list, select the time frame of the report. For details, see
“Choosing the Tracking Range and Granularity” in Working with
Applications.

3 Click Active Filters to select the appropriate conditions for the report. For
details, see “Filtering Using the Active Filter” and “Filtering by Server or
Consumer” on page 340.
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4

Select Real or Synthetic data. For details, see “Real Data or Synthetic Data”
on page 341.

In the Metrics list, select the metric whose performance during the selected
time period you want to display. You can select: Availability (%),
Throughput, Avg. Response Time, # of Calls, # of SOAP Faults, or # of Slow
Calls.

6 Click Generate to generate the report.

7 Click the View as Graph tab to display the Metrics Over Time Report in

graph format, or click the View as Table tab to display the Metrics Over Time
Report in table format.

Understanding Metrics Over Time Reports

374

You can display over time information for the following metrics:

Availability. The average availability (in percentage) of the selected Web
services or operations, running on the selected servers, and accessed by the
selected consumer during the selected time frame of the report.

Throughput. The number of calls to the selected Web services or operations
running on the selected server, by the selected consumer, per minute,
during the selected time frame of the report.

Avg. Response Time (sec.). The average response time (in seconds) of the
selected Web services or operations, running on the selected server, by the
selected consumer during the selected time frame of the report.

# of Calls. The total number of calls to the selected Web services or
operations, running on the selected server, by the selected consumer, during
the selected time frame of the report.

# of SOAP Faults. The total number of faulty calls to the selected Web
services or operations, running on the selected server, by the selected
consumer, during the selected time frame of the report. A faulty call is a call
that ends in a SOAP fault.
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» # of Slow Calls. The total number of slow calls to the selected Web services

or operations, running on the selected server, by the selected consumer,
during the selected time frame of the report. A slow call is a call with a
response time that is longer than the predefined threshold.

Note: You can customize the report. For details, see “Customizing the SOA
Reports” on page 342.

This section includes the following topics:

» “Graph Details” on page 375

» “Table Details” on page 376

Graph Details

The View as Graph tab displays the selected metric performance of the
selected Web services, operations, server, or consumer, during the selected
time frame of the report.

The graph legend indicates the color used to display the metric information
of the Web services if Web services were selected or operations if Operations
were selected in the Active Filters.

Bl updateFatient
o addRecord
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ol getRecord
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\\/\//\/\N\_/\
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You can drill down from each point in the graph to display more detailed
information. For details, see “Drilling Down to Other Reports” on page 377.

Tooltips are shown for each point on the graph.

For a Web service:

Web Service: TraderService

Availability (9:): 100.0%

For an operation:

Web Service: MedRecWebServices
Operation: getRecordsSummary

Availability (%:): 56.25

The tooltip displays the following information:

Item

Description

Web Service/Operation

The name of the selected Web service/operation.

<metric>

The value of the metric at this point.

Table Details

The View as Table tab displays the selected metric performance of the
selected Web services, or operations, during the selected time frame of the

report.
0/1290/18 0718 0718 0/1% 0/189/18 0/18 0/18 0718 0O/1%8 0718 0/18 9/18
Web Service = Operation Namespace 7:49 8:00 9:00 10:00 11:00 12:00 1:00 2:00 3:00 4:00 3:00 6:00 F:00 8:00
A AM  AM L A PM_ P P PM P P P Pl P
o a x) x) x) o o

MedRecWebServices addRecord http i/ fternpuri. orgl

MedRecWebServices getRecord http:fftempuri.org’

MedRecWebServices registerPatient http://termpuri.orgf

- 95,357 ©1.417 64,865 63,441 55,914 F5.61  E7.55

The table displays the Web service and/or operation, the namespace of the
Web service and the value of the metric per time unit.
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Drilling Down to Other Reports

Drill down from each point in the graph to display the following menu:

% Drill Down to Health Repart
@‘ Drill Down to Diagnostics Report

tly Tirme range Drill Down

Select:

> Drill Down to Health Report. To display the Health report for the selected
Web service or operation for the selected time period. For details, see
Chapter 29, “Health Reports.”

> Drill Down to Diagnostics Report. To open the Diagnostics application. For
details, see Mercury Diagnostics User’s Guide.

» Time Range Drill Down. To display the metrics for the selected Web service
or operation for the selected time period.
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Consumer Summary Reports

The Consumer Summary report displays specific metrics for all of the
consumers accessing the selected Web services or operations in a selected

view.
This chapter describes: On page:
Accessing the Consumer Summary Reports 379
Understanding Consumer Summary Reports 380
Drilling Down to Other Reports 383

Accessing the Consumer Summary Reports

You access the Consumer Summary reports from the Business Availability
Center for SOA application.

To access Consumer Summary reports:

1 Select Application > Business Availability Center for SOA, click the Business
Availability Center for SOA tab, and select the Consumer Summary Report
option in the Business Availability Center for SOA tab.

2 In the View list, select the time frame of the report. For details, see
“Choosing the Tracking Range and Granularity” in Working with
Applications.

3 Click Active Filters to select the appropriate conditions for the report. For
details, see “Filtering Using the Active Filter” and “Filtering by Server or
Consumer” on page 340.
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4 Select Real or Synthetic data. For details, see “Real Data or Synthetic Data”

on page 341.

Note: When you select Real, the Consumer Summary Report displays
information only for the consumers that were registered in the Diagnostics
system. All other consumers are aggregated and presented as Others.

Click Generate to generate the report.

6 Click the View as Graph tab to display the Consumer Summary report in

graph format, or click the View as Table tab to display the Consumer
Summary report in table format.

Understanding Consumer Summary Reports

380

Consumer Summary reports include two areas:

> “Consumer Summary Area” on page 380

> “Worst Consumer Area” on page 382

Note: You can customize the report. For details, see “Customizing the SOA
Reports” on page 342.

Consumer Summary Area

The Consumer Summary area is the same in the View as Graph and View as
Table tabs. It displays the health metrics for all of the consumers accessing
the selected Web services or operations. If, in the Active Filters, you also
select specific consumer or server, the health metrics are further filtered by
the selected consumer and server.
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The Consumer Summary area is as follows:

Consurner Surnmary

| 4] 1-zefz b L

. -

ity (%0) Response Time (Sec.) Throughput # Of Calls # 0f SOAP Faults # Of Slow Calls

10.168.24,169

192.168.80.162

100,00

100.00

0.12 0,00 144 ] o &
0.14 0.00 & o o

The report displays the following information:

Item Description
Consumer The IP number of the consumer.
Availability The availability of the selected Web services or

operations accessed by the specific consumer. The
availability is calculated as the number of successful
calls made by the specific consumer divided by the
total number of calls made by the specific
consumer, multiplied by 100.

The background is colored according to the
threshold specified in the Availability KPI
definition. For details, see “How Dashboard KPIs
Work” in Application Administration.

Response Time (sec.)

The average response time (in seconds) of the
selected Web services or operations accessed by the
specific consumer.

The background is colored according to the
threshold specified in the Response Time KPI
definition. For details, see “How Dashboard KPIs
Work” in Application Administration.

Throughput (calls per
min.)

The number of calls, per minute, to the selected
Web services or operations by the specific consumer.

The background is colored according to the
threshold specified in the Throughput KPI
definition. For details, see “How Dashboard KPIs
Work” in Application Administration.
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Item

Description

# of Calls

The total number of calls to the selected Web
services or operations accessed by the specific
consumer.

# of SOAP Faults

The number of faulty calls to the selected Web
services or operations by the specific consumer. A
faulty call is a call that ends in a SOAP fault.

# of Slow Calls

The number of slow calls to the selected Web
services or operations by the specific consumer. A
slow call is a call with a response time longer than
the predefined threshold.

Worst Consumer Area

The Worst Consumer area displays the successful and faulty calls of the
worst 5 consumers accessing the selected Web services, operations, or

Servers.

Each tab in the graph represents a different consumer and displays the
number of successful calls (in green) and the number of faulty calls (in

purple).

Worst Consurmer

#0Of Calls

144

Tz

x)
192,168 80.162

& Successful calls
Ul # Of SOAF Faults

10,168 .24 169

Worst Consumers

Hover above a tab to display a tooltip that indicates the number of faulty
calls and the number of successful calls for the selected consumer.

Calls with emors: 252
Successful calls: 1,570
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You can view the same information, in table format, in the View as Table
tab:

Worst Cansumer

Consumer = Calls with ervors (SOAP Faults) Successtul calls

10,168.24,169 0.0 144.0

192,168.80,162 0.0 6.0

Drilling Down to Other Reports

To drill down to the Health Report for the selected element, click the Drill
ﬁ Down to Health Report button from the Consumer Summary area. For
details, see “Health Reports” on page 343.
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Server Summary Reports

The Server Summary report displays a drillable summary of the metrics for
all of the servers on which the selected Web services or operations of a
selected view are running.

This chapter describes: On page:
Accessing the Server Summary Reports 385
Understanding Server Summary Reports 386
Drilling Down to Other Reports 389

Accessing the Server Summary Reports

You can access the Server Summary reports from the Mercury Business
Availability Center for SOA application.

To access Server Summary reports:

1 select Application > Business Availability Center for SOA, click the Business
Availability Center for SOA tab, and select the Server Summary Report
option in the Business Availability Center for SOA tab.

2 In the View list, select the time frame of the report. For details, see
“Choosing the Tracking Range and Granularity” in Working with
Applications.

3 Click Active Filters to select the appropriate conditions for the report. For
details, see “Filtering Using the Active Filter” and “Filtering by Server or
Consumer” on page 340.
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4 Select Real or Synthetic data. For details, see “Real Data or Synthetic Data”
on page 341.

Note: When you select Real, the Server Report displays information only for
the consumers that were registered in the Diagnostics system. All other
consumers are aggregated and presented as Others.

5 Click Generate to generate the report.

6 Click the View as Graph tab to display the Server Summary report in graph
format, or click the View as Table tab to display the Server Summary report
in table format.

Understanding Server Summary Reports
The Server Summary reports include two areas:

> “Server Summary Area” on page 387

> “Worst Server Area” on page 388

Note:

» You can customize the report. For details, see “Customizing the SOA
Reports” on page 342.

» The Server Summary report is available only if the Server IP field exists in
the sample.
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Server Summary Area

The Server Summary area is similar in the View as Graph and View as Table
tabs. It displays the health metrics for all of the servers on which the
selected Web services or operations are running. If in the Active Filters, you
also select a specific consumer or server, the health metrics are further
filtered by the selected consumer or server.

The Server Summary area is as follows:

Server Summary

RIRIEET I
Server - Availability (1) Response Time (Sac.) Throughput # OF Calls # OF SDAP Faults # OF Slow Calls
0.0.0.0 99,63 0.53 0,01 270 1 o &
207.46,196,115 99,86 0,53 0.08 2,539 5 5 &
207.46.248,109 99,86 0.53 0.08 3,510 s s &
£9.20.5.29 0.00 0,00 0.03 1,263 1,263 0 &

The report displays the following information:

Item Description
Server The IP number of the server.
Availability The availability of the server accessed by the

selected Web services, operations, or consumer. The
availability is calculated as the number of successful
calls made to the server divided by the total number
of calls made to the server, multiplied by 100.

The background is colored according to the
threshold specified in the Availability KPI
definition. For details, see “How Dashboard KPIs
Work” in Application Administration.

Response Time (sec.)

The average response time (in seconds) of the server
accessed by the selected Web services, operations, or
consumer.

The background is colored according to the
threshold specified in the Response Time KPI
definition. For details, see “How Dashboard KPIs

Work” in Application Administration.
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Item Description
Throughput (calls per The number of calls, per minute, to the server by
min.) the selected Web services, operations, or consumer.

The background is colored according to the
threshold specified in the Throughput KPI
definition. For details, see “How Dashboard KPIs
Work” in Application Administration.

# of Calls The total number of calls to the server accessed by
the Web services, operations, or consumer.

# of SOAP Faults The number of faulty calls to the server accessed by
the selected Web services, operations, or consumer.
A faulty call is call that ends in a SOAP fault.

# of Slow Calls The number of slow calls to the server accessed by
the selected Web services, operations, or consumer.
A slow call is a call whose response time is longer
than the predefined threshold.

Worst Server Area

The Worst Server area displays the successful and faulty calls to the 5 worst
servers accessed by the selected Web services, operations, or consumer.

Each tab in the graph represents one of the 5 worst server and displays the
number of successful calls (in green) and the number of faulty calls (in
purple) to that server.

Worst Server

3,540
H successtul calls
ol # 0f S0AP Faults

1,770

#0f Calls

£3.20.5.29 20748196115 207.46.245.103 0000

Worst Servers
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You can view the same information, in table format, in the View as Table

tab:
Worst Server
Servers Calls with errors (50AP Faults) Successful calls
0.0,0.0 1.0 269.0
207.46.196,115 5.0 3534.0
207.46.242.109 5.0 2505.0
69.20,5.29 1263.0 0.0

Hover over a tab to display a tooltip that indicates the number of faulty calls
and the number of successful calls to the selected server.

Calls with emors: 252
Successful calls: 1,570

Drilling Down to Other Reports

To drill down to the Health Report for the selected element, click the Drill
Down to Health Report button from the Server Summary area. For details,

&
J see “Health Reports” on page 343.
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